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バイオ・ラッド テックコール 
製品の学術的お問い合わせ並びに修理・メンテナンスに関するお問い合わせは弊社テックコールにお問い合

わせください。  

 

受付時間：月曜日～金曜日（祝祭日を除く） 

AM9:00～PM5:00 

電話: 03-6404-0331  

Fax:  03-6404-0334  

Email: life_ps_jp@bio-rad.com 

以下の Web でオンラインでのテクニカルサポート並びに製品情報等をご参照頂けます。  

Web：www.bio-rad.com. 

 
日本以外での技術サポートについては、お近くのテクニカルサポート事務所までお問い合わせください。 

 

 

注意 
 

本書の内容は、電子形態、または印刷、記録、またはあらゆる情報記憶または検索システムを含む機械的形態の

いかなる形式または手段によっても、バイオ・ラッド社の書面による許可なしに複製や送信することを禁じます。 

 

バイオ・ラッド社は、製品およびサービスをいつでも修正する権利を留保します。本ユーザーガイドは予告なし

に変更されることがあります。精度を保証する態勢は整っていますが、バイオ・ラッド社は誤記や脱落、または

本情報の適用または使用により生じるいかなる損害について一切の責任を負いません。 

 

以下は、バイオ・ラッド ラボラトリーズ社の登録商標です：Bio-Rad、CFX Maestro、CFX384、CFX384 Touch、

CFX96 Touch、CFX Connect、C1000 Touchおよび iProofと iTaq。 

 

Adobe、Acrobat、および Readerは Adobe Systems Incorporated社の商標です。Cyは GE Healthcareグループ

企業の商標です。CAL Fluorおよび Quasarは Biosearch Technologies, Inc.社の商標です。SYBRおよび Texas Red

は Life Technologies社の商標です。バイオ・ラッド ラボラトリーズ社は、研究目的のみでリアルタイム PCRに

使用する SYBR Green を含有する試薬を販売するため、Life Technologies 社の認可を受けています。Excel、

Microsoft、PowerPoint、およびWindows は、Microsoft社の商標です。Pentiumは Intel社の商標です。EvaGreen

は Biotium, Inc.社の商標です。FAM、ROX および VIC は Applera 社の商標です。バイオ・ラッド ラボラトリー

ズ社は、研究目的のみでリアルタイム PCR に使用する EvaGreen 色素を含有する試薬を販売するため、Applera

社の認可を受けています。 

 

バイオ・ラッド社のサーマルサイクラーとリアルタイムシステムは、１つ以上の以下の米国特許または Eppendorf 

AG：米国特許番号 6,767,512および 7,074,367によって所有される外国語の複製の適用を受けます。 

 

Hard-Shellプレートは、１つ以上の以下の米国特許または Eppendorf AG：米国特許番号 7,347,979; 6,340,589; お

よび 6,528,302によって所有される外国語の複製の適用を受けます。 
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製品を安全にご使用いただくために 
 

C1000
TM

 Touch、CFX96 Touch
TM
、CFX96 Touch

TM
 Deep Well、CFX Connect

TM
、CFX384

TM
 Touch

の各システムを安全にお使いいただくため、本節および本書中に記載する安全仕様を順守することを強

くお勧めします。 

 

安全確保のための警告表示 
 

機器本体および本書に表示される警告表示は、使用者に感電の危険性といった傷害または損害の原因に

ついて警告するためのイラストです。表１に、安全性に関する警告マークを説明します。 

 

標準的な安全性に関する警告 
 

表１ 安全性に関する警告表示の意味 

アイコン 説明 

 

注意：バイオハザード! このマークは、バイオハザード物質に汚染されている可能性が

あるコンポーネントを示しています。  

 

注意：危険のおそれあり! このマークは、正しく取り扱わなかった場合に、使用者に傷

害が生じるおそれのある機器部分を示します。このマークが表示される場合は、必ず本

書を読んで内容をよく確認したうえで操作を進めてください。 

 

 

注意：表面が加熱されている! このマークは、正しく取り扱わなかった場合、加熱した

機器よって使用者に傷害が生じるおそれのある機器部分を示します。 
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機器安全性に関する警告 
 

表２に示す警告ラベルも機器に表示されるものであり、CFX96 Touch、CFX96 Touch Deep Well、CFX 

Connectおよび CFX384 Touchの各システムの安全使用に直接関係します。 

 

表２ 機器の安全性に関する警告マーク 

アイコン 説明 

 

人体や機器本体に傷害を与えるおそれがあることの警告 

本書の解説を読まずに CFX96 Touch、CFX96 Touch Deep Well、CFX Connect または

CFX384 Touchリアルタイム PCR解析システムを操作すると、使用者が傷害を受ける

おそれがあります。安全に使用するため、本書に記載されていない方法によって機器を

操作しないでください。電気機器を安全に使用するための研修を受け、正式な承認を得

ている研究スタッフが本機器を使用してください。本機器の各部品については、手指を

洗浄して水気を十分に拭き取ったうえで、丁寧に取り扱ってください。 

 

 

バイオハザード物質の取り扱いについての警告 

バイオハザードサンプルを取り扱う際、推奨される注意事項やガイドラインに従うこと

と、実験室および施設に固有のローカルなガイドラインに準拠してください。 

 

 

火傷リスクの警告 

サーマルサイクラーを操作すると、重度の火傷を生じるほどに加熱されます。操作時は、

必ず保護用ゴーグルやそれに準じる眼部保護用具を装用してください。サンプルブロッ

クの温度が十分に下がっていることを確認したうえで、リッドを開け、サンプルを取り

出してください。火傷を避けるため、非操作時には本機器から十分離れてください。 

 

 

爆発リスクの警告 

サンプルブロックは、その正常な操作によってサンプル液体を沸騰・爆発させる程度ま

で加熱させることが可能となります。 

 

 

注意：C1000 Touchサーマルサイクラーの取り扱い方法については、C1000 Touchサーマルサイクラ

ーおよび CFXリアルタイム PCR解析システムの取扱説明書を参照してください。 

 



安全にご使用頂くための注意事項 

ユーザーガイド | 13 

安全にご使用頂くための注意事項 
 

表３に、C1000 Touch、CFX96 Touch、CFX96 Touch Deep Well、CFX Connect、CFX384 Touchの

各システムを安全に使用していただくための動作環境条件を示します。クラス A FCC規制に準拠する

ため、同梱のシールドケーブルを必ず使用してください。 

 

表３ 安全にご使用いただくための動作環境条件 

安全な使用要件 仕様 

使用温度 屋内使用のみ。環境温度は 15～31 ℃。最大相対湿度は 80 %（ただし結露のな

いこと） 

高度 2,000 m以下 

   ＊注意：本ユニットを水がかかる可能性のある場所に保管したり、使用したりしないでください。感電の原因と

なることがあります。またユニットを、実験台の端で保管したり、使用したりしないでください 

 

安全規格への順守 
 

C1000 Touch、CFX96 Touch、CFX96 Touch Deep Well、CFX Connect、CFX384 Touchの各システ

ムは、以下に記載する安全性および電磁場に関する基準の該当要件に適合していることが試験により確

認されています。 

 

 IEC 61010-1:2001（第２版）、EN61010-1:2001.（第２版）. 測定、制御および研究室用電気機

器、第 1部：一般的要求事項。 

 

 IEC 61010-2-010:2005, EN61010-2-010:2003. 測定、制御および研究室用電気機器に関する安全

性要件、第 2部-010：材料加熱用実験機器に関する特別要求事項。 

I 

 EC 61010-2-081:2001+A1, EN61010-2-081:2002+A1. 測定、制御および研究室用電気機器に関す

る安全性要件、第 2 部-081：分析用および他目的用の自動および半自動実験機器に関する特別要

求事項（改訂１を含む）。 

 

 EN 61326-1:2006（クラスＡ）. 測定、制御および研究室用電気機器. EMC要求事項、第１部：一

般的要求事項。 

 

前記の安全性と電磁場に関する基準に加え、CFX Connect システムについては、測定、制御および研

究室用電気機器に関する安全要件、第２部-101：体外診断用（IVD）医療機器に関する特別要求事項に

準拠することが、試験により確認されています。 

 

C1000 Touch、CFX96 Touch、CFX96 Touch Deep Well、CFX Connect、CFX384 Touchの各システ

ムは、高周波エネルギーを発生し、それを使用し、放出することを可能とする機器であるため、本取扱

説明書の記載事項に準拠して設置・使用されない場合には、無線通信において有害な干渉を生じるおそ

れがあります。一般住宅地域で本システムを稼働させた場合には、有害な干渉を生じる可能性が高く、

その場合には、使用者が自費によってその干渉を補正しなければなりません。 
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危険性 
 

C1000 Touch、CFX96 Touch、CFX96 Touch Deep Well、CFX Connect、CFX384 Touchリアルタイ

ム PCR解析の各システムは、製造業者によって規定された方法で使用したときに、安全に動作するよ

うに設計されています。C1000 Touch、CFX96 Touch、CFX96 Touch Deep Well、CFX Connect、CFX384 

Touch の各システムまたはその関連コンポーネントのいずれかを製造業者が指定した以外の方法で使

用されている場合は、機器によって提供される固有の保護機能が損なわれる可能性があります。バイ

オ・ラッド ラボラトリーズ社は、指定しない方法でのこの装置の使用によるいかなる怪我、またはバ

イオ・ラッド社または認定代理店によって行われていない機器への改造によって生じた損害について責

任を負うものではありません。C1000 Touch、CFX96 Touch、CFX96 Touch Deep Well、CFX Connect、

CFX384 Touchの各システムに関わる修理サービスは、バイオ・ラッド担当者が実施する必要がありま

す。 

 

バイオハザード 
 

C1000 Touch、CFX96 Touch、CFX96 Touch Deep Well、CFX Connect、CFX384 Touchの各システ

ムは研究室向けの製品です。バイオハザードのサンプルが存在する場合、次のガイドラインに従って、

そして研究室や施設に固有のローカルなガイドラインに準拠してください。 

 

注意：バイオハザード物質は、本機器の通常運転中に一切排出されません。 

 

一般的な予防策 

 

 常に実験用白衣、実験用手袋、横がシールされた安全グラスまたはゴーグルを着用する。 

 

 手は口、鼻、目に触れないようにする。 

 

 潜在的な感染性物質を扱う前に、切り傷や擦り傷は保護しておく。 

 

 潜在的な感染性物質を扱った後、実験室を出る前に石鹸と水でよく手を洗う。 

 

 ベンチで作業する前に、腕時計や宝飾品をはずす。 

 

 割れない漏れ防止のコンテナ内ですべての感染性物質、潜在的な感染性物質を保管する。 

 

 実験室を離れる前に、保護服は脱ぐ。 

 

 手袋をつけた手で、書いたり、電話に出たり、ライトのスイッチをつけたり、他の誰かが手袋無

しで触る可能性のあるものに触らないようにする。 

 

 手袋は頻繁に変える。手袋が目に見えて汚染されているときには、すぐに手袋をはずす。 

 

 潜在的な感染性物質として適切に汚染除去できない物質は露出させない。 

 

 バイオハザード物質が関与する操作が完了したら、適切な消毒剤で作業領域を除染する（例えば、

1:10希釈の市販漂白剤）。 
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表面の汚染 

 

警告! 感電事故を防ぐために、常に汚染除去の手順を実行する前には機器の電源をオフにして電源コー

ドを抜いてください。 

 

次の部分は、病院用殺菌剤、殺ウイルス剤、または殺菌消毒剤で洗浄することができます。 

 

 リッドと本体の外部 

 

 内部のリアクションブロック表面とリアクションブロックのウェル 

 

 コントロールパネルとディスプレイ 

 

消毒剤の準備し、適用するには、製品の製造業者が提供する手順を参照してください。常に消毒剤を適

用した後のリアクションブロックとリアクションブロックのウェルは水で数回すすいでください。徹底

的に水で洗浄した後、リアクションブロックとリアクションブロックのウェルを乾燥させます。 

 

警告! 研磨剤や腐食性の洗剤または、強いアルカリ性溶液を使用しないでください。これらの溶液は、

表面に傷を付けると正確な熱制御が失われるような損傷をリアクションブロックに与える可能性があ

ります。 

 

バイオハザード物質の廃棄 

 

以下に示す潜在的な汚染物質の廃棄は研究室、地域、そして国内の規制に準拠してください。 

 

 臨床サンプル 

 

 試薬 

 

 使用した汚染されている可能性がある反応容器または他の消耗品 

 

化学物質的危険 
 

C1000 Touch、CFX96 Touch、CFX96 Touch Deep Well、CFX Connect、CFX384 Touchの各システ

ムは、潜在的な化学物質を含んでいません。 

 

爆発または燃焼性の危険 
 

C1000 Touch、CFX96 Touch、CFX96 Touch Deep Well、CFX Connect、CFX384 Touchの各システ

ムは、バイオ・ラッド ラボラトリーズ社で指定された適切な方法で使用される限り、可燃性または爆

発に関する一切の異常な危険をもたらすものではありません。 

 

電気的危険 
 

C1000 Touch、CFX96 Touch、CFX96 Touch Deep Well、CFX Connect、CFX384 Touchの各システ

ムが物理的な改良を加えることなく、適切な仕様の電源に接続されていて、適切に設置、操作されてい

る場合には、異常な電気的危険をもたらすものではありません。 

 



製品を安全にご使用いただくために 

16 | CFX Maestro™ ソフトウェア 

輸送 
 

C1000 Touch、CFX Connectサーマルサイクラー、CFX96、CFX96 Deep Well、CFX Connect、CFX384

オプティカルリアクションモジュールを移動または出荷する前に、汚染除去の作業を実施する必要があ

ります。C1000 Touchまたは CFX Connectサーマルサイクラー本体と、CFX96、CFX96 Deep Well、

CFX Connectまたは CFX384オプティカルリアクションモジュールを別々の容器で付属の梱包材で常

に損傷から機器を保護して、移動または輸送してください。適切な容器が見つからない場合には、お近

くのバイオ・ラッドの営業所にお問い合わせください。 

 

保管 
 

C1000 Touch、CFX96 Touch、CFX96 Touch Deep Well、CFX Connect、CFX384 Touchの各システ

ムは、以下の条件下で保管してください。 

 

 温度範囲：-20～60 ℃ 

 

 相対湿度：最大 80 % 

 

廃棄 
 

C1000 Touch、CFX96 Touch、CFX96 Touch Deep Well、CFX Connect、CFX384 Touchリアルタイ

ム PCR 解析の各システムは電気的物質を含んでいます。European Union Directive 2002/96/CE on 

waste and electronic equipment (WEEE Directive)に従って、それは分別廃棄物として処分されるべき

であり、別々に収集する必要があります。廃棄する前に、国固有の指示についてお近くのバイオ・ラッ

ド代理店にお問い合わせください。 
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第１章 はじめに 
 

バイオ・ラッド社の高性能 PCR増幅システムは最新の技術を利用し、ゲノム実験のための核酸増幅の

精度と再現性を高めます。バイオ・ラッド社の PCR 製品ラインは、リアルタイム PCR システムと従

来型の PCRシステムを含んでいます。 

 

リアルタイム PCRシステム 

 
 C1000 Touch

TM
 

 
 CFX96 Touch

TM
 

 
 CFX384 Touch

TM
 

 
 CFX Connect

TM
 

 
 CFX96 Touch

TM
 Deep Well 

 
 CFX Automation System II 

 

従来型 PCRシステム 

 
 C1000

TM
 

 
 S1000

TM
 

 

バイオ・ラッド社の CFX Maestro
TM
ソフトウェアは、すべての CFXシステムと互換性があり、バイオ・

ラッド社の Prime PCR
TM
プライマーとプローブアッセイ用に最適化されたランファイルを取り込みこ

とができるという特長を有しています。 

 

CFX Maestro ソフトウェアを使用すれば、複雑なデータを理解して遺伝子解析に関する説得力のある

分析を行うことができます。t-test、一元配置および二元配置 ANOVA、PrimePCR解析、およびリファ

レンス遺伝子セレクターツールなどのツールを使用すれば、各種方法で遺伝子発現実験を解析すること

が可能です。 
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CFX Maestroソフトウェアの主な特徴 
 

CFX Maestro ソフトウェアを使用すれば、以下を行うことが可能です。 

 

 スタートアップウィザードを使用して、リアルタイム PCR実験を迅速かつ容易に設定する。 

 

 棒グラフ、クラスタ解析図、散布図、Volcano プロット、またはヒートマップを使用してデータ

を解析し、結果を素早く解釈・理解する。 

 

 データ表示をカスタマイズして、発行物やレポートの作成用に高解像度のグラフをエクスポート

する。 

 

 PrimePCR解析コントロールで、RNAの品質を判定し、実験の問題を解決する。 

 

 適切なリファレンス遺伝子を選択し、その安定性をリファレンス遺伝子選択ツールで解析する。 

 

 一元配置（one-way）および二元配置（two-way）ANOVA を含む統計的解析を遺伝子発現解析で

行う。 

 

 生物学的グループ名を付けて多変量実験を設定する。 

 

 各基準の合否結果を含む PDFレポートを自動的に作成し、実験結果を評価しやすくする。 

 

このユーザーガイドでは、これらの機能とその使用方法について説明します。 

 

もっとよく知るには 
 

バイオ・ラッド社のリアルタイム PCRサーマルサイクラーと CFX Maestroソフトウェアの設置後、こ

のガイドにアクセスでき、また、あらゆる画面のヘルプメニューからも詳細なソフトウェアのヘルプト

ピックにアクセスできます。 

 

アドバイス：ウィンドウの右上隅にあるバイオ・ラッド社のロゴをクリックして、バイオ・ラッド社の

ウェブサイトを立ち上げます。このサイトは、テクニカルノート、マニュアル、製品情報およびテクニ

カルサポートへのリンクを含んでいます。また、PCR、リアルタイム PCRおよび遺伝子発現に関する

多様な方法と適用について数多くの技術参考資料も提供しています。 
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第２章 CFX Maestro ソフトウェアのインス

トール 
 

本章では、CFX Maestro ソフトウェアのインストール方法について説明します。対応するバイオ・ラ

ッド社製リアルタイム PCRサーマルサイクラーの設定に関する詳細については、該当するガイドを参

照してください。 

 

C1000 Touch、CFX96 Touch、CFX96 Touch Deep Well、CFX Connect、CFX384 Touchの各システ

ムからリアルタイム PCRデータを解析するには、CFX Maestroソフトウェアが必要です。また、本ソ

フトウェアを使用してソフトウェア制御モードでこれらのシステムを制御することも可能です。 

 

CFX96、CFX96 Deep Well、CFX Connect、CFX384オプティカルリアクションモジュールの梱包セッ

トには、以下の品目が含まれます。 

 

 オプティカルリアクションモジュール 

 

 USBケーブル 

 

 CFX Maestro ソフトウェアのインストール用 USBドライブ 

 

 qbase
+
ソフトウェア設定用クイックガイド 

 

全てを開梱し、箱を保管しておくことをお勧めします。もし欠品、破損がありましたら、バイオ・ラッ

ドまでご連絡ください。 
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システムの使用条件 
 
 

表１に、CFX Maestroソフトウェアを実行するコンピュータ（CFX Maestroコンピュータと呼ぶ）の

最低動作条件および推奨動作条件を示します。 

 

表１ CFX Maestroソフトウェアに関するコンピュータの動作環境 

システム 最低動作条件 推奨動作条件 

オペレーティングシステム Microsoft Windows 7 SP1 Pro 以下のいずれか： 

 Microsoft Windows 7 SP2 Pro（32

ビットおよび 64ビット） 

 Microsoft Windows 10 Pro（64ビ

ットのみ） 

 Microsoft Windows 10 Enterprise

（64ビットのみ） 

 重要：Microsoft Windows 10 Pro および Microsoft Windows 10 Enterpriseの両

方でセキュアブートを無効にしておく必要があります。 

ポート ２個の USB 2.0（高速ポート） ２個の USB 2.0（高速ポート） 

ハードディスク容量 128 GB 128 GB 

プロセッサ速度 2.4 GHz、デュアルコア 2.4 GHz、クアッドコア 

RAM 4GB RAM 8GB RAM 

画面解像度 1024 × 768ピクセル（トゥルーカラー

モード） 

1280 × 1024ピクセル（トゥルーカラ

ーモード） 

PDFリーダー  対応するMicrosoft Office Suiteのいず

れかの Adobe PDF Reader または
Windows PDF Reader 
 2007 
 2010 
 2013 

ローカライズ 対応する Microsoft Windows 32 ビッ

ト版および 64ビット版 OS（英語、中

国語、ロシア語） 

対応する Microsoft Windows 32 ビッ

ト版および 64ビット版 OS（英語、中

国語、ロシア語） 

 

注意：CFX Maestroと同じコンピュータ上で CFX Automation Controlソフトウェアを実行する場合に

は、画面解像度を 1280 × 1024ピクセル（トゥルーカラーモード）に設定してください。 

 

注意：MiniOpticon
TM
システムは、Microsoft Windows 7のオペレーティングシステムを実行できるコン

ピュータでのみ動作可能です（ただし MiniOpticonでの CFX Maestroの使用はお勧めしません）。CFX 

Maestro は、Microsoft Windows 10のオペレーティングシステムのどのバージョンを実行するコンピュ

ータでも MiniOpticonを認識しません。 
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CFX Maestroソフトウェアのインストール 
 

重要：ソフトウェアのインストールやアップグレードを行う前に、CFX Maestro コンピュータに接続

されているすべての機器の接続を解除する必要があります。ソフトウェアのインストール中、リアルタ

イム PCRサーマルサイクラーの電源を切る必要はありません。 

 

注意：どのバージョンのWindows 10に CFX Maestroソフトウェアをインストールする場合でも、イ

ンストール手順を開始する前にセキュアブートを必ず無効にしてください。 

 

以下の手順にて、CFX Maestroソフトウェアをインストールしてください。 

 

1. 必要に応じて、コンピュータから接続されているすべての機器の接続を解除しておいてください。 

CFX Maestro コンピュータにある機器の USB ケーブルを見つけて、接続を解除します。装置に

差し込まれているケーブルはそのままにしておくことができます。 

 

2. 管理者権限で CFX Maestroコンピュータにログインします。 

 

3. CFX Maestro ソフトウェアの USBドライブをコンピュータの USBポートに挿入します。 

 

4. Windows Explorerで、CFX Maestroソフトウェアの USBドライブにナビゲートし、これを開き

ます。 

USB ドライブには、Readme ファイル、CFX_Documentation インストーラ、および以下のフォ

ルダが含まれます。 

 
 CFX 

 
 Drivers 

 
 Firmware 

 

5. CFXフォルダを開き、Setup.exe をダブルクリックして CFX Maestroソフトウェアをインストー

ルします。 

 

6. 画面上のインストール手順に従ってください。 

完了すると、バイオ・ラッド CFX Maestroソフトウェアのスプラッシュ画面がコンピュータ画面

に表示され、バイオ・ラッド CFX Maestro のアイコンがデスクトップに表示されます。 

 

7. CFX_Documentation.exe をダブルクリックして CFX Maestro ソフトウェア文書をインストール

します。 

 

8. インストールの完了後、ソフトウェアの USBドライブを安全に取りはずすことができます。 
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接続機器の検出 
 

インストール中、CFX Maestroソフトウェアのインストーラは CFX Maestro コンピュータに機器のド

ライバを自動的にインストールします。CFX Maestro は、ソフトウェアの起動時に接続されている機

器を検出します。 

 

接続機器の検出方法 

 

1. 同梱の USBケーブルをサーマルサイクラーのベースの後ろにある USB Bポートに差し込んでい

ない場合には、USBケーブルの一端を差し込んでください。 

 

2. もう一端を CFX Maestroコンピュータの USBポートに差し込みます。 

 

3. リアルタイム PCRサーマルサイクラーがまだ起動していない場合には、機器の後ろにある電源ス

イッチを押して電源を入れます。 

 

4. CFX Maestro を起動します。 

 

接続されている機器がソフトウェアによって自動的に検出され、Home ウィンドウの Detected 

Instrumentsペインにその名前が表示されます。 

 

注意：機器が Detected Instruments ペインに表示されない場合には、USBケーブルが正しく設置され

ているかを確認してください。ドライバを再インストールするには、CFX Maestro の Home ウィンド

ウで Tools > Reinstall Instrument Drivers を選択します。 
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ソフトウェアファイル 
 

表２は、CFX Maestro ソフトウェアファイルのタイプを示します。 

 

表２ CFX Maestroソフトウェアファイルのタイプ 

ファイルタイプ 拡張子 詳細 

プロトコール .prcl PCRランを実施するためのプロトコール設定の詳細を含む 

プレート .pltd PCRランを実施するためのプレート設定の詳細を含む 

データ .pcrd 実験ランと PCR解析の結果を含む 

PrimePCRTMラン .csv PrimePCR プレート用のプロトコールとプレートレイアウト

情報を含む 

Gene Study .mgxd 複数の PCR ランを統合した遺伝子発現解析のデータファイ

ル 

スタンドアローンのプ

レデータファイル 

.zpcr スタンドアローンによる取得した蛍光データを含んでおり、

データファイルに変換可能 

LIMS .plrn LIMS準拠のランを処理するのに必要なプレート設定、プロト

コール情報を含む 
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第３章 ワークスペース 
 

CFX Maestroソフトウェアは、プレートの設定、PCRプロトコールの設定、これらの CFX機器での実

行、および PCRランからのデータの解析のためのインタフェースを提供します。 

 

CFX Maestro ソフトウェアには、５つの主要ワークスペースがあります。 

 

 Homeウィンドウ 

 
 Startup Wizard 

 

 Protocol Editorウィンドウ 

 

 Plate Editorウィンドウ 

 

 Data Analysisウィンドウ 

 

本章では、各ワークスペースについて表示と共に簡単に説明します。 
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Homeウィンドウ 
 

CFX Maestro ソフトウェアの Homeウィンドウを開くと Startup Wizardが表示されます。ここから、

実験の設定、ランの実行または繰り返し、あるいは既存のランの解析を行うことが可能です。Homeウ

ィンドウでは、アプリケーションや機器のログを表示し、ユーザーの作成や管理を行い、複数の便利な

ツールにアクセスすることもできます。詳細については、第４章の「Homeウィンドウ」を参照してく

ださい。 
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Startup Wizard 
 

Startup Wizardを使用して、ユーザー定義の実験の設定やランを、または PrimePCR
TM
実験の選択やラ

ンを迅速に行います。また、このウィザードを使用すると、ランの繰り返しやランデータの解析を行え

ます。 
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Protocol Editorウィンドウ 
 

Protocol Editorでは、プロトコールを作成し、開き、レビューし、さらに編集することができます。ま

た、特殊なプロトコール用にリッド温度を修正することもできます。Protocol Editor 機能については、

第５章の「プロトコールの作成」で詳述します。 
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Plate Editorウィンドウ 
 

Plate Editorでは、プレートを作成し、開き、レビューし、さらに編集することができます。Plate Editor

機能については、第 6章の「プレートの」で詳述します。 
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Data Analysisウィンドウ 
 

Data Analysisでは、ランデータの表示や比較、統計解析の実施、データのエクスポート、および発表

用レポートの作成が可能です。Data Analysis機能については、第８章の「データ解析について」で詳

述します。また、第９章の「データ解析の詳細」も参照してください。 
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第４章 Homeウィンドウ 
 

CFX Maestroソフトウェアは、PCRプロトコールを設定し、これらを CFX機器で実行し、PCRラン

データを解析するためのインタフェースを提供します。 

 

本章では、CFX Maestroソフトウェアについて紹介し、Homeウィンドウからアクセスできる機能につ

いて説明します。 
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Homeウィンドウ 
 

CFX Maestro の Homeウィンドウには Startup Wizardが表示され、ここでランの設定、ランの実行ま

たは繰り返し、あるいは既存のランの解析を行えます。Homeウィンドウからは、アプリケーションや

機器のログの表示、ユーザーの作成や管理、さらに複数の便利なツールへのアクセスも可能です。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

説明 

 
1 ソフトウェアのタイトルバーには、ソフトウェアのバージョン番号とログインしているユーザ

ーの名前が表示されます。 

 

2 メニューバーは、File、View、User、Run、Tools、Windowsおよび Helpのメニューコマンド

への迅速なアクセスを提供します。 

 

3 ツールバーコマンドは、メニューのオプションへの迅速なアクセスを提供します。 

 

4 左側のペインには、CFX Maestroコンピュータに接続されている機器が表示され、リッドを操

作して機器の状態を表示するためのボタンが用意されています。 

 

5 メインペインには、作業用ウィンドウが表示されます。Home画面のデフォルトの作業用ウィ

ンドウは Startup Wizardになっています。 

 

6 ステータスバーには、接続されている機器とログインしているユーザーの名前が表示されま

す。 
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Fileメニューコマンド 
 

New（新規） ― 新しいプロトコール、プレート、または Gene Studyの作成を選択できるダイアログ

ボックスを開く。 

 

Open（開く） ― 既存のプロトコール、プレート、データファイル、Gene Study、LIMSファイル、

スタンドアローン機器によるラン（スタンドアローンラン）、または PrimePCR ランファイルへナビ

ゲートしてこれらを開くことができるダイアログボックスを開く。 

 

Recent Data Files（最近のデータファイル） ― 最近開いた PCRファイルのリストを表示する。 

 

Repeat a Run（ランを繰り返す） ― 保存済みの PCRファイルの場所をWindows Explorerで開く。

ここでランを見つけて繰り返すことができる。 

 

Exit（終了） ― CFX Maestroを終了する。 

 

View メニューコマンド 
 

Application Log（アプリケーションのログ） ― 初回インストール時から現時点までの CFX Maestro

ソフトウェアの使用ログを表示する。 

 

Run Reports（ランレポート） ― ランレポートのリストを表示する。 

 

Startup Wizard（起動ウィザード） ― メインペインに Startup Wizardを表示する。 

 

Run Setup（ラン設定） ― メインペインに Run Setupウィンドウを表示する。 

 

Instrument Summary（機器の概要） ― メインペインに Instrument Summary ウィンドウを表示する。 
 

Detected Instruments（検出された機器） ― 接続されている機器の、左側のペインにおける表示と

非表示を切り替える。デフォルトでは、接続されている機器が左側のペインに表示される。 

 

Toolbar（ツールバー） ― 画面上部のツールバーの表示と非表示を切り替える。デフォルトでは、ツ

ールバーが表示されている。 

 

Status Bar（ステータスバー） ― 画面下部のステータスバーの表示と非表示を切り替える。デフォル

トでは、ステータスバーが表示されている。 

 

Show（表示） ― 以下を行えるダイアログボックスを開く。 

 

 Statusログの表示または非表示 

 

 CFX Maestro データフォルダを開いて表示 

 

 ユーザーのデータフォルダを開いて表示 

 

 LIMSファイルフォルダを開いて表示 

 

 PrimePCRフォルダを開いて表示 

 

 ラン履歴の表示 

 

 接続されているすべての機器の特性を表示 
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Userメニューコマンド 
 

Select User（ユーザーを選択） ― Login画面が開き、User Nameドロップダウンリストからユーザ

ーを選択してアプリケーションにログインできる。 

 

Change Password（パスワードを変更） ― Change Password ダイアログボックスが開き、CFX 

Maestro ソフトウェアのユーザーパスワードを変更できる。 

 

User Preferences（ユーザー基本設定） ― User Preferencesダイアログボックスが開き、以下のデフ

ォルト設定をユーザーが変更できる。 

 

 ラン完了時のメール通知の送受信 

 

 データファイルの保存 

 

 Protocol Editorまたは Protocol AutoWriterによるプロトコールの作成 

 

 プレートの作成 

 

 データの解析 

 

 遺伝子発現解析の実施 

 

 データの品質の判定 

 

 CFXデータのエクスポート 

 

User Administration（ユーザー管理者） ― User Administrationダイアログボックスが開き、管理者

はユーザーを作成し、役割許可を変更し、役割をユーザーに割り当てることができる。 

 

Bio-Rad Service Login（バイオ・ラッド社サービスログイン） ― バイオ・ラッド社の技術サービス

担当者のみが使用。このコマンドを選択しないでください。 

 

Runメニューコマンド 
 

User-defined Run（ユーザー定義のラン） ― Run Setupウィンドウが開き、ユーザー定義のプロト

コールやプレートを設定し、選択した機器で PCR実験を実施できる。 

 

PrimePCR Run（PrimePCRラン） ― デフォルトの PrimePCRプロトコールと選択した機器に基づ

きロードされるプレートレイアウト設定の Run Setupウィンドウに Start Runタブを開く。 

 

End-Point Only Run（エンドポイントのみのラン） ― デフォルトのエンドポイントプロトコールと

選択した機器に基づきロードされるプレートレイアウト設定のRun SetupウィンドウにStart Runタブ

を開く。 

 

Qualification Run（適正ラン） ― デフォルトのバイオ・ラッド社適正プロトコールと選択した機器

対応したプレートレイアウトが設定され、Run Setupウィンドウの Start Runタブを開く。 
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Toolsメニューコマンド 
 

Master Mix Calculator（マスターミックス計算機能） ― Master Mix Calculatorが開き、反応混合液を

作成して計算値を印刷できる。 

 

Protocol AutoWriter ― Protocol AutoWriterダイアログボックスが開き、新しいプロトコールを簡単に

作成できる。 

 

Ta Calculator（Ta 計算機能） ― Ta Calculatorが開き、プライマーのアニーリング温度を簡単に計算

できる。 

 

Dye Calibration Wizard（色素キャリブレーションウィザード） ― Dye Calibrationウィザードが開き、

新しい蛍光色素について機器のキャリブレーションを行える。 

 

Reinstall Instrument Drivers（機器の再インストールドライバ） ― バイオ・ラッド社のリアルタイ

ム PCRとの接続をコントロールするドライバを再インストールする。 

 

Zip Data and Log Files（データとログの Zip圧縮） ― 保管用に ZIPファイルに圧縮および保存する

かまたはメール送信するファイルを選択できるダイアログボックスが開く。 

 

Batch Analysis（バッチ解析） ― Batch Analysisダイアログボックスが開き、一度に２つ以上のデー

タファイルを解析するためのパラメータを設定できる。 

 

Options（オプション） ― 以下を行うためのダイアログボックスが開く。 

 

 メールサーバーの設定 

 

 LIMSおよびその他のデータファイルのエクスポート設定 

 

Helpメニューコマンド 
 

アドバイス：Helpメニューは、CFX Maestroソフトウェアのすべてのウィンドウのメニューバーで使

用できます。 

 

Contents（内容） ― CFX Maestroの Helpシステムの Contentsタブを表示する。 

 

Index（索引） ― CFX Maestroの Helpシステムの Contentsタブを表示する。 

 

Search（検索） ― CFX Maestroの Helpシステムの Contentsタブを表示する。 

 

Open User Guide（ユーザーガイドを開く） ― 本ガイドの PDFを開く。 

 

Additional Documentation（追加文書） ― 他の CFX Maestroの PDF文書や CFX機器ガイドへのア

クセスを提供する。 

 

qPCR Applications and Technologies Web Site（qPCRアプリケーションと技術ウェブサイト） ― 

バイオ・ラッド社のqPCR Applications & Technologiesウェブサイトが開き、リアルタイムPCR（qPCR）

に関する詳しい情報を得ることができる。 

 

qPCR Reagents Web Site（qPCR試薬ウェブサイト） ― バイオ・ラッド社の PCRおよび qPCR用

試薬に関するウェブサイトが開き、PCR 用試薬、スーパーミックス、色素、およびキットを注文でき

る。 

 

qPCR Plastic Consumables Web Site（qPCRプラスチック製消耗品ウェブサイト） ― バイオ・ラ

ッド社の PCRプラスチックおよび消耗品に関するウェブサイトが開き、PCR用プレート、プレートシ

ール、チューブとキャップ、およびその他のプラスチック製の付属品を注文できる。 
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Software Web Site（ソフトウェアウェブサイト） ― バイオ・ラッド社の PCR解析ソフトウェアの

ウェブサイトが開き、バイオ・ラッド社の最新版 CFX Maestroソフトウェアを注文できる。 

 

Check For Updates（アップデートの確認） ― ソフトウェアと機器の Updatesダイアログボックス

を開く。CFX Maestro コンピュータがインターネットに接続されている場合、ソフトウェアは新しい

ソフトウェアまたは機器のアップデートが可能であるかを検出し、必要なアップデートを自動的に実施

する。 

 

About（情報） ― CFX Maestroの商標とバージョン情報を表示する。 

 

Toolbarコマンド 
 

   ― Windows Explorer が開き、データファイルや Gene Study ファイルにナビゲートして開く

ことができる。 

 

   ― Master Mix Calculatorを開く。 

 

   ― Run Setupウィンドウを開く。 

 

   ― デフォルトの PrimePCR プロトコールと選択した機器に基づくプレートレイアウト設定の

Run Setupウィンドウを開く。 

 

   ― Startup Wizardを開く。 
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Startup Wizard 
 

CFX Maestroを起動すると、作業用ペインに Startup Wizardが表示されます。Startup Wizard から、

以下を行えます。 

 

 検出された機器のうちの１つを選択し、ユーザー定義のランまたは PrimePCR ランを設定する。 
 

 過去のデータファイルを指定して同じ条件でのランを繰り返す。 

 

 一回のランの結果を解析するためのデータファイル、もしくは複数の遺伝子発現解析ランからの

結果をまとめた Gene Studyファイルを開く。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

これらのタスクについては、後続の各章で詳述します。 

 

ステータスバー 
 

ソフトウェアのメインウィンドウ下部にあるステータスバーの左側には、検出された機器の現在のステ

ータスが表示されます。ステータスバーの右側には、現在のユーザー名、日付、時刻が表示されます。 
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Detected Instruments ペイン 
 

Detected Instrumentsペインには、CFX Maestroコンピュータに接続されている各機器が表示されます。

デフォルトでは、各機器はアイコンとして示され、そのシリアル番号が機器の名称として表示されます。

機器のリストには、C1000 Touchまたは S1000サーマルサイクラーにセットされているデュアルブロ

ックリアクションモジュール毎にブロック（ブロックＡおよびブロックＢ）が別々に表示されます。 

 

システムのアップデートが必要な機器には赤色の警告が表示されます。システムがアップデートされる

まではその機器を使用することができません。システムのアップデートに関する詳細については、44

ページの「ソフトウェアと機器のアップデート」を参照してください。 

 

例えば、以下の画像は検出された５つの機器が接続されています。 

 

 CFX96 リアクションモジュールを付属した C1000 Touchサーマルサイクラー（SIM29305） 

 

 デュアル 48-ウェルブロックを付属した S1000 サーマルサイクラー（SIM83388.A および

SIM83388.B）。これは C1000 Touchサーマルサイクラーに接続されている。 

 

 CFX96 Deep Wellリアクションモジュールを付属した C1000サーマルサイクラー（SIM66346） 

 

 CFX Connectサーマルサイクラー（SIM85866） 

 

アドバイス：本機器はアップデートする必要があります。システムをアップデートするまで、ユ

ーザーは本機器を使用できません。 
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このペインでは以下を行えます。 

 

 選択した機器の特性やキャリブレーションした色素の表示。 

 

 機器の特性に関する詳細については、42ページの「機器の特性を表示」を参照してください。 

 

 接続されている機器のステータスを表示。 

 

 選択した機器の電動リッドを開く。 

 

 選択した機器の電動リッドを閉じる。 

 

 接続されているすべての機器のステータスを表示。 

 

接続されている機器のステータスの表示方法 

 

 Detected Instruments ペインで、対象の機器を選択して以下のいずれかを行います。 

 Selected Instrumentセクションで View Statusをクリックする。 

 

 右クリックして表示されるメニューで View Statusを選択する。 

 

Run Detailsダイアログボックスが現れ、Run Statusタブが表示されます。選択した機器のステータス

は、例えば下図のようにランステータスペインの下に表示されます。 
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機器のリッドの開閉方法 

 

 Detected Instruments ペインで、対象の機器を選択して以下のいずれかを行います。 

 

 Selected Instrumentセクションで Open Lidまたは Close Lidをクリックする。 

 

 右クリックして表示されるメニューで適切な操作を選択する。 

 

 Run Detailsダイアログボックスを開いて Run Statusタブを選択し、Open Lidまたは Close 

Lidをクリックする。 

 

検出されたすべての機器のステータスの表示方法 

 

 以下のいずれかを行います。 

 

 Detected Instruments ペインの All Instrumentsセクションで、View Summaryをクリックす

る。 

 

 メニューバーで、View > Instrument Summaryを選択する。 

 

Instrument Summaryダイアログボックスが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

アドバイス：システムが検出した接続機器が１つだけの場合、All Instruments セクションは Detected 

Instruments ペインには表示されません。単一機器の場合に機器の概要を表示するには、View > 

Instrument Summaryを選択してください。 
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Instrument Summaryツールバーのコントロールボタン 

 

表３は、Instrument Summaryツールバーのコントロールボタンと機能を記載しています。 

 

表３ Instrument Summaryツールバーのツールバーボタン 

 

ボタン ボタン名称 機能内容 

 
Create a new Run Run Setupウィンドウを開いて選択されているブロック

にランを設定します。 

 

Stop 選択されているブロックの現在のランを停止します。 

 Pause 選択されているブロックの現在のランを一時中断しま

す。 

 
Resume 選択されているブロックのランを再開します。 

 

Flash Block Indicator 選択されているブロックのリッドのインジケータ LED

を点灯します。 

 

Open Lid 選択されているブロックの電動リッドを開きます。 

 

Close Lid 選択されているブロックの電動リッドを閉じます。 

 
Hide Selected Blocks Instrument Summary リスト内で選択されているブロッ

クを非表示にします。 

 

Show All Blocks Instrument Summary リスト内で選択されているブロッ

クを表示します。 

 

Show リスト内で表示するブロックを選択します。検出された

すべてのブロック、すべての待機ブロック、現ユーザー

で実行中のすべてのブロック、または実行中のすべての

ブロックから、表示オプションを１つ選択します。 
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機器の特性を表示 
 

Detected Instrumentsペインでは、選択した機器とその特性、輸送用ネジのステータス、およびキャリ

ブレーション済みの色素（蛍光色素）のリストに関する詳細を表示できます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

機器の特性の表示方法 

 

 Detected Instruments ペインで、対象の機器を右クリックして表示されるメニューの Properties

を選択します。 

 

Propertiesタブ 

 

Propertiesタブは、モデル、構成要素のシリアル番号、およびファームウェアのバージョンを含む選択

されている機器に関する技術詳細を記載します。機器（およびそのシリアル番号）のデフォルトの名称

が、Detected Instrumentsペインや Instrument Propertiesダイアログボックスのヘッダーバーを含む多

くの場所に表示されます。識別しやすくするように、機器の名称を変更できます。 

 

機器の名称変更方法 

 

 Instrument Propertiesタブで、Propertiesタブの上部にあるRenameボックス内に名称を入力し、

Renameをクリックします。 

 

新しい名称が Propertiesタブの Nickname列に表示され、さらに Instrument Properties ヘッダー

バーと Detected Instrumentsペインにも表示されます。 
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Shipping Screw タブ 

 

Shipping Screwタブは、選択されている機器の輸送用ネジに関する現在のステータスを表示します（取

りはずされているか設置されているか）。さらにこのタブは、赤色の輸送用ネジの取り付けまたは取り

はずし方法の説明を含んでいます。 

 

アドバイス：ソフトウェアで輸送用ネジが検出されると、Instrument Propertiesダイアログボックスに

は Shipping Screwタブが自動的に表示されます。指示に従ってネジを取りはずしてください。 

 

注意：機器を使用する前に輸送用ネジを取りはずしてください。詳細については、選択されている機器

に関する「機器のガイド」を参照してください。 

 
 

Calibrated Dyes タブ 

 

Calibrated Dyesタブは、キャリブレーション済みの蛍光色素と選択されている機器のプレートを表示

します。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

キャリブレーションの詳細については、Detail列内にある Infoボタンをクリックしてください。 
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はじめる前に 
 

ソフトウェアと機器のアップデート 
 

インターネットに接続すると、CFX Maestro ソフトウェアは起動のたびにアップデートを自動的に確

認します。また、接続されている機器がアップデート可能かどうかも判定します。アップデートが検出

されると、CFX Maestro は自動的にアップデートすることができます。 

 

アップデート可能な場合、Software and Instruments Updatesダイアログボックスが自動的に表示され

ます。 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

重要：アップデートが必要なシステムには、赤色で警告表示されます。必要なアップデートを行うまで

は、そのシステムを使用できません。 

 

ソフトウェアとシステムの両方のアップデートを実行する場合、ソフトウェアが先にアップデートされ

ます。最新のアップデートをダウンロードするには、CFX Maestro ソフトウェアを実行しているコン

ピュータをインターネットに接続する必要があります。アップデートを開始する前に、すべてのデータ

解析ウィンドウを閉じて、すべての機器がアイドル状態であることを確認してください。 

 

ソフトウェアのアップデートが完了すると、CFX Maestro は再起動した後に機器のアップデートを開

始します。CFX Maestroでは、機器のソフトウェアが、インストールされている CFX Maestroソフト

ウェアのバージョンと互換性があるかどうかを判定します。機器のソフトウェアに互換性がない場合、

そのアップデートを自動的に開始します。この操作にはインターネット接続は必要ありません。 

 

注意：アップデートの完了後に機器を再起動する必要があります。 
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ソフトウェアとシステムのアップデート方法 

 

 Software and Instrument Updates ダイアログボックスで、以下のいずれかを行います。 

 

 ソフトウェアまたはシステムのアップデートが可能な場合、いずれか適切なチェックボック

スを選択して Updateをクリックする。 

 

 ソフトウェアとシステムの両方のアップデートが可能な場合、両方のチェックボックスを選

択して Updateをクリックする。 

 

アドバイス：この場合、適切な通信を確保するため、ソフトウェアのアップデートには接続され

ているすべての機器のアップデートが必要です。 

 

Software and Instrument Updatesダイアログボックスの警告を非表示にする方法 

 

 新しいアップデートが可能な場合に Updates ダイアログボックスを非表示にするには、

Automatically show this window when updates are available チェックボックスを解除します。 

 

重要：取り付けられた機器のアップデートが必要な場合、Software and Instrument Updatesダイ

アログボックスは、このチェックボックスが解除されていても、自動的に表示されます。その機

器で実験を行うために、必要なアップデートを実行してください。 

 

Updatesダイアログボックスを表示するには、Homeウィンドウで Help > Check for Updates を

選択し、Notify when updates are available チェックボックスを選択してください。 

 

User Preferencesの設定 
 

アドバイス：CFX Maestro ソフトウェアを使用するためにこれらのタスクを行う必要はありません。

本節を飛ばしても差し支えなく、また、これらのタスクはいつでも行えます。 

 

CFX Maestro では、作業環境をカスタマイズできます。管理者がソフトウェアユーザーを作成した場

合、各ユーザーは各自の作業環境をカスタマイズできます。管理者がユーザーを作成しなかった場合、

基本設定の変更は CFX Maestroにログインする全員に適用されます。（CFX Maestroユーザーの作成

に関する詳細については、付録Ｂ「CFX Maestro のユーザーおよび役割の管理」を参照。） 

 

例えば、Users > User Preferences メニューでは以下を行えます。 

 

 ラン完了時のＥメール通知の設定。 

 

 以下のデフォルト設定を変更。 

 

 ファイルの保存先 

 

 ランの設定ファイル 

 

 ファイルのネーミング用接頭語 

 

 新ししいプロトコールとプレートを作成する場合に使用するデフォルトパラメータの設定。 

 

 デフォルトのデータ解析および遺伝子発現パラメータの設定。 

 

 デフォルトの品質管理パラメータのカスタマイズ。 

 

 データエクスポート用のデータパラメータのカスタマイズ。 
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Toolsメニューでは以下を行えます。 

 

 マスターミックスの作成。 

 

 特定機器用の色素のキャリブレーション。 

 

注意：マスターミックスと色素のキャリブレーションは、CFX Maestro にログインする全員が利用で

きます。 

 

本節では、これらのタスクの実施方法を詳述します。 

 

Ｅメール通知の設定 

 

CFX Maestro を発信用Ｅメールサーバーに接続して、ラン完了のＥメール通知をリストにあるユーザ

ーに送信することができます。また、データファイルや解析レポートを添付して送信することも選択で

きます。CFX Maestroとご使用の SMTPサーバーの接続方法については、47ページの「CFX Maestro

と SMTPサーバーの接続」を参照してください。 

 

Ｅメール通知の設定方法 

 

1. Users > User Preferences を選択して User Preferencesダイアログボックスを開きます。 

 

User Preferencesダイアログボックスが現れ、Emailタブが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

注意：CFX Maestro用の有効な SMTPサーバーが設定されていないことをシステムが検出した場

合には、通知されます。Configure Emailをクリックして Optionsダイアログボックスを開き、Ｅ

メール用の SMTP サーバーを設定してください。詳細については、47 ページの「CFX Maestro

と SMTPサーバーの接続」を参照してください。 
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2. To: テキストボックスに、ラン完了を通知する個人のＥメールアドレスを入力します。受信者は

全員、ラン完了後にＥメールを受信することになります。 

 

注意：各自のＥメールアドレスは改行して入力してください。各アドレスの後に Enter または

Returnを押してください。 

 

3. （オプション）cc: テキストボックスに、各Ｅメール通知のコピーを送信先のＥメールアドレス

を入力します。 

 

4. （オプション）デフォルトでは、すべての受信者がデータファイルのコピーを添付ファイルとし

て受信します。データファイルのコピーを添付したくない場合には、このチェックボックスを解

除してください。 

 

5. （オプション）Ｅメールに解析レポートの PDFファイルを添付するには、Attach Analysis Report

を選択します。 

 

6. OKをクリックして変更を保存し、User Preferencesダイアログボックスを閉じます。 

 

受信者のＥメールアドレスの編集方法 

 

 必要に応じてＥメールアドレスを修正し、OKをクリックします。 

 

Ｅメール受信者の削除方法 

 

1. Ｅメール受信者を選択して、Deleteキーを押します。 

 

2. OKをクリックして変更を保存し、ダイアログボックスを閉じます。 

 

重要：User Preferencesダイアログボックスの Restore Defaultsをクリックすると、すべてのタブのす

べての基本設定が工場出荷時の設定へとリセットされます。このボタンをクリックする際には注意して

ください。 

 

CFX Maestroと SMTPサーバーの接続 

 
 

1. 以下のいずれかを行います。 

 

 User > User Preferencesを選択してEmailタブのConfigure Outgoing Emailをクリックする。 
 

 Tools > Optionsを選択する。 

 

Optionsダイアログボックスが現れ、Emailタブが表示されます。 
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2. 以下の情報を団体全員に提供します。 

 

 SMTP Server Name（SMTPサーバー名） ― ご所属の発信用Ｅメールサーバーの名称。 

 

 Port（ポート） ― 使用する SMTPサーバーのポート番号。通常 25。 

 

 Use SSL（を使用） ― セキュアソケットレイヤー（SSL）のオプション。一部の SMTP

サーバーではこの設定が必要になります。ご所属で必要がなければ、このチェックボックス

を解除してください。 

 

 Use Default “From” Address（デフォルトの送信元アドレスを使用） ― ご所属のＥメー

ルサーバーの名称。一部の SMTPサーバーではすべての送信メールに特定のドメイン（例え

ば、＜名前＞@YourCompany.com）からの「from（送信元）」アドレスを含める必要があ

ります。その場合には、このチェックボックスを解除して、有効なＥメールアドレスを用意

してください。 

 

 Authentication Required（認証が必要） ― サイトでアカウント認証が必要な場合、この

チェックボックスが選択されていることを確認してください。 

 

 User Name（ユーザー名） ― 認証済みアカウントの名称。これは、Authentication Required

が選択されている場合にのみ必要です。 

 

 Password（パスワード） ― 認証済みアカウントのパスワード。これは、Authentication 

Requiredが選択されている場合にのみ必要です。 

 

3. SMTPサーバーの設定が正しいことを確認するため、Test Email Address テキストボックスに有

効なＥメールアドレスを入力して Test Emailをクリックします。 

 

注意：一部の SMTPサーバーでは添付ファイルが認められず、またそれ以外では一定サイズまで

の添付ファイルしか認められません。CFX Maestroでデータファイルおよび／またはレポートを

Ｅメール送信する場合には、Test Attachmentを選択して Attachment Sizeを MB単位で５メガバ

イト（MB）以上に設定してください。 

 

4. OKをクリックして変更を保存し、ダイアログボックスを閉じます。 
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デフォルトのファイル設定を変更 

 

User Preferenceダイアログボックスの Filesタブで、以下の変更を行えます。 

 

 CFX Maestro ファイルのデフォルト保存先。 

 

 ラン設定のデフォルトファイル。 

 

 デフォルトのファイルネーミング用パラメータ。 

 

デフォルトのファイル設定の変更方法 

 

1. Users > User Preferences を選択して User Preferencesダイアログボックスを開きます。 

 

2. User Preferencesダイアログボックスの Filesタブを選択します。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Default Folder for File Creation セクションでナビゲートして、新しいファイルの保存先になるデ

フォルトフォルダを選択します。以下のようなファイルタイプごとに異なる保存先を選択するこ

とができます。 

 

 Protocol（プロトコール） 

 

 Plate（プレート） 

 

 Data File（データファイル） 

 

 Gene Study（Gene Study） 

 

4. File Selection for Run Setup セクションでナビゲートして、Experiment Setupウィンドウを開い

た時に表示する対象のプロトコールファイルとプレートファイルを選択します。 
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5. Data Fileセクションで、データファイルの接頭語および／または接尾語を定義します。それぞれ

の部分で新しい値をドロップダウンリストから選択します。また、Prefix テキストボックスと

Suffixテキストボックスでカスタムの接頭語と接尾語を用意することも可能です。 

 

CFX Maestro の選択ボックスの下に、ファイル名のプレビューが表示されます。 

 

6. OKをクリックして変更を保存し、ダイアログボックスを閉じます。 

 

重要：User Preferencesダイアログボックスの Restore Defaultsをクリックすると、すべてのタブのす

べての基本設定が工場出荷時の設定へとリセットされます。このボタンをクリックする際には注意して

ください。 

 

デフォルトのプロトコールパラメータの設定 

 

Protocol Editorと Protocol AutoWriterのデフォルトのプロトコールパラメータの設定方法 

 

1. Users > User Preferences を選択して User Preferencesダイアログボックスを開きます。 

 

2. User Preferencesダイアログボックスの Protocolタブを選択します。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Protocol Editorセクションで、Protocol Editorに表示される以下の設定の値を指定します。 

 

 Sample Volume（サンプル容量） ― ウェル内のサンプルの容量（単位は µL）。 

 

 Lid Shutoff Temperature（リッドのヒーターシャットオフ温度） ― ラン実行時にリッドヒ

ーターが切れるブロック温度（単位は℃）。 
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4. Protocol AutoWriterセクションで、Protocol AutoWriterに表示される以下の設定の値を指定しま

す。 

 

 Annealing Temperature（アニーリング温度） ― iProof DNAポリメラーゼ、iTaq DNAポリ

メラーゼ、またはその他のポリメラーゼを使用した実験時の温度（単位は℃）。 

 

 Amplicon Length（アンプリコン長さ） ― アンプリコンの長さ（単位は bp）。 

 

5. OKをクリックして変更を保存し、ダイアログボックスを閉じます。 

 

重要：User Preferencesダイアログボックスの Restore Defaultsをクリックすると、すべてのタブのす

べての基本設定が工場出荷時の設定へとリセットされます。このボタンをクリックする際には注意して

ください。 

 

デフォルトのプレートパラメータの設定 

 

Plate タブへの変更を、ソフトウェアのすべてのユーザーが利用できます。プレート設定中に行う変更

は、保存してプレートファイルを閉じた後に、ユーザーが利用できます。 

 

User Preferencesダイアログボックスでは、以下を行えます。 

 

 デフォルトのプレートパラメータの設定。 

 

 各ライブラリへの新しいターゲット名、サンプル名、および生物学的グループ名の追加。 

 

 各ライブラリからのターゲット名、サンプル名、および生物学的グループ名の削除。 

 

デフォルトのプレートパラメータの設定方法 

 

1. Users > User Preferences を選択して User Preferencesダイアログボックスを開きます。 

 

2. User Preferencesダイアログボックスの Plateタブを選択します。 
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3. 新しいプレートファイルに関する以下の設定の値を指定します。これらの値は、Plate Editorウィ

ンドウに表示されます。 

 

 Plate Type（プレートタイプ） 

 

 Plate Size（プレートサイズ） 

 

 Units（単位） ― 標準物質を含むウェルの初期鋳型濃度。 

 

CFX Maestroでは、これらの単位を使用して Data Analysis Quantification タブに検量線を作

成します。 

 

 Scientific Notation（指数表記） ― これを選択すると、CFX Maestroは指数表記で濃度の

単位を表示します。 

 

 Scan Mode（スキャンモード） ― ラン実行時にスキャンするチャンネル数またはチャン

ネルのタイプ。 

 

 Fluorophores（蛍光色素） ― Plate Editorのウェルのロードコントロールに表示されるデ

フォルトの蛍光色素。 

 

 Libraries（ライブラリ） ― 実験で主に使用するターゲット、サンプル、および生物学的グ

ループ。 

 

 Target Names（ターゲット名） ― ターゲット遺伝子と配列の名称。 

 

 Sample Names（サンプル名） ― 実験サンプルの名称またはサンプルの識別特性（例

えば、1Hr）。 

 

 Biological Names（生物学的グループ名） ― 同一の処理状態または条件（例えば、

治療済み、未治療、正常、腫瘍）を備えた同様のサンプル群の名称。 

 

4. OKをクリックして変更を保存し、ダイアログボックスを閉じます。 

 

新しいターゲット名、サンプル名、または生物学的グループ名の追加方法 

 

 該当するライブラリボックスにターゲット、サンプル、または Biological Group の名称を入力し

て OKをクリックします。 

 

ターゲット名、サンプル名、または生物学的グループ名の削除方法 

 

 該当するライブラリボックスで名称を選択して Deleteキーを押し、OKをクリックします。 

 

重要：ライブラリから削除した名称はソフトウェアから削除されるため、ユーザーは使用できなくなり

ます。デフォルトの CFX Maestroの名称を復元するには、Restore Defaultsをクリックします。User 

Preferencesダイアログボックスの Restore Defaultsをクリックすると、すべてのタブのすべての基本

設定が工場出荷時の設定へとリセットされます。デフォルトの CFX Maestroの名称を削除する場合お

よびこのボタンをクリックする場合には注意してください。 
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デフォルトのデータ解析パラメータの設定 

 

デフォルトのデータ解析パラメータの設定方法 

 

1. Users > User Preferences を選択して User Preferencesダイアログボックスを開きます。 

 

2. User Preferencesダイアログボックスの Data Analysisタブを選択します。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Analysis Modeセクションで、データを解析するためのモードを選択します（Fluorophore（蛍光

色素別）または Target（ターゲット））。 

 

4. PCR Quantitationセクションで、以下のオプションのデフォルトパラメータを設定します。 

 

 Baseline Setting（ベースライン設定） ― 解析モード用のベースライン手法。 

 

 Cq Determination Mode（Cq計算モード） ― 各蛍光トレースについて Cq値を計算するモー

ド（回帰法または単一閾値）。 

 

 Threshold Calc. Mode（閾値計算モード） ― エンドポイントターゲット量。 

デフォルトは Autoです。すなわち、ソフトウェアはエンドポイントターゲットを自動的に計

算します。特定の閾値を設定するには、Autoチェックボックスを解除して、相対蛍光単位（ま

たは RFU）で計算された指定のエンドポイント量を入力します。最大値は 65000.00RFU で

す。その後のランのデータファイルでは、この閾値設定が適用されます。 

 

 Baseline Calc. Mode（ベースライン計算モード） ― すべてのトレースのベースライン値。 

デフォルトは Autoです。すなわち、ソフトウェアはすべてのトレースのベースラインを自動

的に計算します。特定のベースライン値を設定するには、Autoチェックボックスを解除して、

サイクルレンジ（1～9999）の最小値と最大値を入力します。その後のランのデータファイル

では、このサイクルレンジが適用されます。 
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 Log View（ログ表示） ― ソフトウェアによる増幅データの表示方法を決定する。 

 

 On（オン） ― 増幅データは片対数グラフで表示される。 

 

 Off（オフ） ― （デフォルト）増幅データは線形グラフで表示される。 

 

5. End Pointセクションで、エンドポイント計算を行う場合に平均化するためのエンドサイクルの数

を選択します。 

 

 PCR（PCRラン） ― 定量化データを平均化するためのエンドサイクルの数（デフォルトは

5）。 

 

 End Point Only Run（エンドポイントのみのラン） ― エンドポイントデータを平均化する

ためのエンドサイクルの数（デフォルトは２）。 

 

6. Melt Curve セクションで、検出するピークのタイプを選択します（正または負）。 

 

7. Well Selectorセクションで、ウェルラベルの表示方法を選択します（サンプルタイプ、ターゲッ

ト名称、またはサンプル名称より）。 

 

8. OKをクリックして変更を保存し、ダイアログボックスを閉じます。 

 

重要：User Preferencesダイアログボックスの Restore Defaultsをクリックすると、すべてのタブのす

べての基本設定が工場出荷時の設定へとリセットされます。このボタンをクリックする際には注意して

ください。 

 

デフォルトの遺伝子発現データファイルパラメータの設定 

 

新しい遺伝子発現データファイルのデフォルトパラメータの設定方法 

 

1. Users > User Preferences を選択して User Preferencesダイアログボックスを開きます。 

 

2. User Preferencesダイアログボックスの Gene Expressionタブを選択します。 
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3. 以下の設定の値を指定します。 

 

 Relative To（相対） ― 対照（１を始点とする）またはゼロに対する遺伝子発現データを

グラフ化します。 

 

 Zero（ゼロ） ― ソフトウェアは対照を無視します。これは、対照サンプルがExperiment 

Settingsウィンドウで割り当てられていない場合のデフォルトです。 

 

 Control（対照） ― ソフトウェアは、Experiment Setupウィンドウで割り当てられて

いる対照サンプルに相対的なデータを計算します。 

 

 X-Axis（X軸） ― グラフ x軸上にサンプルまたはターゲットを選択します。 

 

 Y-Axis（Y軸） ― グラフ y軸上に線形、log2または log10のスケールを選択します。 

 

 Scaling（基準化） ― グラフの基準化オプション。（デフォルトは Unscaled（非基準化）

です） 

 

 Highest（最高点） ― ソフトウェアはグラフをデータの最高点で基準化します。 

 

 Lowest（最低点） ― ソフトウェアはグラフをデータの最低点で基準化します。 

 

 Unscaled（非基準化） ― ソフトウェアはグラフの基準化されていないデータを提示

します。 

 

 Method（解析法） ― 正規化発現（ΔΔCq）または相対発現（ΔCq）のいずれかより解析モ

ードを選択します。 

 

 Error Bar（エラーバー） ― 標準偏差（Std.Dev.）または平均値の標準誤差（Std. Error Mean）

としてデータの変動を示します。 

 

 Error Bar Multiplier（エラーバー乗数） ― エラーバーのグラフ化に使用する標準偏差の乗

数（デフォルトは１）。 

 

乗数は２または３に変更できます。 

 

 Sample Types to Exclude（除外するサンプルタイプ） ― 解析から除外するサンプルタイ

プ。 

 

１つ以上のサンプルを解析から除外することができます。すべてのサンプルタイプを除外す

るには、選択されているサンプルタイプのチェックボックスを解除します。 

 

4. OKをクリックして変更を保存し、ダイアログボックスを閉じます。 

 

重要：User Preferencesダイアログボックスの Restore Defaultsをクリックすると、すべてのタブのす

べての基本設定が工場出荷時の設定へとリセットされます。このボタンをクリックする際には注意して

ください。 
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品質管理（QC）ルールのカスタマイズ 

 

CFX Maestroでは、Data Analysisウィンドウ内のデータに適用される品質管理ルールを設定できます。

設定されたルールに反するデータが、ソフトウェアにより検証されます。 

 

注意：デフォルトでは、すべての品質管理ルールが有効です。 

 

アドバイス：QC パラメータを満たさないウェルを、Data Analysis ウィンドウの QC モジュールにお

ける解析から容易に除外できます。 

 

品質管理ルールのカスタマイズ方法 

 

1. Users > User Preferences を選択して User Preferencesダイアログボックスを開きます。 

 

2. User Preferencesダイアログボックスの QCタブを選択します。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ここで、 

 

 NTC（No Template Control） ― テンプレート無しコントロール 

 

 NRT（No Reverse transcription Control） ― 逆転写反応無しコントロール 

 

 Efficiency（効率） ― PCR効率 

 

 Std Curve R
2
（検量線 R

2
） ― 検量線のＲ二乗値（相関係数） 

 

 Replicate group Cq Std Dev（リプリケートグループの Cq標準偏差） ― 各リプリケート

グループについて算定される標準偏差。 
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3. 各 QCルールについて、以下のいずれかを行います。 

 

 デフォルト値を使用する場合には、何も行わない。 

 

 値を変更する場合、Value テキストボックスをクリックして新しい値を入力し、Enter キー

を押す。 

 

 ルールを無効にする場合には、Useチェックボックスを解除する。 

 

4. OKをクリックして変更を保存し、ダイアログボックスを閉じます。 

 

重要：User Preferencesダイアログボックスの Restore Defaultsをクリックすると、すべてのタブのす

べての基本設定が工場出荷時の設定へとリセットされます。このボタンをクリックする際には注意して

ください。 

 

データエクスポートパラメータのカスタマイズ 

 

CFX Maestro のデータは以下のフォーマットでエクスポートできます。 

 
 Text (.txt) 

 
 CSV (.csv) 

 
 Excel 2007 (.xlsx) 

 
 Excel 2003 (.xls) 

 
 XML (.xml) 

 
 HTML (.html) 
 

エクスポートするデータのタイプを指定して、エクスポートされるデータの出力をカスタマイズするこ

とができます。 

 

データエクスポートパラメータのカスタマイズ方法 

 

1. Users > User Preferences を選択して User Preferencesダイアログボックスを開きます。 

 

2. User Preferencesダイアログボックスの Custom Export タブを選択します。 
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3. Export Formatドロップダウンリストから、データをエクスポートするフォーマットを選択します。 
 

4. Data to Export セクションで、エクスポートするデータのタイプに関するチェックボックスを選択

または解除します。選択した項目が Exported Columnsリストボックスに表示されます。 

 

注意：デフォルトでは、ラン情報がヘッダーに含まれます。ラン情報を含めたくない場合には、

このチェックボックスを解除してください。 

 

5. 選択した項目の出力表示順序を変更できます。 

 

Exported Columns リストボックス内の項目を強調表示して、リストの左側にある矢印ボタンをク

リックし、それを上下に移動させます。 

 

6. 任意で、選択した項目の出力カラムの名称を以下の手順で変更できます。 

 

a. Customize Column Names をクリックします。 

 Column Name Customizerダイアログボックスが表示されます。 

 

b. 変更したい各デフォルトカラム名について、Custom Nameフィールドに新しい名称を入力

します。 

 

c. 以下のいずれかを行います。 

 

 OKをクリックして変更を保存し、Custom Export タブに戻る。新しい名称が Exported 

Columnsリストボックス内のデフォルトカラム名の横にある括弧内に表示されます。 

 

 Cancelをクリックして変更を行わずに Custom Export タブに戻る。 

 

7. OKをクリックして変更を保存し、ダイアログボックスを閉じます。 

 

重要：User Preferencesダイアログボックスの Restore Defaultsをクリックすると、すべてのタブのす

べての基本設定が工場出荷時の設定へとリセットされます。このボタンをクリックする際には注意して

ください。 
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マスターミックス反応液の調製 
 

CFX Maestroの Master Mix Calculatorを使用すると、マスターミックス内の必要な各成分量を容易に

計算することができます。マスターミックス計算表をデフォルトのプリンターで印刷し、後の使用のた

めに各ターゲットの計算値を保存しておくことができます。 

 

Master Mix Calculatorを使用したマスターミックス反応液の調製 

 

1. Master Mix Calculatorを以下のいずれかの方法で開きます。 

 

 Tools >Master Mix Calculator を選択する。 

 

 ツールバーの Master Mix Calculatorをクリックする。 

 

Master Mix Calculatorが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Reactionセクションで、検出方法を選択します。 

 
 SYBR

®
 Green/EvaGreen 

 

 Probes（プローブ） 

 

3. 新しいターゲットを作成するには、Target セクションの Create Newをクリックします。新しい

ターゲット名がターゲットのドロップダウンリストに表示されます。 
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4. （オプション）デフォルトのターゲット名を変更するには以下を行います。 

 

a ドロップダウンのターゲットリストにあるターゲット名を強調表示する。 

 

b.  Target ボックスに新しいターゲット名を入力する。 

 

c.  Enterキーを押す。 

 

5. フォワードプライマー、リバースプライマー、およびプローブの初期濃度と最終濃度を調節しま

す。 

 

6. Master Mix Setupセクションで以下の値を調節します。 

 

 ランする反応数 

 

 １ウェルあたりの反応液量 

 

 各ウェルに加えるテンプレート液量 

 

 １ウェルあたりのスーパーミックス濃度 

 

 １ウェルあたりの余剰反応液量 

 

7. （オプション）必要な数のターゲットについて手順２～６を行います。 

 

8. Choose Target to Calculateセクションで計算するターゲットを選択します。 

 

アドバイス：ターゲットの計算は、１つだけ、あるいは同時に複数またはすべてのターゲットに

ついて可能です。 

 

選択したターゲットそれぞれに必要な成分について計算した液量が、マスターミックス表に表示

されます。 

 

9. Set as Defaultをクリックして、各液量の入力を新しいデフォルト値として Target and Master Mix 

Setupセクションに設定します。 

 

10. OKをクリックして Master Mix Calculatorダイアログボックスの内容を保存します。 

 

マスターミックス計算表の印刷方法 

 

 マスターミックス計算表を印刷するには、Printをクリックします。 

 

計算表は、デフォルトのプリンターに印刷されます。 

 

マスターミックス計算表を PDFファイルに保存する方法 

 

 お使いのデフォルトのプリンターを PDFドライバに変更し、Master Mix Calculatorの Printをク

リックします。 

 

ターゲットの削除方法 

 

 ターゲットのドロップダウンリストでターゲットを選択して Removeをクリックします。 

 

重要：ターゲットは、ターゲットリストから削除されると、そのターゲットを使用しているマス

ターミックス計算からも削除されます。ターゲットを削除する際は注意してください。 
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新しい色素のキャリブレーション 
 

CFX96 Touch、CFX96 Touch Deep Wellおよび CFX Connectの各システムは、白色ウェルプレートお

よび透明ウェルプレートで高頻度に使用される蛍光色素に対し工場出荷時にキャリブレーションされ

ています。CFX384 Touchシステムは、白色ウェルプレートのみ工場でキャリブレーション処理済みで

す。表４に、各機器のキャリブレーションを要する蛍光色素とチャンネルを記載します。 

 

注意：CFX96 Touch、CFX96 Touch Deep Well、CFX Connect および CFX384 Touchの各システムは、

FRETケミストリーに適したチャンネルを含みます。このチャンネルに対しては、特定の色素のキャリ

ブレーションが不要です。 

 

表４ 工場でキャリブレーション済みの蛍光色素、チャンネルおよび機器 

蛍光色素 チャンネル 励起（nm） 検出（nm） 機器 

FAM, SYBR Green I 1 450～490 515～530 CFX96 Touch、CFX96 Touch 

Deep Well、CFX Connect お

よび CFX384 Touchの各シス

テム 

VIC, HEX, CAL Fluor 
Gold 540, Cal Fluor 
Orange 560 

2 515～535 560～580 CFX96 Touch、CFX96 Touch 

Deep Well、CFX Connect お

よび CFX384 Touchの各シス

テム 

ROX, Texas Red, CAL 
Fluor Red 610, TEX 615 

3 560～590 610～650 CFX96 Touch、CFX96 Touch 

Deep Well および CFX384 

Touchの各システム 

CY5, Quasar 670 4 620～650 675～690 CFX96 Touch、CFX96 Touch 

Deep Well および CFX384 

Touchの各システム 

Quasar 705, Cy5.5 5 672～684 705～730 CFX96 Touch および CFX96 

Touch Deep Wellの 2システ

ムのみ 
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CFXシステム用の新しい色素のキャリブレーション方法 

 

1. Homeウィンドウの Detected Instruments ペインでターゲットの機器を選択します。 

 

2. Tool > Calibration Wizard を選択して Dye Calibrationウィザードを開きます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ターゲット機器についてすでにキャリブレーションされている蛍光色素が Calibrated 

Flurophores表に表示されます。 

 

3. Calibrate Newまたは Existing Fluorophores セクションで、ドロップダウンリストからキャリブレ

ーションする蛍光色素を選択します。 

 

蛍光色素の名称がリストに含まれていない場合には、テキストボックスに名称を入力してリスト

に追加してください。 

 

4. 蛍光色素のプレートタイプを選択します。 

 

プレートタイプがリストに含まれていない場合には、テキストボックスに名称を入力してリスト

に追加してください。 

 

5. 蛍光色素のチャンネルを選択します。 

 

6. 蛍光色素のプレートカラムを選択します。 

 

7. （オプション）蛍光色素に関連付ける色を入力します。 

 

8. Add to Plateをクリックして蛍光色素を追加します。 

 

9. （オプション）手順３～８を繰り返し行い、プレートに対してキャリブレーションしたい蛍光色

素を追加します。 

 

10. 蛍光色素の追加を完了したら、View Plate をクリックして Pure Dye Plate Displayウィンドウを

開きます。 

 

このウィンドウは、プレートに色素を設定する際のガイドとなります。 
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11. 色素のキャリブレーション用に 96ウェルプレートまたは 384ウェルプレートの調製を行います。 
 

a. Pure Dye Plate Displayに示すパターンにしたがい、色素溶液を各ウェルに分注する。 

 

b. 蛍光色素ごとに、50μL（96ウェルプレート）または 30μL（384ウェルプレート）の 300 nM

色素溶液を４つのウェルに注入します。なお、プレート内の半分以上は空のウェルを含めて

ください。 

 

c. 実験に使用する方法でプレートをシーリングします。 

 

12. ブロック内にキャリブレーションプレートをセットして、リッドを閉じます。 

 

13. Dye Calibrationウィザードの Calibrateをクリックした後、OKをクリックしてプレートがブロッ

ク内にあることを確定します。 

 

14. CFX Maestroソフトウェアによってキャリブレーションのランが完了すると、ダイアログボック

スが表示されます。Yesをクリックすると、キャリブレーションが終了し、Dye Calibration Viewer

が表示されます。 

 

15. OKをクリックしてウィンドウを閉じます。 
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第５章 プロトコールの作成 
 

プロトコールは、特定の配列で実行されるステップのセットです。CFX Maestro ソフトウェアでは、

すべてのステップが機器のオプションに関連付けられています。例えば、ステップは機器にブロックと

リッド温度の制御を指示し、ブロック間の温度差を適用し、プレートリード、あるいは融解曲線の解析

を実施します。各オプションは、各種プレートおよびランタイプについて指定されます。 

 

CFX Maestroでは、Protocol Editorと Protocol AutoWriterの２つのプロトコール作成用オプションを

ご提供します。 

 

Protocol Editorは、以下を含むことを特徴としています。 

 

 プロトコールを迅速に作成するための標準プロトコールコントロールボタン 

 

 温度グラジェントを迅速に計算する機能 

 

 選択したプレートタイプのラン時間を迅速に計算する機能 

 

 プロトコールのステップを編集する機能 

 

 再使用のためにプロトコールを保存する機能 

 

 プロトコールをデフォルトのプリンターに印刷する機能 

 

Protocol AutoWriterは、提供されるパラメータを使用して、ホットスタート、初期変性、アニーリング、

および伸長の各ステップを含むカスタマイズされた PCRプロトコールを自動的に生成します。これに

より、推奨されるプロトコールをグラフィックで表示でき、さらにプロトコールの編集、ラン、または

保存を行えます。 
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Protocol Editorウィンドウ 
 

Protocol Editorを使用して、プロトコールを作成し、開き、レビューし、さらに編集します。デフォル

トでは、Protocol Editorが開くと 96ウェルプレート用の一般的なリアルタイム２ステッププロトコー

ルが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

説明 

 
1 メニューバーは、File、Settings および Tools の各メニューコマンドへの迅速なアクセスを提

供します。 

2 ツールバーは、プロトコールの保存と印刷、ステップを挿入する場所の決定、サンプル容量の

設定、および推定されるプロトコールのラン時間の表示を迅速に行います。 

3 メインペインには、プロトコールのグラフィック表現が表示されます。 

4 下部のペインには、プロトコールのアウトラインが表示されます。 

5 左側のペインには、プロトコールをカスタマイズするために追加できるプロトコールコントロ

ールボタンが表示されます。 

 

Fileメニューコマンド 
 

Save（保存） ― 現在のプロトコールを保存します。 

 

Save As（別名で保存） ― 現在のプロトコールを新しい名前または新しい場所に保存します。 

 

Close（閉じる） ― Protocol Editorを閉じます。 

 

Settingsメニューコマンド 
 

Lid Settings（リッドの設定） ― Lid Settingダイアログボックスを開きます。ここではリッド温度の

変更や設定を行えます。 
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Toolsメニューコマンド 
 

Gradient Calculator（グラジェント計算機） ― このダイアログボックスでは、グラジェントステッ

プを行うブロックタイプを選択できます。デフォルトは 96ウェルです。 

 

Run time Calculator（ラン時間計算機） ― このダイアログボックスでは、Run Setupウィンドウの

推定ラン時間を計算するための、プレートタイプとスキャンモードを選択できます。デフォルトは 96

ウェルとすべてのチャンネルになっています。 

 

Toolbarコマンド 
 

   ― 現在のプロトコールファイルを保存します。 

 
 

   ― 選択しているウィンドウを印刷します。 

 
 

         ― このコマンドを使用して、現在選択しているステップのどちら側にステップを

挿入するかを選択します。 

 
 

          ― このコマンドを使用して、µL単位でサンプル容量を入力します。サンプル容

量はブロックのタイプによって異なります。 

 

 96ディープウェルブロックの場合、0～125 µLの範囲 

 

 96ウェルブロックの場合、0～50 µLの範囲 

 

 384ウェルブロックの場合、0～30 µLの範囲 

 

サンプル容量の詳細については、73ページの「サンプル容量の設定」を参照してください。 

 

         ― プロトコールのステップ、加温・冷却速度、および選択しているブロックのタ

イプから推定されたラン時間を表示します。 

 

   ― プロトコールに関する Help情報を表示します。 
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プロトコール編集用コントロールボタン 
 

Protocol Editorウィンドウの左側のペインには、プロトコール作成用のコントロールボタンが含まれま

す。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

各コントロールボタンは、プロトコール内の１ステップを示すパラメータセットからなります。各パラ

メータを修正し、それを追加または削除してプロトコールをカスタマイズすることができます。本節で

は、各コントロールボタンのオプションについて説明します。 

 

 Insert Step（ステップの挿入） ― 選択しているステップの前または後にステップを挿入します。

温度と保持時間の値をプロトコールのグラフィック表示またはプロトコールのアウトラインで編

集することができます。 

 

 Insert Gradient（グラジェントの挿入） ― グラジェント計算機で選択されたウェルブロックの

タイプに基づき、グラジェントステップを挿入します。グラジェントステップを挿入すると表示

される Gradientペインで、グラジェント範囲を編集することができます。 

 

 Insert GOTO（GOTOの挿入） ― ソフトウェアに、指定のサイクル数だけ指定のステップを順

次反復させるサイクリング（ループ）ステップを挿入します。反復は、最初のサイクル完了後に

始まります。例えば、ソフトウェアにステップ２～４を 39回反復させることができます。最後の

反復後、ソフトウェアはステップ２～４を合計 40回行ったことになります。グラフィック表示ま

たはプロトコールのアウトラインで return-to（GOTO）ステップとサイクル数を編集することが

できます。 

 

 Insert Melt Curve（融解曲線を挿入） ― 融解曲線の読み取りステップを挿入します。 

 

 Insert Plate Read to Step（プレートリードステップを挿入） ― 選択しているステップにプレ

ートリードコマンドを追加します。プレートリードでは、サイクルの最後における蛍光色素の量

を測定します。プレートリードステップは一般に、GOTO ループの最後のステップになっていま

す。 

 

アドバイス：プレートリードコマンドをステップに追加した後、そのステップを選択するとボタ

ンが Remove Plate Readに変わります。 

 

 Remove Plate Read（プレートリードを削除） ― 選択しているステップからプレートリードコ

マンドを削除します。 

 

アドバイス：プレートリードコマンドをステップから削除した後、そのステップを選択するとボ

タンが Add Plate Read to Stepに変わります。 
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 Step Options（ステップのオプション） ― Step Optionsダイアログボックスを開くと、選択し

ているステップで使用できるオプションが表示されます。ステップのオプションに関する詳細に

ついては、69ページの「ステップのオプション」を参照してください。 

 

アドバイス：Step Optionsへのアクセスは、グラフィック表示内のステップを右クリックしても

行えます。 

 

 Delete Step（ステップの削除） ― プロトコールから選択しているステップを削除します。 

 

ステップのオプション 

 

Step Optionsダイアログボックスを開くと、ステップに追加、変更、またはステップから削除できるオ

プションが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Plate Read（プレートリード） ― これを選択すると、ステップにプレートリードが追加されま

す。 

 

 Temperature（温度） ― 選択しているステップにおけるターゲット温度を設定します。 

 

 Gradient（グラジェント） ― ステップのグラジェント範囲を設定します。範囲は 1～24 ℃です。 

 

注意：グラジェントのランは、ブロックの前方（画像では列Ｈ）では最低温度、ブロックの後方

（画像では列Ａ）では最高温度で実行されます。 

 

 Increment（増分） ― 選択しているステップの温度の増加（または減少）量。この値は、各サ

イクルでターゲット温度に追加されます。範囲は±0.1～10 ℃です。 

 

注意：温度を低下させるには、数値の前にマイナス記号（-）を入力してください（例えば、-5 ℃）。 

 

 Ramp Rate（加温・冷却速度変化） ― 選択しているステップの加温・冷却速度変化。範囲はブ

ロックサイズによって異なります。 

 

 Time（時間） ― 選択しているステップの保持時間です。 

 

 Extend（延長） ― 選択しているステップを延長または短縮する時間（秒単位）。このオプショ

ンは各サイクルの保持時間に追加されます。範囲は 1～60秒です。 

 

 Beep（ビープ音） ― これを選択すると、ステップの最後にビープ音が鳴ります。 

 

アドバイス：オプションの範囲外の数値を入力すると、ソフトウェアは範囲内でその値に最も近

い値へ変更します。 
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Protocol Editorでプロトコールを作成 
 

Protocol Editorを使用してカスタムプロトコールファイルを作成することができます。また、以前保存

したプロトコールファイルや CFX Maestroソフトウェアと同梱されたサンプルプロトコールファイル

の編集や保存も可能です。 

 

新しいプロトコールファイルを作成するには、以下を行います。 

 

 Protocol Editorでプロトコールファイルを開く。 

 

アドバイス：Protocol Editorで、新規または既存のプロトコールを開くことができます。 

 

 新しいプロトコールの設定。 

 

 プロトコールコントロールボタンのペインからプロトコールにステップを追加する。 

 

 ステップのプロパティの編集。 

 

 プロトコールの保存。 

 

アドバイス：以前保存したプロトコールファイルまたはサンプルプロトコールファイルから新しいプロ

トコールを作成するには、71 ページの「Protocol Editor で既存のプロトコールを開く」を参照してく

ださい。 

 

Protocol Editorで新しいプロトコールファイルを開く 
 

CFX Maestroは、新しいプロトコールファイルを開くための以下の複数のオプションをご提供します。 

 

 Homeウィンドウから開く。 

 

 Startup Wizardダイアログボックスから開く。 

 

 Run Setupダイアログボックスから開く。 

 

Homeウィンドウから新しいプロトコールファイルを開く方法 

 

 File > New > Protocolを選択します。 

 

Protocol Editorウィンドウが開き、デフォルトのプロトコールファイルが表示されます。 

 

アドバイス：デフォルトのプロトコールの設定に関する詳細については、49ページの「デフォル

トのファイル設定の変更方法」を参照してください。 

 

Startup Wizardから新しいプロトコールファイルを開く方法 

 

1. Startup Wizard が見当たらない場合には、Home ウィンドウで以下のいずれかを行い、Startup 

Wizardを開きます。 

 

 View > Startup Wizard を選択する。 

 

 ツールバーの Startup Wizardをクリックする。 

 

デフォルトでは、Startup Wizardには CFX96が選択されている Run Setupタブが表示されます。 

 

2. 必要に応じて、ドロップダウンリストから機器タイプを選択します。 

 

3. ランタイプとして User-definedをクリックします。 

Run Setupダイアログボックスで Protocolタブが開き、デフォルトのプロトコールファイルが表

示されます。 
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4. Create Newをクリックします。 

 

Protocol Editorウィンドウが開き、デフォルトのリアルタイムプロトコールが表示されます。 

 

Run Setupダイアログボックスから新しいプロトコールを開く方法 

 

1. Homeウィンドウで以下のいずれかを行い、Run Setupダイアログボックスを開きます。 

 

 Run > User-defined Runを選択する。 

 

 ツールバーで User-defined Run Setupをクリックする。 

 

Run Setupダイアログボックスで Protocolタブが開かれ、デフォルトのプロトコールファイルが

表示されます。 

 

2. Create Newをクリックします。 

 

Protocol Editorウィンドウが開き、デフォルトのリアルタイムプロトコールが表示されます。 

 

Protocol Editorで既存のプロトコールを開く 
 

CFX Maestro は、カスタムの新規プロトコールとして編集と保存が可能なサンプルプロトコールファ

イルをご提供します。また、既存のカスタムプロトコールから新規プロトコールを作成することも可能

です。 

 

サンプルプロトコールファイルを開く方法 

 

1. Homeウィンドウで File > Open > Protocolを選択します。 

 

デフォルトでは、Windows Explorerで CFX Maestroの Sampleファイルフォルダの場所が開かれ

ます。 

 

2. Sampleファイルフォルダを開くと、以下のフォルダが見つかります。 

 

 ConventionalProtocols ― 従来の PCR解析用のプロトコールファイルの例を含む。 

 

 DataFiles ― CFX Maestroの機能を探索するために使用できるデータファイルの例を含む。 
 

 MeltCalibration ― バイオ・ラッド社の Precision Melt Analysisソフトウェアで使用するプ

ロトコールファイルの例を含む。 

 

 Plates ― プレートファイルの例を含む。 

 

 RealTimeProtocols ― リアルタイム PCR解析用のプロトコールファイルの例を含む。 

 

3. ConventionalProtocolsまたは RealTimeProtocolsのいずれか実行したいランタイプのプロトコー

ルフォルダを開きます。 

 

4. 最適なプロトコールを選択して Openをクリックします。 

 

サンプルプロトコールが Protocol Editorウィンドウで開かれます。 

 

5. File > Save As を選択して、新しい名称で、または新しいフォルダ内にプロトコールを保存しま

す。 
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既存のプロトコールを開く方法 

 

1. Homeウィンドウで以下のいずれかを行います。 

 

 File > Open > Protocolを選択してナビゲートし、ターゲットプロトコールを選択して Open

をクリックする。 

 

 Startup Wizardを開き、以下のいずれかを行う。 

 

 表示されたプロトコールを編集するには、Edit Selectedをクリックする。 

 

 別の既存のプロトコールを編集するには、Select Existingをクリックしてターゲットフ

ァイルにナビゲートする。 

Protocol Editorウィンドウでプロトコールが開きます。 

 

2. File > Save As を選択して、新しい名称で、または新しいフォルダ内にプロトコールを保存しま

す。 

 

新しいプロトコールの設定 
 

アドバイス：お使いのプロトコールファイルが必要なパラメータを含んでいる場合（例えば、既存のプ

レートファイルを編集している場合）、本節をスキップすることができます。その場合には 74ページ

の「プロトコールへのステップの追加」に進んでください。 

 

新しいプロトコールファイルには以下のパラメータが必要です。 

 

 ブロックタイプ 

 

 選択したブロックタイプのスキャンモード 

 

 リッド温度 

 

 サンプル容量 

 

ブロックタイプの設定 

 

CFX Maestro では、ブロックタイプに基づき、グラジェントステップ用の温度増減を自動的に計算し

ます。 

 

注意：Protocol Editorで設定されるプレートタイプは、リアクションモジュールのプレートと同一とし

ます。 

 

ブロックタイプの設定方法 

 

 Protocol Editorウィンドウで Tools > Gradient Calculatorを選択し、表示されるドロップダウンリ

ストから該当するプレートタイプを選びます。 

 

選択したブロックタイプのスキャンモードを選択 

 

プロトコールのラン時間を求めるため、ターゲットのブロックタイプとスキャンモードを選択します。 
 

ブロックタイプとスキャンモードの選択方法 

 

 Protocol Editorウィンドウで Tools > Run time Calculatorを選択し、表示されるドロップダウンリ

ストから該当するプレートタイプとスキャンモードを選びます。 
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リッド温度の調節 

 

CFX Maestro では、デフォルトのリッド温度を以下のように設定します。 

 

 96ウェル機器 ― 105.0 ℃ 

 

 384ウェル機器 ― 95.0 ℃ 

 

 48ウェル機器 ― 100.0 ℃ 

 

必要に応じてプロトコールのリッドヒーターに関するデフォルト設定を変更し、またはリッドヒーター

を切ることができます。 

 

アドバイス：デフォルトのリッド温度は、User Preferences ダイアログボックスで変更できます。50

ページの「デフォルトのプロトコールパラメータの設定」を参照してください。 

 

リッド温度の調節方法 

 

1. Plate Editorウィンドウで Settings > Lid Settingsを選択します。 

 

Lid Settingsダイアログボックスが表示されます。 

 

2. 以下のいずれかを行います。 

 

 User Definedを選択してテキストボックスに温度値を入力する。 

 

 Turn Off Lid Heaterを選択する。 

 

3. OKをクリックして変更を受け入れ、ダイアログボックスを閉じます。 

 

サンプル容量の設定 

 

デフォルトでは、CFX Maestroは各ウェルのサンプル容量を 25 µLに設定します。サンプル容量は、

例えば以下のようにブロックのタイプによって異なります。 

 

 96ディープウェルブロックの場合は 0～125 µL 

 

 96ウェルブロックの場合は 0～50 µL 

 

 384ウェルブロックの場合は 0～30 µL 

 

機器では、以下の 2つの温度制御モードを使用して、いつサンプルがプロトコール内のターゲット温度

に到達するかを判定します。 

 

 Calculated（計算）モード ― サンプル容量がブロックに適した容量に設定される場合、サーマ

ルサイクラーはサンプル容量に基づいてサンプル温度を計算します。このモードが標準モードと

なります。 

 

 Block（ブロック）モード ― サンプル容量がゼロ（０）µL に設定される場合、サーマルサイク

ラーはサンプル温度を測定ブロック温度と同等であると記録します。 

 

特定ブロックのサンプル容量の設定方法 

 

 Plate Editorウィンドウのツールバーにある Sample Volumeテキストボックスに正しい値を入力

します。 

 

アドバイス：User Preferences ダイアログボックスでデフォルトのサンプル容量を変更できます。51

ページの「デフォルトのプレートパラメータの設定方法」を参照してください。 
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プロトコールへのステップの追加 
 

プロトコールにステップを追加する方法 

 

1. Protocol Editorウィンドウでプロトコールを開きます。 

 

2. 新しいステップを挿入する位置を決めます。ツールバーの Step ドロップダウンリストで Before

または Afterを選択します。 

 

3. グラフ上で、新しいステップが前か後に挿入されるステップを選択します。 

 

4. 左側のペインで Insert Stepをクリックします。 

 

5. 温度または保持時間を変更するには、グラフまたはプロトコールのアウトラインのデフォルト値

をクリックして新しい値を入力してください。 

 

6. （オプション）左側のペインの Step Optionsをクリックして Step Optionsダイアログボックスを

表示し、選択しているステップで使用できるオプションを変更します。 

 

アドバイス：グラフペインまたはプロトコールのアウトラインのペインの右クリックメニューで

も、Step Optionsダイアログボックスにアクセスすることができます。 

 

7. OKをクリックした後で Yesをクリックし、プロトコールへの変更を保存します。 

Save Asダイアログボックスが表示されます。 

 

8. Save Asダイアログボックスで、新しいプロトコールファイルの名称を入力し、Saveをクリック

します。 

 

グラジェントステップを挿入 
 

グラジェントステップの挿入方法 

 

1. グラジェント用のプレートサイズが、機器のブロックタイプと同じであることを確認してくださ

い（96ウェルまたは 384ウェル）。 

 

2. プレートサイズをまだ選択していない場合には、グラジェント用のプレートサイズを選択してく

ださい。 

 

Tools > Gradient Calculatorを選択して、ドロップダウンリストから該当するウェルタイプを選択

します。 

 

3. ツールバーの Insert Stepドロップダウンリストから Beforeまたは Afterを選択します。 

 

4. グラフまたはアウトラインのペインで、グラジェントステップが挿入される前か後のステップを

選択します。 

 

5. 左側のペインで Insert Gradientをクリックします。新しいグラジェントステップが、例えば以下

のようにグラフまたはアウトラインのペインで強調表示されます。 

 



Protocol Editorでプロトコールを作成 

ユーザーガイド | 75 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

グラジェントの各列の温度が、右側のペインの Gradient表に表示されます。 

 

6. グラジェント温度の範囲を編集するには、以下のいずれかを行います。 

 

 グラフまたはアウトラインペインのデフォルトの温度をクリックし、新しい温度を入力する。 
 

 Step Optionsをクリックし、Step Optionsウィンドウにグラジェント範囲を入力する。 

 

 Gradient表の Range値を変更する。 

 

7. 保持時間を編集するには、グラフィック表示またはテキスト表示内のデフォルト時間をクリック

して新しい時間を入力します。 

 

8. OKをクリックした後に Yesをクリックし、変更を保存します。 

 

GOTOステップを挿入 
 

注意：GOTO セット内に GOTO ステップを挿入することはできません。入れ子型の GOTO ループを

作成することはできません。 

 

GOTOステップの挿入方法 

 

1. ツールバーの Insert Stepドロップダウンリストから Beforeまたは Afterを選択します。 

 

2. グラフで、GOTOステップが挿入される前または後のステップを選択します。 

 

3. 左側のペインで Insert GOTO をクリックします。 

 

4. GOTOステップ番号または GOTOの反復回数を編集するには、グラフまたはアウトラインペイン

のデフォルトの数値を選択して新しい値を入力してください。 

 

5. OKをクリックした後に Yesをクリックし、変更を保存します。 
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融解曲線(Melt Curve)ステップを挿入 
 

アドバイス：GOTOループ内には融解曲線ステップを挿入することができません。 

 

注意：融解曲線(Melt Curve)ステップには、ステップの最初に、プロトコールには表示されない 30 秒

間の待機時間が含まれます。 

 

融解曲線ステップの挿入方法 

 

1. ツールバーの Insert Stepドロップダウンリストから、Beforeまたは Afterを選択します。 

 

2. グラフで、融解曲線ステップが挿入される前または後のステップを選択します。 

 

3. 左側のペインで Insert Melt Curve をクリックします。新しい融解曲線ステップが、例えば以下の

ように、グラフまたはアウトラインペイン内で強調表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

4. 融解温度範囲または増加時間を編集するには、グラフまたはアウトラインペイン内のデフォルト

の数値を選択し、新しい値を入力してください。 

 

5. OKをクリックした後で Yesをクリックし、変更を保存します。 
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プレートリードステップの追加または削除 
 

アドバイス：ステップにプレートリードコマンドを追加した後、このステップを選択するとボタンは

Remove Plate Readに変わります。 

 

ステップにプレートリードを追加する方法 

1. ツールバーの Insert Stepドロップダウンリストから、Beforeまたは Afterを選択します。 

 

2. グラフで、プレートリードステップが挿入される前または後のステップを選択します。 

 

3. 左側のペインで、Add Plate Read to Step をクリックしてプレートリードを選択しているステッ

プに追加します。 

 

4. OKをクリックした後で Yesをクリックし、変更を保存します。 

 

プレートリードをステップから削除する方法 

 

 グラフでプレートリードを含むステップを選択し、左側のペインにある Remove Plate Readをク

リックします。 

 

ステップオプションの変更 
 

選択しているステップのステップオプションの変更方法 

 

1. グラフまたはアウトラインペインのターゲットステップを選択します。 

 

2. 左側のペインの Step Optionsをクリックし、Step Optionsダイアログボックスを開きます。 

代替的に、いずれかのペインのターゲットステップを右クリックして、表示されるメニューのStep 

Optionsを選択することもできます。 

 

3. オプションの追加、修正、または削除の方法： 

 

 該当するテキストボックスに値を入力する。 

 

 特定のテキストボックス内の値を編集する。 

 

 チェックボックスを選択または解除する。 

 

4. OKをクリックして変更を保存し、Step Optionsダイアログボックスを閉じます。 

 

5. OKをクリックした後で Yesをクリックし、プロトコールを保存します。 

 

ステップの削除 
 

重要：この機能を元に戻すことはできません。ステップを削除する際には注意してください。 

 

プロトコール内のステップの削除方法 

 

1. グラフまたはアウトラインペイン内のステップを選択します。 

 

2. 左側のペインの Delete Stepをクリックして、選択しているステップを削除します。 

 

3. OKをクリックした後で Yesをクリックし、プロトコールを保存します。 
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プロトコールのコピー、エクスポート、または印刷 
 

プロトコールのコピー方法 

 

 プロトコールのアウトラインを右クリックして Copy Protocolを選択します。 

 

アウトラインは、.txt、.xls、.docまたは.pptなどのファイルにペーストできます。 

 

プロトコールのエクスポート方法 

 

1. プロトコールのアウトラインを右クリックし、Export Protocolを選択します。 

 

Save Asダイアログボックスが表示されます。 

 

2. （オプション）Windows Explorerで、プロトコールファイルを保存するフォルダにナビゲートし

ます。 

 

3. File nameにエクスポートされるプロトコールファイルの名称を入力します。 

 

4. Save をクリックします。 

 

プロトコールの印刷方法 

 

 プロトコールのアウトラインを右クリックし、Printを選択します。 

 

プロトコールのアウトラインは、デフォルトのプリンターに印刷できます。 
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Protocol AutoWriterを使用したプロトコールの作成 
 

重要：バイオ・ラッド社は、Protocol AutoWriterで作成したプロトコールの実行によって常に PCR生

成物が得られることを保証しません。 

 

CFX Maestroの Protocol AutoWriterは、以下の入力パラメータに基づいて PCRサイクルプロトコール

を自動的に生成します。 

 

 Amplicon Length（アンプリコン長さ） ― PCR生成物の予測される長さ 

 

 Annealing Temperature（アニーリング温度） ― 使用するプライマーの反応 Ta 

 

Taが未知の場合、Ta計算機を使用すれば、プライマー配列に基づいて自動的に計算できます。 

 

注意：Taは、選択している酵素およびプロトコール速度に基づくプライマーの融解温度（Tm）情

報により調節されます。 

 

 Enzyme type（酵素タイプ） ― DNAポリメラーゼ酵素（iTaq、iProof DNAポリメラーゼまたは

その他） 

 

iTaq や iProof DNA ポリメラーゼ以外の酵素を使用する場合には、グラジェント範囲、Hot Start

活性化時間（秒単位）、および最終的な延長時間（秒単位）を含む追加情報を入力できます。 

 

 Run speed（ラン速度） ― 反応速度（標準、高速、または超高速） 

 

Protocol AutoWriter では、選択される速度設定に応じてプロトコールを最適化します。合計のラ

ン時間は、ステップやサイクルの数、各ステップのインキュベーション時間、およびターゲット

温度に均一になるまでの時間により決まります。 

 

入力したパラメータと標準 PCRガイドラインを使用することで、Protocol AutoWriterは、Hot Start、

初期変性、アニーリング、および延長の各ステップを含むカスタマイズされた PCRプロトコールを自

動的に生成します。これにより、推奨されるプロトコールのグラフィック表現を表示でき、さらにプロ

トコールの編集、実行、または保存が可能です。 
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CFX Maestroの Protocol AutoWriterを使用した新しいプロトコールの作成方法 

 

1. Homeウィンドウの Tools > Protocol AutoWriterを選択します。 

 

Protocol AutoWriterダイアログボックスが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Enter Target Values/Enzyme セクションで以下を行います。 

 

 わかっている場合には、プライマーのアニーリング温度（Ta）を入力する。 

 

アドバイス：プライマーのアニーリング温度がわからない場合には、Ta Calculatorをクリッ

クしてください。Ta Calculatorで、フォワードプライマーおよびリバースプライマーの各配

列を入力してアニーリング温度が計算されます。詳細については、82ページの「Ta Calculator

の使用」を参照してください。 

 

注意：Ta Calculatorで使用する計算の詳細については、Breslauer et al. 1986 を参照してく

ださい。 

 

 塩基ペア（bp）にアンプリコン長さを入力する。 

 

 オプションのリストから酵素タイプを選択する（iTaq
TM

 DNAポリメラーゼ、iProof
TM

 DNA

ポリメラーゼ、またはその他）。 

 

アドバイス：酵素タイプで Others（その他）を選択すると、Additional Parameters（オプシ

ョン）セクションのパラメータがアクティブ状態になります。 
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3. 酵素タイプで Other を選択した場合、以下のパラメータのいずれかまたはすべてをプロトコール

に追加します。 

 

 グラジェント範囲 

 

 Hot Start活性化温度 

 

 最終伸長時間 

 

4. Type セクションでスライドバーを移動してプロトコール速度を選択します（Standard、Fast ま

たは Ultrafast［標準、高速、または超高速］）。CFX Maestroが合計ラン時間を調節します。 

 

5. 実施する PCRのタイプを選択します（デフォルトはリアルタイム PCRになっています）。 

リアルタイム PCR を使用すると、CFX Maestro はプレートリードステップを追加して蛍光デー

タを収集します。 

 

6. Preview セクションでプロトコールのレビューを行います。必要に応じて変更することができま

す。 

 

7. 以下のいずれかを行ってください。 

 

 OKをクリックして新しいプロトコールを保存する。保存後、Startup Wizardにプロトコー

ルが開きます。Edit Selectedをクリックしてプロトコールの変更を行ってください。例えば、

リッド温度やサンプル容量を変更が必要な場合があります。 

 

 Cancelをクリックして、プロトコールを保存せずにウィンドウを閉じる。 

 



第５章 | プロトコールの作成 

82 | CFX Maestro™ ソフトウェア 

Ta Calculatorの使用 
 

プライマーのアニーリング温度が不明である場合は、Ta Calculator を使用して値を計算することがで

きます。この値を Protocol AutoWriterまたは Protocol Editor で使用して、独自のプロトコールを作成

することが可能です。 

 

Ta Calculatorについて 
 

Ta Calculatorは、プライマーごとの Tm値のほかに、標準速度におけるプロトコールの Ta値も計算しま

す。 

 

プロトコールの Taは、以下のルールを適用した平均プライマーTm値に基づいています。 

 

 プライマーTm値間の差が４℃を超える場合、Ta =（２つのプライマーTm値の低い方+２）- ４℃ 

 

 Tm値間の差が４℃以下の場合、Ta =（プライマーTm値の平均値）- ４℃ 

 

塩基ペアのカウント方法 

 

各プライマーについて、Ta Calculatorは 14個以下の塩基ペア（bp）配列に以下の塩基ペアカウント方

法を使用します。 

 
Tm = ((w*A + x*T)*2) + ((y*G + z*C)*4) 

 

ここで、ｗ、ｘ、ｙ、ｚはそれぞれ、配列内の塩基Ａ、Ｔ、Ｇ、Ｃの数です。 

 

最近傍法 

 

14 bpより長い配列の場合、最近傍法を使用します。最近傍法では、融解温度の計算は、エントロピー

（オリゴヌクレオチドのランダム性のオーダーまたは尺度）、エンタルピー（オリゴヌクレオチドによ

り放出または吸収される熱量）、自由エネルギー、および温度の間の熱力学的関係に基づいています。 
 

ΔH = ΔG + T*ΔS 
 

ここで、 

 

 ΔH = エンタルピー値（Cal/Mole*K） 

 

 T = 温度（ケルビン） 

 

 ΔS = エントロピー値（Cal/Mole*K） 

 

 ΔG = ギブス自由エネルギー（Cal/Mole*K） 

 

エントロピーとエンタルピーの変化は、83 ページの表５に示すヌクレオチドペアの値を足し合わせる

ことにより直接計算されます（Breslauer et al. 1986年）。 
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平衡状態の自由エネルギーと反応物および生成物の濃度の間の関係は、次式で与えられます。 

 

ΔG = R*T*ln ((DNA * プライマー)/(DNA +プライマー)) 

 

ここで、Ｒは気体定数（1.986 Cal/Mole*K）です。 

 

Ｇを２つの式に代入すると、Ｔは次式で与えられます。 

 

T = ΔH/(ΔS + R*Ln((DNA * プライマー)/(DNA + プライマー))) 

 

ここでは、DNAの濃度と DNA-プライマー複合体の濃度は等しいと仮定しています。 

 

単鎖からＢ型構造 DNAへの移行時、５kcalの自由エネルギー（3.4 kcal）の変化があることが実験的に

わかっています（Sugimoto et al. 1996年）。これは、へリックス開始エネルギーであると推定されま

す。最後に、塩の調整を追加すると Ta Calculatorが使用する式は次のようになります。 

 

T = (ΔH – 5(Kcal/K*Mole))/(ΔS + (R*ln(1/(プライマー)))) + 16.6 log10(塩のモル濃度) 

 

多様なパラメータが１MNaCl で得られ、また１の log10はゼロであることから、塩の濃度に調整用定数

は必要ありません。 

 

熱力学的計算では、アニーリングは pH 7.0で生じると仮定しています。Tm計算では、配列は対称的で

はなくＧまたはＣの少なくとも一方を含むと仮定しています。 

 

オリゴヌクレオチドの配列は、妥当な Tm値を得るためには少なくとも 14 個の塩基からなるものとし

ます。塩基が 14個未満の場合には、塩基ペアカウント方法を使用します（下記の表５を参照）。 

 

表５ Breslauerの相互作用定数 

相互作用 H S G 

AA TT 9.1 24 1.5 

AT TA 8.6 23.9 1.5 

AC TG 6.5 17.3 1.3 

AG TC 7.8 20.8 1.6 

TA AT 6 16.9 0.9 

TT AA 9.1 24 1.9 

TC AG 5.6 13.5 1.6 

TG AC 5.8 12.9 1.9 

CA GT 5.8 12.9 1.9 

CT GA 7.8 20.8 1.6 

CC GG 11 26.6 3.1 

CG GC 11.9 27.8 3.6 

GA CT 5.6 13.5 1.6 

GT CA 6.5 17.3 1.3 

GC CG 11.1 26.7 3.1 

GG CC 11 26.6 3.1 
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Ta Calculatorの使用方法 

 

1. Ta Calculatorを開くには、以下のいずれかを行います。 

 

 現在 Protocol AutoWriterを使用している場合、Ta Calculatorをクリックする。 

 

 Homeウィンドウの Tools > Ta Calculatorを選択する。 

 

Ta Calculatorダイアログボックスが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Forward Primerテキストボックスに、フォワードプライマーの配列を入力するかペーストします。 
 

アドバイス：ダイアログボックスの左側にあるＡ、Ｔ、Ｇ、Ｃの各ボタンを使用して配列を入力

することもできます。 

 

3. Reverse Primerテキストボックスにリバースプライマーの配列を入力するかペーストします。 

 

4. Calculateをクリックします。 
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Ta Calculator は各プライマーの Tmと、平均 Tm と Ta値を計算し、これを下記のように表示しま

す。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

プライマーTm値が４℃以上異なる場合、Protocol AutoWriter では低い方のプライマーTm値+２℃

を Ta値の計算の基礎として使用します。この値はさらに、酵素と反応速度を変更することにより

修正できます。 

 

Ta Calculatorは、iTaq DNAポリメラーゼの標準速度のアニーリング温度を生成します。異なる酵

素を使用する場合には、速度設定は自動的に Taに調節されます。 

 

5. 以下のいずれかを行います。 

 

 Protocol AutoWriter から Ta Calculator を開いた場合、OK をクリックすれば Protocol 

AutoWriterに戻ります。アニーリング温度は自動的に修正されます。 

 

 Toolsメニューから Ta Calculatorを開いた場合、計算結果を記録して Cancelをクリックす

ると計算機が閉じます。 
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第６章 プレートの作成 
 

Plate ファイルには、スキャンモード、蛍光色素、およびウェル内容物などのランパラメータに関する

情報が含まれます。ラン実行後、CFX Maestro ソフトウェアはウェル内容物をラン実行中に収集した

蛍光色素データとリンクさせ、Data Analysisウィンドウで適切な解析を行います。例えば、標準サン

プルタイプがロードされたウェルが、検量線の生成に使用されます。 

 

CFX Maestro ソフトウェアでは、リアルタイム PCRラン用の Plate Editorと正規化遺伝子発現解析用

の Setup Wizardの２つのオプションをプレート作成用に用意しています。 

 

Plate Editorは以下の機能を含みます。 

 

 プレートのウェルに割り当てる標準蛍光色素とサンプルタイプ 

 

 遺伝子発現解析用にリファレンスターゲットとコントロールサンプルを設定する機能 

 

 ランの前、ランの最中、またはランの後にプレート設定を編集する機能 

 

 再使用のためにプレートファイルを保存する機能 

 

 プレートファイルをデフォルトのプリンターに印刷する機能 

 

Setup Wizard のガイドにより、正規化遺伝子発現解析用のプレートレイアウトを作成することができ

ます。ランの前、ランの実行中、またはランの後で Setup Wizardを使用できます。 
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Plate Editorウィンドウ 
 

Plate Editorを使用して、カスタムプレートの作成や既存のプレートの修正を行えます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

説明 

 

1 メニューバーは、Fileや Settingsといったメニューコマンドの他にプレートの Editing Toolsオプシ

ョンへの迅速なアクセスと提供します。 

2 ツールバーは、重要なプレートローディング機能への迅速なアクセスを提供します。 

3 メインペインは、照会に応じてプレートアウトラインやプレートオプションを表示します。 

4 右側のペインは、プレートのカスタマイズに使用するオプションを表示します。 

5 下部のペインは、プレートタイプを表示し、表示オプションへの迅速なアクセスを提供します。 

 

Fileメニューコマンド 
 

Save（保存） ― User Preferences ダイアログボックス内の Fileタブで指定した場所にプレートデー

タファイルを保存します。詳細については、49 ページの「デフォルトのファイル設定を変更」を参照

してください。 

 

Save As（別名で保存） ― 開いているプレートデータファイルを新しい名称で保存します。 

 

Print（印刷） ― 開いているプレートデータファイルを印刷します。 

 

Close（閉じる） ― Plate Editorを閉じます。 

 

Editメニューコマンド 
 

Undo（元に戻す） ― プレートファイルが保存されるまで、プレートファイルへの変更を戻します。 

 

Redo（やり直し） ― プレートファイルが保存されていない限り、最新の Undo動作を取り消します。 
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Settingsメニューコマンド 
 

Plate Size（プレートサイズ） ― ラン用のプレートサイズを選択するダイアログボックスを開きます。 
 

注意：プレートサイズは、ランを実行する機器のブロックサイズと同一であるものとします。

CFX384 Touch システムの場合には 384ウェルを、CFX96 Touch、CFX96 Touch Deep Well また

は CFX Connectシステムの場合には 96ウェルを選択してください。 

 

Plate Type（プレートタイプ） ― サンプルを入れるプレート内のウェルのタイプとして、BR White

か BR Clearを選択するためのダイアログボックスを開きます。厳密なデータ解析を行うため、選択す

るプレートタイプはランで使用するプレートタイプと同一とします。 

 

注意：新しいプレートタイプはキャリブレーションが必要となります。詳細については、61 ペー

ジの「新しい色素のキャリブレーション」を参照してください。 

 

Number Convention（数値表記） ― 単位を表示する方法を選択できるダイアログボックスを開きま

す。デフォルトでは、指数表記で単位を表示します。 

 

Units（単位） ― 検量線から不明サンプルの定量を行う際にスプレッドシートに表記する単位を選択

するためのダイアログボックスを開きます。 

 

Editing Toolsメニューコマンド 
 

Setup Wizard（設定ウィザード） ― 現在のプレートのレイアウトと解析パラメータを定義する Setup 

Wizardを開きます。ランの前、ランの実行中、またはラン完了後に Setup Wizardを使用できます。 

 

Spreadsheet View/Importer（スプレッドシートの表示／インポート） ― スプレッドシートのフォー

マットのテンプレートとしてプレートレイアウトを表示する Viewダイアログボックスを開きます。こ

のダイアログボックスを使用して、.csvフォーマットでプレートテンプレートデータのエクスポートま

たはインポートを行えます。 

 

Flip Plate（プレートをフリップ） ― プレート情報を 180度回転させます。 

 

Plate Editorツールバーコマンド 
 

     ― プレートへの変更を元に戻します。CFX Maestro ソフトウェアでは最大 10 個の Undo

操作に対応します。 

 

     ― 最新の Undo 操作を取り消します。CFX Maestro ソフトウェアでは最大 10 個の Redo

操作に対応します。 

 

    ― 現在のプレートファイルを保存します。 

 

       ― プレート表示を拡大・縮小できるドロップダウンリストを表示します。 

 
 

            ― スキャンモードを選択できるドロップダウンリストを表示します。これ

は、どのチャンネルでラン実行中に蛍光色素データを収集するかを機器が識別するものです。 
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― 現在のプレート用のウェルグループ作成に使用できるWell Groups Manager 

を開きます。 

 
 

― 増幅トレースの色とシンボルを選択できるダイアログボックスを表示します。 
 
 

― プレートレイアウトをテンプレートとしてスプレッドシートフォーマットで 

表示する Viewダイアログボックスを開きます。このダイアログボックスを使用し 

て、.csvフォーマットでプレートテンプレートデータをエクスポートまたはイン 

ポートすることができます。 

 
 

― 現在のプレートのレイアウトおよび解析パラメータを定義できる Setup  

Wizardを開きます。ランの前、ランの最中、またはランの後に Setup Wizardを 

使用できます。 

 
 

― プレートレイアウトパラメータを定義し、またターゲット名、サンプル名、お 

よび生物学的グループ名を作成または削除することが可能な User Preferencesダ 

イアログボックスのPlateタブを開きます。Plateタブへの変更は、次回Plate Editor 

を開くときにも有効です。 

 
 

― プレートの設定とウェルのロードに必要なステップを表示します。 
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Plate Editorを使用したプレートファイルの作成 
 

Plate Editorを使用すると、カスタムプレートファイルを作成することができます。また、以前保存し

たプレートファイルまたは CFX Maestroソフトウェアに同梱されるサンプルプレートファイルの編集

や保存も可能です。 

 

新しいプレートファイルを作成するには、以下を行ってください。 

 

 Plate Editorのプレートファイルを開く。 

 

 プレートタイプを選択する。 

 

注意：プレートファイルのプレートタイプは、リアクションモジュールのプレートと同じものと

します。 

 

 プロトコールで使用するスキャンモードを選択する。 

 

 プレートで使用する蛍光色素を選択する。 

 

 サンプルタイプ、ターゲット、およびサンプルを選択する。 

 

 必要に応じて技術リプリケートを選択する。 

 

 プレートレイアウトを保存する。 

 

アドバイス：以前保存したプレートファイルまたはサンプルプレートファイルから新しいプレートを作

成する場合は、92ページの「Plate Editorで既存のプレートファイルを開く」を参照してください。 

 

Plate Editorで新しいプレートファイルを開く 
 

CFX Maestro ソフトウェアでは、新しいプレートファイルを開くためのオプションを複数ご提供しま

す。 

 

 Homeウィンドウから開く 

 

 Startup Wizardダイアログボックスから開く 

 

 Run Setupダイアログボックスから開く 

 

Homeウィンドウから新しいプレートファイルを開く方法 

 

 File > New > Plateを選択します。 

 

Plate Editorウィンドウが開き、選択している機器のデフォルトのプレートファイルが表示されま

す。 

 

アドバイス：デフォルトのプレートファイルの設定に関する詳細については、49ページの「デフ

ォルトのファイル設定を変更」を参照してください。 

 

Startup Wizardから新しいプレートファイルを開く方法 

 

1. 見当たらない場合には、Homeウィンドウで以下のいずれかを行ってStartup Wizardを開きます。 

 

 View > Startup Wizard を選択する。 

 

 ツールバーの Startup Wizardをクリックする。 

 

デフォルトでは、Startup Wizardには、選択されている CFX96の Run設定タブが表示されます。 
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2. 必要に応じて、ドロップダウンリストから機器のタイプを選択してください。 

 

3. 新しいプレートを作成するには、ランタイプとして User-definedをクリックしてください。 
 

Run Setupダイアログボックスが開き、Protocolタブが表示されます。 

 

4. Plateタブをクリックして Create Newをクリックします。 
 

Plate Editorウィンドウが開き、選択している機器のデフォルトのプレートレイアウトが表示され

ます。 

 

Run Setupダイアログボックスから新しいプレートファイルを開く方法 

 

1. Homeウィンドウで以下のいずれかを行い、Run Setupダイアログボックスを開きます。 
 

 Run > User-defined Runを選択する。 
 

 ツールバーの User-defined Run Setupをクリックする。 
 

Run Setupダイアログボックスに Protocolタブが開きます。 

 

2. 新しいプレートを作成するには、Plateタブをクリックし、Create Newをクリックします。 
 

Plate Editorウィンドウが開き、選択している機器のデフォルトのプレートレイアウトが表示され

ます。 

 

Plate Editorで既存のプレートファイルを開く 
 

CFX Maestro ソフトウェアは、新しいプレートとして編集や保存が可能なサンプルプレートファイル

を用意しています。また、以前保存したプレートファイルから新しいプレートファイルを作成すること

も可能です。 

 

サンプルプレートファイルを開く方法 

 

1. Homeウィンドウの File > Open > Plateを選択します。 
 

Windows Explorerで CFX Maestroの Sampleファイルフォルダの場所が開かれます。 

 

2. Sampleファイルフォルダを開いて、Platesフォルダを開きます。 

 

3. 最適なプレートを選択して Openをクリックします。 
 

Plate Editorウィンドウにサンプルプレートファイルが開きます。 

 

4. File > Save As を選択して、プレートファイルを新しい名称で、または新しいフォルダに保存し

ます。 

 

以前保存したプレートファイルを開く方法 

 

1. Homeウィンドウで以下のいずれかを行います。 
 

 File > Open > Plateを選択してナビゲートし、ターゲットプレートを選択して Openをクリ

ックする。 
 

 Startup Wizardを開き、以下のいずれかを行う。 
 

 既存のプレートファイルを編集するには、Select Existingをクリックしてターゲットフ

ァイルにナビゲートする。 
 

 表示されているプレートファイルを編集するには、Edit Selectedをクリックする。 
 

Plate Editorウィンドウにターゲットプレートが開きます。 
 

2. File > Save As を選択して、プレートファイルを新しい名称で、または新しいフォルダに保存し

ます。 
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新しいプレートファイルの設定 
 

アドバイス：ご使用のプレートファイルに必要なパラメータが含まれている場合（例えば、サンプルま

たは既存のプレートファイルを編集する場合）、本節をスキップすることができます。99ページの「プ

レートファイルへのオプションのパラメータの割り当て」に進んでください。 

 

新しいプレートファイルには、以下のパラメータが必要です。 

 

 プレートサイズ 

 

 プレートタイプ 

 

 スキャンモード 

 

 １蛍光色素（色素） 

 

 １サンプルタイプ 

 

プレートサイズとタイプの選択 

 

重要：プレート設定時にプレートサイズを選択する必要があります。ランの実行中やランの後でプレー

トサイズを変更することはできません。 

 

ソフトウェアはプレートサイズとタイプを、ラン実行中すべてのウェルに適用します。選択するプレー

トサイズはランで使用するプレートと必ず同一としてください。 

 

CFX96 Touch、CFX96 Touch Deep Well、CFX Connectおよび CFX384 Touchの各機器は、工場出荷

時に多くの蛍光色素とプレートの組み合わせに対してにキャリブレーションされています。こうしたキ

ャリブレーション処理については、機器、色素、およびプレートタイプを特定して行われます。使用す

る予定の蛍光色素が、選択するプレートタイプ用に必ずキャリブレーションされていることを確認して

ください。 

 

アドバイス：機器で色素とプレートタイプの新しい組み合わせをキャリブレーションする場合は、Tools 

> Calibration Wizardを選択してください。色素とプレートタイプのキャリブレーションに関する詳細

については、61ページの「新しい色素のキャリブレーション」を参照してください。 

 

スキャンモードの選択 

 

CFX96 Touchおよび CFX96 Touch Deep Wellの各システムでは、６チャンネルでの蛍光色素の励起・

検出となります。CFX Connect システムでは、３チャンネルでの蛍光色素の励起・検出となります。

CFX384 Touchシステムでは、５チャンネルでの蛍光色素の励起・検出となります。すべてのシステム

で、ラン実行中に蛍光色素データを収集するために複数のデータ取得スキャンモードが使用されます。 
 

CFX Maestro ソフトウェアでは以下の３つのスキャンモードを用意しています。 

 

 All Channels（全チャンネル） 

 

 CFX96 Touchおよび CFX96 Touch Deep Wellの各システムでチャンネル１～５をスキャン 

 

 CFX Connectシステムでチャンネル１と２をスキャン 

 

 CFX394 Touchシステムでチャンネル１～４をスキャン 
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 SYBR
®
 /FAM 

 

 チャンネル１のみをスキャン 

 

 高速スキャンを提供 

 
 FRET 

 FRETチャンネルのみをスキャン 

 

 高速スキャンを提供 

 

蛍光色素を選択 

 

重要：ランを実行する前に、CFX Maestro ソフトウェアはプレートに指定した蛍光色素がその機器で

キャリブレーションされているかを検証します。キャリブレーションされていない蛍光色素が含まれて

いる場合、プレートによるランを実行することはできません。 

 

ランを実行する前に、１つ以上の蛍光色素をプレートレイアウトにロードする必要があります。このと

き、必要な限り多くの蛍光色素を加えることができますが、プレートは１つ以上の蛍光色素を含む必要

があります。選択した蛍光色素は、Target Namesにターゲットのオプションとして表示されます。 

 

蛍光色素（またはプレート色素）を Plate Editorのウェルローディングコントロールにロードするには、

Select Fluorophores ダイアログボックスを使用します。Select Fluorophores ダイアログボックスに表

示される蛍光色素は、選択するスキャンモードによって異なります。 

 

 All Channels（全チャンネル） 

 

使用可能なすべての蛍光色素が表示されます。 

 

アドバイス：必要な限り多くの蛍光色素を追加できますが、各ウェルの１つのチャンネルにつき

１つの蛍光色素しかロードできません。 

 
 SYBR

®
/FAM 

 

チャンネル１の蛍光色素のみが表示されます。 

 
 FRET 

 

チャンネル６の蛍光色素のみが表示されます。 

 

アドバイス：FRET が選択されたスキャンモードの場合にのみ、チャンネル６の FRET 蛍光色素

が表示されます。All Channelsスキャンモードでは使用できません。 

 

注意：Select Fluorophoreダイアログボックスに直接蛍光色素を追加したり、ここから削除したりする

ことはできません。Calibration Wizardを使用して、機器で新しい蛍光色素をキャリブレーションする

必要があります。キャリブレーション後、新しい蛍光色素がこのリストの自動的に追加されます。詳細

については、61ページの「新しい色素のキャリブレーション」を参照してください。 
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サンプルタイプの選択 

 

重要：ラン実行前に、プレートウェルに割り当てるサンプルタイプを１つ以上選択する必要があります。 
 

CFX Maestro ソフトウェアでは、以下の５個のサンプルタイプをご提供します。 

 

 Unknown（不明） 

 

 Standard（標準） 

 

 NTC（テンプレート無しコントロール） 

 

 Positive Control（陽性コントロール） 

 

 Negative Control（陰性コントロール） 

 

 NRT（逆転写無しコントロール） 

 

サンプルタイプをプレートウェルに割り当ててください。 

 

新しいプレートの設定 

 

新しいプレートを設定するには、 

 

1. Plate Editorウィンドウで新しいプレートを開きます。 

 

2. プレートサイズを設定するには、Settings > Plate Sizeを選択し、ドロップダウンメニューから適

当なプレートサイズを選択します。 

 

3. プレートタイプを設定するには、Settings > Plate Typeを選択し、ドロップダウンメニューから

BR Whiteまたは BR Clearを選択します。 

 

4. 任意に、Settingsメニューから、数値表記と表示単位を変更できます。 

 

 数値表記を変更するには、Settings > Number Conventionを選択し、Scientific Notationを選

択する。 

 

アドバイス：デフォルトではScientific Notationが選択されます。この場合、Scientific Notation

を選択することによりデフォルトが解除され、数値表記が標準形式に設定されます。 

 

 表示単位を変更するには、Settings > Unitsを選択し、新しい単位の値を選択する。 

 

5. スキャンモードを設定するには、Plate Editorウィンドウのツールバーにある Scan Modeドロッ

プダウンリストから適切なスキャンモードを選択します。 
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6. プレートに必要な蛍光色素を選択します。 

 

a. 右側のペインの Select Flurophoresをクリックします。 

 

Select Fluorophores ダイアログボックスが表示されます。手順５で選択したスキャンモード

のタイプで使用できる蛍光色素がわかります（下図のとおり）。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

b. 蛍光色素を選択するには、Selectedチェックボックスをクリックします。 

 

アドバイス：リストから蛍光色素を削除するには、Selectedチェックボックスを解除します。 
 

c. 蛍光色素の表示色を変更するには、Colorボックスをクリックします。 

 

注意：選択する色は、Plate Editorウィンドウと Data Analysisグラフの両方の蛍光色素を表

します。 

 

d. Colorダイアログボックスで、希望の色を選択するか、Define Custom Colorsをクリックし

て蛍光色素を表す新しい色を作成します。 

 

e. OKをクリックして変更を保存し、Select Fluorophores ダイアログボックスを終了します。 
 

7. サンプルタイプをロードする１つ以上のウェルを選択する必要があります。デフォルトでは、ウ

ェル A1が選択されています。 

 

プレートペインで、以下のいずれかを行います。 

 

 複数の隣接するウェルをロードするには、１つのウェルをクリックしてターゲットウェルへ

とドラッグする。 

 

 複数の隣接しないウェルをロードするには、Ctrlキーを押したまま各ウェルをクリックする。 
 

 同じサンプルタイプの列全体をロードするには、列番号をクリックする。 
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 行全体をロードするには、その行番号をクリックする。 

 

 プレート全体をロードするには、プレートの左上隅をクリックする。 

 

例： 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. サンプルタイプを右側のペインにあるSample Typeドロップダウンメニューから選択しているウ

ェルへと割り当てます。 

 
 
 
 
 
 
 
 
 

9. １つ以上の蛍光色素を、サンプルタイプを含むすべてのウェルに割り当てます。ウェルまたはウ

ェル群には、２つ以上の蛍光色素を割り当てることができます。 

 

注意：１つのチャンネルには１つの蛍光色素しか割り当てることができません。同じチャンネル

から同じウェルに２つ以上の蛍光色素を割り当てることはできません。 

 

アドバイス：現時点では、ターゲットを蛍光色素に関連付けるか、または蛍光色素のみをウェル

に割り当てて、実験のラン実行後にターゲットを蛍光色素に関連付けることができます。 

 

 選択しているウェルに蛍光色素のみを割り当てるには、右側のペインの Target Namesセク

ションで特定の蛍光色素の Loadチェックボックスを選択します。 

 

 ターゲットを蛍光色素に関連付けるには、Target Namesセクションで特定の蛍光色素に関

してドロップダウンリストからターゲット名を選択します。ソフトウェアはその Load チェ

ックボックスを自動的に選択します。 
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10. Standardサンプルタイプを含むウェルについては、濃度をロードする必要があります。各ウェル

は異なる濃度値をもつことが可能です。デフォルトでは、CFX Maestroソフトウェアは Standard

サンプルタイプのすべてのウェルに 1.00E+06 の濃度をロードします。必要に応じて値を変更す

ることが可能です。 

 

a. プレートペインで、ターゲットの Standardウェルを選択します。 

 

b. （オプション）別の濃度をロードするには、Concentration テキストボックスに新しい値を

入力して Enterを押します。 

 

c. Loadをクリックして、選択しているウェルに値をロードします。 

 

d. Standardサンプルタイプのすべてのウェルについて、この手順を実施します。 

 

アドバイス：同じ濃度をすべての Standardウェルにロードするには、<All>がドロップダウ

ンリストの Concentration 値の下に表示されていることを確認してください。同じ濃度値を

特定の蛍光色素のすべてのウェルにロードするには、ドロップダウンリストをクリックして

蛍光色素を選択します。 

 

e. （オプション）Standard サンプルの濃度に関して希釈系列を入力して検量線をロードする

には、Dilution Seriesをクリックしてください。 

 
 
 
 
 
 
 
 
 
 
 
 

ダイアログボックスで以下を行った後に Applyをクリックして Plate Editorに戻ってくださ

い。 

 

 希釈系列用の新しい開始濃度を入力する。 

 

 Replicates from（開始リプリケート番号）と Replicates to（終了リプリケート番号）

の各値を設定する。 

 

 Dilution Factor値（これは各リプリケートグループ内の濃度変化）を設定する。 

 

 希釈系列の濃度を増やすか減らすかを選択する。 

 

 ドロップダウンリストから、希釈系列に使用する蛍光色素を選択する。 

 

11. OKをクリックして新しいプレートを保存する。 
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プレートファイルへのオプションのパラメータの割り当て 
 

プレートファイルは、ラン用サンプルがロードされた各ウェルの内容に関する情報を含みます。ラン実

行後、CFX Maestro ソフトウェアはプロトコール中に収集された蛍光データにウェルの内容をリンク

させ、Data Analysisウィンドウにおいて該当の解析を適用します。 

 

CFX Maestro ソフトウェアでは、実験のランの前、ラン実行中、またはランの後でも、プレート内の

各ウェルにパラメータを割り当てることができます。また、既存のプレートファイルまたは新しいプレ

ートファイルにパラメータを割り当てることが可能です。これらのパラメータとして以下が含まれます。 
 

 Target Names（ターゲット名） ― ロードされた各ウェルの対象ターゲット（遺伝子または配列）。 
 

 Sample Names（サンプル名） ― 0 Hrまたは dil-1など、ロードされた各ウェル内のサンプルに

対応する識別名称または条件。 

 

 Biological Group（生物学的グループ） ― マウス１、マウス２、またはマウス３など、ウェル

のグループに対応する識別名称または条件。 

 

アドバイス：ターゲット名、サンプル名、および生物学的グループは、Data Analysisウィンドウ

の Gene Expressionタブ内のデータを比較するため、ウェル間で一致させてください。各名称と

も、大文字使用や句読点およびスペースが同じであるものとします。例えば、”Actin”と”actin”、”2Hr”

と”2 hr”、さらに”Mouse 1”と”mouse 1”はそれぞれ同一ではありません。名称の一貫性を得るため

に、Homeウィンドウで使用できる User > User Preferences > Plateの Librariesセクションで名

称を入力してください。 

 

 Technical Replicates（技術的リプリケート） ― 同じサンプルを解析する回数。 

 

 Dilution series（希釈系列） ― 解析用の検量線データを作成するため、リプリケートグループ

内の Standardサンプルタイプの濃度を変化させる量。 

 

ウェルへのターゲットの割り当て 
 

アドバイス：単一または複数のウェルに同じターゲット名を割り当てることができます。また、複数の

ターゲットを同じウェルに割り当てることも可能です。 

 

重要：ターゲットを割り当てた後に OKをクリックすると変更が保存され、Plate Editorツールバーの

Undoが無効になります。OKをクリックする際には注意してください。 

 

ウェルまたはウェルグループへのターゲットの割り当て方法 

 

1. Plate Editorで、ウェルまたはウェルグループがサンプルタイプに割り当てられていることを確認

してください。 

ウェルへのサンプルタイプの割り当てに関する詳細については、95ページの「サンプルタイプの

選択」を参照してください。 

 

2. プレートペインで、ウェルまたはウェルグループを選択します。 

 

 単一のウェルを選択する場合には、そのウェルをクリックする。 

 

 複数の隣接するウェルを選択する場合には、１つのウェルをクリックしてターゲットのウェ

ルまでドラッグする。 

 

 複数の隣接しないウェルを選択する場合には、Ctrlキーを押したままそれぞれのウェルをクリ

ックする。 
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 同じサンプルタイプを含むカラム全体を選択するには、カラム番号をクリックする。 

 

 列全体を選択するには、その列番号をクリックする。 

 

3. 右側のペインで、Target Nameドロップダウンリストから、選択している各蛍光色素の名称を選

択します。 

 
 
 
 
 
 
 
 
 

4. ターゲットを割り当てなければならない各ウェルまたはウェルグループについて、手順３を繰り

返し行ってください。 

 

アドバイス：選択している各蛍光色素に割り当てるターゲット名は同じであっても異なっていて

も良いです。 

 

5. OKをクリックして変更を確定し、プレートを保存します。 

 

注意：誤ってプレートを変更した場合には、OKをクリックして変更を確定する前に、Plate Editor

ツールバーの Undoをクリックしてください。 

 

ターゲット名の削除方法 

 

 選択しているウェルまたはウェルグループからターゲット名を削除するには、Loadチェックボッ

クスを解除します。 

 

重要：ウェルからターゲット名を削除すると、関連する蛍光色素も削除されます。ウェルからターゲッ

ト名を削除する際には注意してください。 

 

リストにターゲット名を追加する方法 

 

 ターゲット名をドロップダウンリストに追加するには、以下のいずれかを行います。 

 

 Target Nameドロップダウンリストに名称を入力して、Enterキーを押す。 

 

アドバイス：１つのリストに追加するターゲット名は、その他すべてのターゲットリストに

表示されます。 

 

 ドロップダウンリストの右側にある緑色の+記号をクリックし、ターゲット名を入力して

Enterキーを押す。 

 ツールバーの User Preferencesをクリックし、Plateタブの Target Namesに名称を追加する。 
 

重要：ドロップダウンリストに追加するターゲット名は、現在のプレートについてのみ、さらに

名称をウェルに割り当ててプレートレイアウトを保存した場合にのみ使用できます。ウェルに名

称を割り当てずにプレートレイアウトを保存した場合には、名称は保存されないため後で使用で

きません。ターゲット名を永久に追加するには、User Preferencesダイアログボックスを使用し

て Target Namesライブラリにもターゲット名を追加します。ライブラリに追加する名称は、Plate 

Editorを再び開いた後に使用できます。詳細については、50ページの「デフォルトのプロトコー

ルパラメータの設定」を参照してください。 

 



プレートファイルへのオプションのパラメータの割り当て 

ユーザーガイド | 101 

リストからターゲット名を削除する方法 

 

1. ツールバーの User Preferencesをクリックします。 

 

User Preferencesダイアログボックスが現れ、Plateタブが表示されます。 

 

2. Plateタブの Target Namesライブラリで、削除する名称を選択して Deleteキーを押します。 

 

3. OKをクリックして変更を保存し、User Preferencesダイアログボックスを閉じます。 

 

重要：プレートファイルに保存したターゲット名を削除することはできません。Target Names

ドロップダウンリストに追加して使用せずにプレートに保存したカスタム名は、リストから自動

的に削除されます。Target Names Libraryから削除するカスタム名は、ソフトウェアから永久に

削除されるため、ユーザーは使用できなくなります。ターゲット名を削除する際には注意してく

ださい。 

 

ウェルへのサンプル名の割り当て 
 

注意：サンプル名を割り当てるには、選択しているウェルに少なくとも１つの蛍光色素を割り当てる必

要があります。選択しているウェルに蛍光色素が割り当てられていない場合には、Sample Namesドロ

ップダウンリストが無効になります。蛍光色素の割り当てに関する詳細については、99 ページの「ウ

ェルへのターゲットの割り当て」を参照してください。 

 

アドバイス：各ウェルまたはウェルグループに割り当てることができるサンプル名は１つだけです。 

 

ウェルまたはウェルグループへのサンプル名の割り当て方法 

 

1. Plate Editorで、ウェルまたはウェルグループが蛍光色素に割り当てられていることを確認してく

ださい。 

 

2. プレートペインで、ウェルまたはウェルグループを選択します。 

 

3. 右側のペインで、Sample Namesドロップダウンリスト内の名称を選択します。 

 

ソフトウェアは Loadチェックボックスを自動的に選択します。 

 
 
 
 
 
 
 
 

4. サンプル名を割り当てなければならない各ウェルまたはウェルグループに関して、手順３を繰り

返し行います。 

 

5. OKをクリックして変更を確定し、プレートを保存します。 

 

注意：誤ってプレートを変更した場合には、OKをクリックして変更を確定する前に、Plate Editor

ツールバーの Undoをクリックしてください。 

 

サンプル名の削除方法 

 

 選択されているウェルまたはウェルグループからサンプル名を削除するには、Loadチェックボッ

クスを解除します。 
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リストにサンプル名を追加する方法 

 

 ドロップダウンリストにサンプル名を追加するには、以下のいずれかを行います。 

 

 Sample Namesドロップダウンリストに名称を入力し、Enterキーを押す。 

 

 ドロップダウンリストの右側にある緑色の+記号をクリックし、サンプル名を入力する。 

 

 ツールバーの User Preferencesをクリックし、Plateタブの Sample Namesライブラリに名

称を追加する。 

 

重要：ドロップダウンリストに追加するサンプル名は、現在のプレートについてのみ、さらに名

称をウェルに割り当ててプレートレイアウトを保存した場合にのみ使用できます。ウェルに名称

を割り当てずにプレートレイアウトを保存した場合、名称は保存されないため後で使用できませ

ん。サンプル名を永久に追加するには、User Preferencesダイアログボックスを使用して Sample 

Namesライブラリにサンプル名を追加してください。ライブラリに追加した名称は、Plate Editor

を再び開いた後に使用できます。詳細については、51ページの「デフォルトのプレートパラメー

タの設定」を参照してください。 

 

リストからサンプル名を削除する方法 

 

1. ツールバーの User Preferencesをクリックします。 

 

User Preferencesダイアログボックスが現れ、Plateタブが表示されます。 

 

2. Plateタブの Sample Namesライブラリで、削除する名称を選択して Deleteキーを押します。 

 

3. OKをクリックして変更を保存し、User Preferencesダイアログボックスを閉じます。 

 

重要：プレートファイルに保存したサンプル名は削除できません。Sample Namesリストに追加し使用

せずにプレートに保存したカスタム名は、ドロップダウンリストから自動的に削除されます。Sample 

Names Libraryから削除するカスタム名は、ソフトウェアから削除されるため、ユーザーは使用できな

くなります。サンプル名を削除する際には注意してください。 

 

ウェルへの生物学的グループの割り当て 
 

重要：生物学的グループを割り当てるには、選択しているウェルに１つ以上の蛍光色素を割り当てる必

要があります。蛍光色素を割り当てることにより、Biological Groupsドロップダウンリストが有効にな

ります。蛍光色素の割り当てに関する詳細については、99 ページの「ウェルへのターゲットの割り当

て」を参照してください。 

 

アドバイス：各ウェルまたはウェルグループに割り当てることができる生物学的グループは１つです。 
 

ウェルまたはウェルグループへの生物学的グループの割り当て 

 

1. Plate Editorで、ウェルまたはウェルグループに蛍光色素が割り当てられていることを確認してく

ださい。 

 

2. プレートペインで、ウェルまたはウェルグループを選択します。 

 

3. 右側のペインで、Biological Groupドロップダウンリスト内の名称を選択します。 

 

CFX Maestro ソフトウェアは、Loadチェックボックスを自動的に選択します。 
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4. 生物学的グループを割り当てなければならないウェルまたはウェルグループについて、手順３を

繰り返し行います。 

 

5. OKをクリックして変更を確定し、プレートを保存します。 

 

注意：誤ってプレートを変更した場合には、OKをクリックして変更を確定する前に Plate Editor

ツールバーの Undoをクリックしてください。 

 

アドバイス：ウェルに生物学的グループ名を割り当てることにより、Experiment Settingsダイア

ログボックスの Biological Group Analysisオプションが有効になり、４つの設定のいずれかでサ

ンプルの解析を行うことができます。詳細については、109ページの「Experiment Settingsの変

更」を参照してください。 

 

生物学的グループの削除方法 

 

 選択しているウェルまたはウェルグループから生物学的グループを削除するには、Loadチェック

ボックスを解除します。 

 

生物学的グループ名をリストに追加する方法 

 

 ドロップダウンリストに生物学的グループ名を追加するには、以下のいずれかを行います。 

 

 Biological Groupドロップダウンボックスに名称を入力し、Enterキーを押す。 

 

 ドロップダウンリストの右側にある緑色の+記号をクリックし、生物学的グループの名称を入

力する。 

 

 ツールバーの User Preferencesをクリックし、Plateタブの Biological Names ライブラリに

名称を追加する。 

 

重要：ドロップダウンリストに追加する生物学的グループ名は、現在のプレートについてのみ、

さらに名称をウェルに割り当ててプレートレイアウトを保存した場合にのみ使用できます。ウェ

ルに名称を割り当てずにプレートレイアウトを保存した場合、名称は保存されないため後で使用

できません。生物学的グループ名を永久に追加するには、User Preferencesダイアログボックス

を使用して Biological Namesライブラリに生物学的グループ名を追加してください。ライブラリ

に追加した名称は、Plate Editor を再び開いた後に使用できます。詳細については、51 ページの

「デフォルトのプレートパラメータの設定」を参照してください。 

 

リストから生物学的グループ名を削除する方法 

 

1. ツールバーの User Preferencesをクリックします。 

 

User Preferencesダイアログボックスが現れ、Plateタブが表示されます。 

 

2. Plateタブの Biological Namesライブラリで、削除する名称を選択して Deleteキーを押します。 

 

3. OKをクリックして変更を保存し、User Preferencesダイアログボックスを閉じます。 

 

重要：プレートファイルで保存した生物学的グループ名を削除することができません。Biological 

Group Namesドロップダウンリストに追加し使用せずにプレートに保存したカスタム名は、リス

トから自動的に削除されます。Biological Names Libraryから削除する名称は、ソフトウェアから

永久に削除されるため、ユーザーは使用できなくなります。生物学的名称を削除する際には注意

してください。 
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プレートのすべての生物学的グループを表示 

 

 プレートのすべての生物学的グループを表示するには、Show Biological Groups をクリックしま

す。 

 
 
 
 
 
 
 

各グループが特定の色で識別され、Show Biological Groupsボタンが Hide Biological Groups に切り替

わります。 

 

ウェル内の色を解除するには、Hide Biological Groups をクリックします。代替的に、プレート内の任

意のウェルをクリックして、生物学的グループを非表示にすることも可能です。 

 

ウェルへの技術リプリケート番号の割り当て 
 

重要：技術リプリケート番号を割り当てるには、選択しているウェルは同一のウェル内容物を含んでい

なければなりません。すなわち、選択しているウェルは、同一のサンプルタイプと蛍光色素を含んでい

る必要があります。適切であれば、これらには同じターゲットとサンプル名、さらに同じ生物学的グル

ープも割り当てられるものとします。これらが異なる場合には、CFX Maestro ソフトウェアではこの

オプションが無効になります。 

 

ウェルグループへの技術リプリケート番号の割り当て方法 

 

1. Plate Editorで、ウェルグループの内容物が同一であることを確認します。 

 

2. プレートペインで、ウェルのターゲットグループを選択します。 

 

3. 右側のペインにある Replicate #セクションで、選択しているウェルの数と同じになるまでリプリ

ケート番号を増やします。 
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4. （オプション）リプリケートシリーズを選択しているウェルのセットに適用するには以下を行い

ます。 

 

a. Technical Replicates をクリックする。Replicate #セクションが展開され、以下のオプション

が表示されます。 

 
 

 Replicate Size（リプリケートサイズ） ― リプリケートの各グループ内のウェル数を示

す数値。 

 

 Starting Replicate #（開始リプリケート番号） ― 選択しているリプリケートグループ

のリプリケートシリーズの最初の番号。 

 

重要：デフォルトでは、CFX Maestro ソフトウェアはプレートに割り当てられている最

後の技術リプリケート番号よりも１大きい開始リプリケート番号を表示します。例えば、

プレートの最後の技術リプリケート番号が５の場合、次の開始番号は６になります。開始

番号は、まだ割り当てられていない任意の数に変更できます。 

 

 ロード方向（水平［Horizontal］または垂直［Vertical］） 

 

b. Applyをクリックしてシリーズにパラメータを適用し、Replicate #表示に戻る。 

 

5. OKをクリックして変更を確定し、プレートを保存します。 

 

注意：誤ってプレートを変更した場合には、OKをクリックして変更を確定する前に Plate Editor

ツールバーの Undoをクリックしてください。 

 

リプリケートシリーズからウェルを削除する方法 

 

 削除するウェルまたはウェルグループを選択し、Replicate # Loadチェックボックスを解除しま

す。 

 

代替的に、Clear Replicate #をクリックして、選択しているウェルまたはウェルグループからリプ

リケート番号を解除することもできます。 

 

プレートのすべての技術リプリケートを表示する方法 

 

 プレートのすべての技術リプリケートを表示するには、Show Technical Replicates をクリックし

ます。 

 

各グループが特定の色で識別され、Show Technical Replicates ボタンが Hide Technical 

Replicatesに切り替わります。 

 

Hide Technical Replicates をクリックすると、ウェル内の色が解除されます。代替的に、プレー

ト内の任意のウェルをクリックして、技術リプリケートを非表示にすることも可能です。 
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Standardサンプルタイプへの希釈系列の割り当て 
 

前述のとおり、Standard サンプルタイプのすべてのウェルには、濃度値を割り当てなければなりませ

ん。Standardサンプルタイプの複数のウェルに希釈系列を割り当てることが可能です。 

 

注意：希釈系列をウェルグループに割り当てるには、ウェルは技術リプリケートシリーズに含まれてい

る必要があります。ウェルをリプリケートシリーズに追加する方法に関する詳細については、104ペー

ジの「ウェルへの技術リプリケート番号の割り当て」を参照してください。 

 

Standardサンプルウェルのグループに希釈系列を割り当てる方法 

 

1. Plate Editorで、以下の要件が満たされていることを確認してください。 

 

 ウェルのグループのサンプルタイプが Standardであること。 

 

 グループ内のすべてのウェルに１つ以上の蛍光色素が割り当てられており、同一蛍光色素が

含まれていること。 

 

 グループ内のすべてのウェルが、同じ技術リプリケートシリーズに含まれていること。 

 

注意：CFX Maestroソフトウェアでは、選択しているすべてのウェルが基準を満たしている場合

にのみ Dilution Series（希釈系列）オプションが有効になります。 

 

2. プレートペインで、ウェルのターゲットグループを選択します。 

 

3. 右側のペインの Concentration セクションで、Dilution Series をクリックします。Concentration

セクションが展開され、以下のオプションが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 

 Starting Concentration（開始濃度） ― 希釈系列を開始する濃度値。 

 

 Replicates from and to（開始リプリケート番号から終了リプリケート番号まで） ― 希釈係

数が適用される希釈系列内のリプリケート。 

 

 Dilution Factor（希釈係数） ― リプリケートグループごとの濃度の変化量。 

 

4. オプションの値を設定するか、またはデフォルト値を確定します。 

 

5. デフォルトでは、Decreasingが選択されており、希釈系列は希釈係数ずつ減少します。Increasing

を選択すると、希釈系列が増加します。 
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6. （オプション）デフォルトでは、希釈係数はリプリケートシリーズ内のすべての蛍光色素に適用

されます。シリーズが２つ以上の蛍光色素を含み単一の蛍光色素に希釈を適用したい場合には、

その蛍光色素をドロップダウンリストから選択してください。 

 

7. Applyをクリックして希釈系列をウェルグループに適用し、Concentration画面に戻ります。 

 

8. OKをクリックして変更を確定し、プレートを保存します。 

 

注意：誤ってプレートを変更した場合には、OKをクリックして変更を確定する前に、Plate Editor

ツールバーの Undoをクリックしてください。 

 

別のウェルへのウェル内容の複製 
 

ウェルの内容をコピーし、それを単一または複数のウェルにペーストすることができます。しかし、単

一ウェルの内容しか複製できません。複数のウェルを選択してその内容を複製することはできません。 
 

別のウェルへのウェル内容の複製方法 

 

1. プレートペインで、複製するウェルを選択します。 

 

2. ウェルを右クリックして Copy Wellを選択します。 

 

3. 内容をペーストするウェルを選択します。 

 

 単一ウェルを選択する場合、そのウェルをクリックする。 

 

 複数の隣接するウェルを選択する場合、１つのウェルをクリックしてターゲットのウェルまで

ドラッグする。 

 

 複数の隣接しないウェルを選択する場合、Ctrlキーを押したまま各ウェルをクリックする。 

 

4. 選択しているターゲットウェルで右クリックして、Paste Wellを選択します。 

 

CFX Maestro ソフトウェアは選択したウェルに最初のウェルの内容をペーストします。 

 

ウェルへのメモの追加 
 

ウェルに説明のメモを追加することができます。このウェルのメモは、Data Analysis ウィンドウの

Quantificationタブで見ることができます。 

 

ウェルにメモを追加する方法 

 

1. プレートペインで、メモを追加したいウェルを選択します。 

 

2. 下部のペインにある Viewセクションで、Well Noteを選択します。 

 

Well Noteダイアログボックスが右側のペインに表示されます。 
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3. テキストボックスにメモの内容を入力し、Enterキーを押します。 

 

選択しているウェルの下部にテキストが表示されます。 

 

アドバイス：ウェルのメモを前にも作成している場合には、それをドロップダウンリストから選

び、選択しているウェルに適用することが可能です。 

 

ウェルからすべての内容を消去 
 

個々のウェル、ウェルグループ、またはプレート全体からすべての内容を消去することができます。ウ

ェル内容の消去によって、プレートリード中に収集された蛍光データが削除されることはありません。 
 

注意：ウェルの内容を消去することにより、ウェルから内容が永久に削除されます。ウェルの内容を消

去した後に OKをクリックしてプレートを保存すると、この消去操作を取り消すことはできません。ウ

ェルの内容を消去する際には注意してください。 

 

ウェルからすべての設定を消去する方法 

 

1. Plate Editorで、プレートペインのウェルまたはウェルグループを選択します。 

 

 単一ウェルを選択する場合、そのウェルをクリックする。 

 

 複数の隣接するウェルを選択する場合、１つのウェルをクリックしてターゲットのウェルま

でドラッグする。 

 

 複数の隣接しないウェルを選択する場合、Ctrlキーを押したまま各ウェルをクリックする。 

 

 同一のサンプルタイプのカラム全体を選択する場合、カラム番号をクリックする。 

 

 列全体を選択する場合、その列番号をクリックする。 

 

2. 右側のペインで、Clear Wellsをクリックします。 

 

CFX Maestro ソフトウェアは、選択しているウェルのすべての設定を消去します。 

 

3. 以下のいずれかを行います。 

 

 誤ってウェルの内容を消去した場合には、OK をクリックして変更を確定する前に、Plate 

Editorツールバーの Undoをクリックしてください。 

 

重要：Undo をクリックする前に OK をクリックすると変更が保存され、Plate Editor ツール

バーの Undoが無効になります。 

 

 OKをクリックして変更を確定し、プレートを保存する。 
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Experiment Settingsの変更 
 

Experiment Settings ダイアログボックスを使用して、ターゲットやサンプルのリストを表示または変

更し、生物学的グループをプレート内のウェルに割り当てた場合には、解析用の遺伝子発現解析サンプ

ルグループを設定することができます。 

 

Experiment Settings ダイアログボックスの Targetsタブには、ターゲット遺伝子または対象の遺伝子配

列などの、各 PCR反応ようのターゲット名のリストが表示されます。 

 

Samplesタブには、１時間（1 Hr）で得られるサンプルまたは特定の個体（マウス１）より得られるサ

ンプルなど、ターゲットのソースを示すサンプル名のリストが表示されます。 

 

デフォルトで、CFX Maestro ソフトウェアには各ターゲットとサンプル名に関するすべての解析設定

が表示されます。設定パラメータ調節すれば、Data Analysis ウィンドウの情報を変更することが可能

です。 

 

Experiment Settingsダイアログボックスを使用したプレート設定の変更方法 

 

1. Experiment Settings ダイアログボックスを開くには、以下のいずれかを行います。 

 

 Plate Editorの右側のペインで、Experiment Settingsをクリックする。 

 

 Data Analysisウィンドウの Gene Expressionタブで、Experiment Settings をクリックする。 
 

Experiment Settingsダイアログボックスが現れ、Targetsタブの内容が表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 新しいターゲットまたはサンプル名を追加するには、該当するタブの Newテキストボックスに名

称を入力して Addをクリックします。 

 

3. リストから１つ以上のターゲットまたはサンプル名を削除するには、該当するタブの Select to 

Removeカラムで項目のチェックボックスを選択して、Remove checked item(s)をクリックしま

す。 
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4. CFX Maestroでは、遺伝子発現解析からの NTC（対照テンプレートなし）サンプルタイプは除外

されます。 

 

NTCサンプルタイプを含めるには、Exclude the following sample types（以下のサンプルタイプ

を除外）セクションのチェックボックスを解除します。以下から該当するチェックボックスを選

択して、除外するサンプルタイプを選択できます。 

 

 NRT（逆転写なし） 

 

 Negative Control（陰性対照） 

 

 Positive Control（陽性対照） 

 

 Standard（標準） 

 

5. Targetsタブでは以下を行えます。 

 

a. 遺伝子発現データ解析用の基準としてターゲットを選択する場合、Referenceカラムからター

ゲットを選択する。 

 

b. Analysis Settings ウィンドウの Gene Expressionタブに適用される解析パラメータを非表示

にする場合、Show Analysis Settings を解除する。 

 

ソフトウェアは以下のカラムを非表示にします。 

 

 Color（色） 

 

 Show Chart（グラフを表示） 

 

 Auto Efficiency（自動効率） 

 

 Efficiency（効率）（%） 

 

c. Gene Expressionグラフに描かれるターゲットの色を変更する場合、Colorカラム内の該当す

るセルをクリックし、表示される Colorダイアログボックスで新しい色を選択して OKをクリ

ックする。 

 

d. 選択した色で Gene Expressionグラフにターゲットを表示する場合、Show Graph カラムの

チェックボックスを選択する。 

 

e. デフォルトでは、データが検量線を含む場合に CFX Maestroソフトウェアは、ターゲットの

相対効率を自動的に計算する。 

 

以前得た効率値を使用する場合には、その値を Efficiency（%）カラムの該当するセルに入力

して Enterキーを押してください。CFX Maestroソフトウェアが Auto Efficiencyチェックボ

ックスを解除します。 

 

6. Samplesタブでは以下を行えます。 

 

a. 遺伝子発現データ解析用のコントロールサンプルとしてサンプルを選択する場合、Controlカ

ラム内の該当するチェックボックスを選択する。 

 

b. ラン用のサンプルにコントロール条件を割り当てる場合、Controlカラム内の該当するチェッ

クボックスをクリックする。 

 

c. まだ選択していない場合には、Show Analysis Settings を解除して Gene Expressionタブに適

用される解析パラメータを非表示にするか変更する。ソフトウェアが Color カラムと Show 

Chartカラムを非表示にします。 

 

7. OKをクリックして Experiment Settingsダイアログボックスにパラメータを保存し、Plate Editor

ウィンドウに戻ります。 
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ウェルグループの作成 
 

ウェルグループは単一プレートを、Data Analysis ウィンドウで個別に解析できるウェルのサブセット

へと分割します。ウェルグループの設定後、独立グループとしてデータ解析するため Data Analysisウ

ィンドウから１つ選びます。例えば、１つのプレートで複数の実験ランを解析するため、または異なる

検量線を含む各ウェルグループを解析するために、ウェルグループを設定します。 

 

注意：デフォルトのウェルグループは All Wells（すべてのウェル）です。 

 

ウェルグループの作成方法 

 

1. Well Groups Managerを開くには、以下のいずれかを行います。 

 

 Plate EditorツールバーのWell Groupsをクリックする。 

 

 Data Analysisウィンドウの Manage Well Groupsをクリックする。 

 

Well Groups Managerダイアログボックスが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Add をクリックして新しいグループを作成します。ドロップダウンメニューには、最初のグルー

プのグループ名が Group 1（グループ１）と表示されます。 

 

3. ウェルグループをクリック＆ドラッグして、プレート内のウェルグループ用のウェルを選択しま

す。選択したウェルが青色で Manager に表示されます。 

 

4. （オプション）ウェルグループの名称を変更するには、その名称をドロップダウンメニューから

選択して新しい名称を入力します。 

 

5. （オプション）ウェルグループを削除するには、その名称をドロップダウンから選択して Delete

をクリックします。 

 

6. 終了するには OKをクリックしてウィンドウを閉じるか、Cancelをクリックして変更を行わずに

ダイアログボックスを閉じます。 
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Well Groups Manager ダイアログボックスの右クリックメニュー項目 
 

表６は、ウェルを右クリックしたときにWell Groups Managerダイアログボックスで使用できるメニ

ュー項目です。 

 

表６ Well Groups Managerダイアログボックスの右クリックメニュー項目 

項目 機能内容 

Copy 後に別のウェルにペーストできるウェルの内容をコピーします。 

Copy as Image ウェルセレクター画面を画像としてコピーします。 

Print ウェルセレクター画面を印刷します。 

Print Selection 現在の選択肢を印刷します。 

Export to Excel データを Excelのスプレッドシートにエクスポートします。 

Export to Csv データをカンマ区切り文書としてエクスポートします。 

Export to Xml データを.xml文書としてエクスポートします。 

Export to Html データを.html文書としてエクスポートします。 
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トレーススタイルの変更 
 

プレートセットアップ中とランの進行中、増幅トレースの色とスタイルを変更することができます。そ

して、データの収集に応じて Real-time Statusウィンドウでトレースを簡単に表示することができます。 
 

トレーススタイルの変更方法 

 

1. Plate Editorツールバーの Trace Stylesをクリックします。 

 

開いているプレートの Trace Stylesダイアログボックスが、下図のように表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 特定の蛍光色素でトレーススタイルを表示するには、その蛍光色素を Fluorophoresドロップダウ

ンリストから選択します。 

 

3. トレース表示を変更するには、以下を行います。 

 

a. Wellsドロップダウンリストからトレースタイプを選択する。 

 

b. Colorカラムでトレースの色をクリックする。 

 

c. 表示される Colorダイアログボックスで、トレース用の別の色を選び OKをクリックする。 

 

ウェルタイプの変化が下のグリッドに表示されます。 

 

d. （オプション）Symbolsドロップダウンリストからトレース用の記号を選択する。 

 

4. 色のセットを迅速に変更するには、Color Quick Setセクションで該当する選択肢をクリックしま

す。 

 

5. グリッド内のウェルラベルを表示するには、Well Labelsセクションのラベルタイプを選択します。 
 

6. OKをクリックして変更を保存するか、Cancelをクリックして変更をキャンセルします。 
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スプレッドシートフォーマットで表示 
 

Spreadsheet View/Importer ツールには、プレートの内容がスプレッドシートフォーマットで表示され

ます。Spreadsheet View/Importer ツールを使用して、タブ区切りフォーマットのウェルの内容を

Microsoft Excelなどのアプリケーションにエクスポートすることができます。また、タブ区切りのアプ

リケーションからウェルの内容をインポートすることも可能です。 

 

Spreadsheet View/Importerツールの使用方法 

 

1. Plate Editorツールバーの Spreadsheet View/Importerをクリックして、Plate Spreadsheet View

ダイアログボックスを開きます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Spreadsheet Viewダイアログボックスには、単一の蛍光色素に関するプレートの内容が表示され

ます。別の蛍光色素に関するプレートの内容を表示するには、Fluors List ドロップダウンリスト

から選択します。 

 

3. プレートのスプレッドシートのテンプレートを Excel ファイル（.csv フォーマット）にエクスポ

ートするには、Export Templateをクリックします。このテンプレートを編集して、ウェルの内容

情報をインポートできます。 

 

4. （オプション）カンマ区切りファイルからウェルの内容をインポートするには、Import をクリッ

クします。 

 

5. 特定のカラムのデータに応じてスプレッドシートをソートするには、カラム名の隣にある三角を

クリックします。 

 

アドバイス：カラム名そばにアスタリスク（*）があるカラム（例えば*Target Name）内のあらゆ

るセルの内容は編集可能です。 

 

注意：Plate Editorを開いてメニューバーの Settings > Unitsを選択して、Quantityカラム内の検量線デ

ータの単位を選択してください。プレートのラン完了後、この検量線データが、選択した単位で Data 

Analysisウィンドウの Quantificationタブの Standard Curveグラフに表示されます。 
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Spreadsheet View/Importerツールの右クリックメニュー項目 

 

表７は、ツール内のウェルで右クリックしたときに使用できる Spreadsheet View/Importerツールのメ

ニュー項目を記載しています。 

 

表７ Spreadsheet View/Importerツールの右クリックメニュー項目 

項目 機能内容 

Copy スプレッドシート全体をコピーします。 

Copy as Image スプレッドシートを画像ファイルとしてコピーします。 

Print スプレッドシートを印刷します。 

Print Selection 選択したセルのみを印刷します。 

Export to Excel ファイル Excelのスプレッドシートにエクスポートします。 

Export to Text ファイルをテキストファイルにエクスポートします。 

Export to Xml ファイル.xmlファイルとしてエクスポートします。 

Export to Html ファイル.htmlファイルとしてエクスポートします。 

Find スプレッドシート内のテキストを検索します。 

Sort Sort ウィンドウ内のデータを最大 3 カラムまで選択してスプレッドシ

ートをソートします。 
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Setup Wizardを使用したプレートレイアウトの作成 
 

Setup Wizard を使用すると、正規化遺伝子発現解析に必要なプレートレイアウト情報を入力すること

ができます。この情報は以下を含みます。 

 

 ターゲット名 

 

 サンプル名 

 

 プレートにおけるターゲットとサンプルの位置 

 

 リファレンス遺伝子 

 

 コントロールサンプル 

 

ランの前、ラン実行中、またはランの後に Setup Wizardを使用できます。 

 

Setup Wizardの使用 
 

本節では、プレートの Setup Wizardを使用したプレートレイアウトの作成方法について説明します。

プレート内の各ウェルの内容をより見やすくするには、Setup Wizardの上部にある Zoom plateをクリ

ックしてください。 

 

重要：Setup Wizardの他のタブにいる間に Auto layoutタブに戻ると、プレートレイアウトがリセット

されます。このタブを選択する際には注意してください。 

 

アドバイス：Setup Wizardの Tools > Clear Plateを選択すると、レイアウトをリセットできます。 

 

Setup Wizardの使用方法 

 

1. Plate Editorを開きます。 

 

2. Setup Wizardを開くには、以下のいずれかを行います。 

 

 Editing Tools > Setup Wizard を選択する。 

 

 Plate Editorツールバーの Setup Wizardをクリックする。 
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Setup Wizardが現れ、Auto layout タブが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Auto layoutタブで以下を行います。 

 

a. グリッド内のウェルをクリックして横方向と下方にドラッグし、サンプルをロードしたいプ

レート上の領域を指定する。 

 

b. ロードするターゲットとサンプルの数を入力する。 

 

アドバイス：ターゲットとサンプルの数は、選択しているセルの数を同じである必要があり

ます。入力した数値が選択した領域に一致しない場合、数値かプレートの選択領域を修正し

てください。プレート上のアイテムの方向やグルーピングを指定できます。 

 

c. （オプション）プレートの方向を変更する。例えば、列内のターゲットや行内のサンプル、

またはサンプルのグループを設定できます。 

 

d. Nextをクリックして Target namesタブに移る。 

 

注意：プレートレイアウトに一定のパターンがない場合には、Target namesタブを使用して

ターゲットを手動で配置するか、Sample names タブを使用してプレート上にサンプルを手

動で配置してください。クリック＆ドラッグして、複数のウェルを選択してください。 

 

4. Target names タブで、ターゲットグループのターゲット名を定義します。 

 

a. 以下のいずれかを行う。 

 

 グループごとのターゲット名を変更する場合、Select byを Target に設定する。 

 ウェルごとのターゲット名を変更する場合、Select byをWellに設定する。 
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b. グリッド内のターゲットグループまたはウェルを選択して、Target name ドロップダウンリ

ストに名称を入力する。 

 

アドバイス：右側にある次のグループまたはウェルを選択するには Tab を押し、下にある次

のグループまたはウェルを選択するには Enter を押してください。代替的に、Target name

タブと Sample nameタブで、Ctrlキーを押したままウェルをクリックして、隣接していない

複数のウェルを選択できます。 

 

c. Nextをクリックして Sample namesタブに移る。 

 

5. Sample namesタブで、サンプルグループ用のサンプル名を定義します。 

 

6. Nextをクリックして Reference targetsタブに移ります。 

 

7. Reference targets タブで、正規化遺伝子発現用のリファレンスとして使用する１つ以上のターゲ

ットを選択し、Nextをクリックして Control sampleタブに移ります。 

 

8. Control sampleタブで、相対遺伝子発現計算用のコントロールとして使用するサンプルを１つ選

択します。 

 

9. OKをクリックしてプレートレイアウトを保存し、Plate Editorに戻ります。ここではさらに、プ

レートパラメータを定義できます。詳細については、99ページの「プレートファイルへのオプシ

ョンのパラメータの割り当て」を参照してください。 

 

代替的に、Previousをクリックすると、前のタブに戻って変更を行えます。 

 

注意：Auto layoutタブに戻ると、プレートが自動的にリセットされます。Previousをクリックす

る際には注意してください。 
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第７章 実験のラン 
 

本章では、CFX Maestro ソフトウェアを使用した、カスタム（ユーザー設定）または PrimePCRアッ

セイ実験のランの方法について説明します。 

 

ランのデータファイルには、ラン用のプロトコールとプレート情報が含まれます。また、ラン完了後に

CFX Maestro が実施する解析から得られるデータも含まれます。 

 

CFX Maestro ソフトウェアにより、ユーザー定義または PrimePCR実験の設定とランが容易になりま

す。Run Setupウィンドウが実験の設定に関する共通手順を Start Runダイアログボックスまでガイド

します。そしてそこからランを開始します。 

 



第７章 | 実験のラン 

120 | CFX Maestro™ ソフトウェア 

Run Setupウィンドウ 
 

Run Setupウィンドウは、実験の設定とランに必要なファイルと設定への迅速なアクセスを提供します。

ユーザー定義の実験のランを実行したい場合、Run Setup ウィンドウを開いて Protocol タブを表示し

ます。PrimePCR実験のランを実行したい場合には、Run Setupウィンドウを開いて Start Runタブを

表示します。 

 

アドバイス：PrimePCRの詳細については、133ページの「PrimePCR実験の実施」を参照してくださ

い。また、Start Runタブの詳細については、125ページの「Start Runタブ」を参照してください。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

説明 

1 タブは、実験の設定とラン実行の際のガイドになります。 

  Protocolタブ ― ランまたは編集する既存のプロトコールを選択し、または Protocol Editor

内に新しいプロトコールを作成します。 

  Plateタブ ― ランまたは編集する既存プレートを選択し、または Plate Editor内に新しいプ

レートを作成します。 

  Start Run タブ ― 実験の設定の表示、１つ以上の機器ブロックの選択、およびランの開始

を行います。 

2 メインウィンドウには、適用する各タブのオプションが表示されます。 

3 ナビゲーションボタンにより Start Runタブへ導かれます。 
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Run Setupウィンドウへのアクセス 
 

Run Setupウィンドウへのアクセス方法 

 

 以下のいずれかを行います。 

 

 Startup Wizard内の Run setupタブの User-definedまたは PrimePCRをクリックする。 

 

 Homeウィンドウのツールバーの User-defined Run Setupまたは PrimePCR Run Setupをク

リックする。 

 

 Homeウィンドウで Run > User-definedRun または PrimePCR Run のいずれかを選択する。 
 

Protocolタブ 
 

Protocolタブには、ランを実行するプロトコールファイルのプレビューが表示されます。プロトコール

ファイルには、機器温度ステップに関する指示に加え、ランプレート、サンプル容量、およびリッド温

度を制御する機器のオプションが含まれます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

デフォルトで、ソフトウェアは User > User Preferencesダイアログボックスの Filesタブにある Run 

Setupセクションで File Selectionに定義されるプロトコールを表示します。User Preferencesダイア

ログボックス内でデフォルトのプロトコールを変更できます。詳細については、49 ページの「デフォ

ルトのファイル設定の変更方法」を参照してください。 

 

Protocolタブでは以下を行えます。 

 

 ランを実行する新規プロトコールの作成 

 

 ランまたは編集する既存のプロトコールを選択 

 

プロトコールの作成や修正の詳細については、第５章の「プロトコールの作成」を参照してください。 
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新しいプロトコールの作成方法 

 

1. Protocolタブの Create Newをクリックします。 

 

Protocol Editorが表示されます。 

 

2. Protocol Editorを使用して新しいプロトコールを作成します。 

 

3. OKをクリックしてプロトコールを保存し、Run Setupの Protocolタブに戻ります。 

 

4. プロトコールの詳細を表示し、以下のいずれかを行います。 

 

 詳細が正しい場合、Nextをクリックして Plateタブに移る。 

 

 詳細が正しくない場合、Edit SelectedタブをクリックしてProtocol Editorウィンドウに戻る。

プロトコールを訂正して変更を保存した後、Protocol タブの Next をクリックして Plate タブ

に移る。 

 

既存のプロトコールの選択方法 

 

1. Protocolタブで、以下のいずれかを行います。 

 

 Select Existingをクリックして既存のプロトコールへナビゲートする。 

 

 Express Loadをクリックし、プロトコールのドロップダウンリストからプロトコールを１つ

選択する。 

 

アドバイス：Express Loadドロップダウンリストへのプロトコールの追加、またはドロップ

ダウンリストからのプロトコールの削除を行えます。詳細については、「Express Loadのプ

ロトコール追加および削除」を参照してください。 

 

2. プロトコールの詳細を表示し、以下のいずれかを行います。 

 

 詳細が正しい場合、Nextをクリックして Plateタブに移る。 

 

 詳細が正しくない場合、Edit Selectedをクリックして Protocol Editorを開く。プロトコール

を訂正して変更を保存した後、Protocolタブの Nextをクリックして Plateタブに移る。 

 

Express Loadのプロトコールの追加および削除 

 

Protocol Editorに表示される Express Loadドロップダウンリストの内容を修正することができます。

このリストのプロトコールは、下記のフォルダに保存されます。 

 
C:¥Users¥Public¥Documents¥Bio-Rad¥CFX¥Users¥<user_name>¥ExpressLoad¥ 
 

Express Loadリストのプロトコールの修正方法 

 

1. ExpressLoadフォルダにナビゲートして、これを開きます。 

 

2. フォルダ内のプロトコールファイル（.pcrl）を訂正します。 

 

3. 以下のいずれかを行います。 

 

 フォルダからプロトコールを削除して、ドロップダウンリストから削除する。 

 

 フォルダ内のプロトコールをコピーして、ドロップダウンリストに追加する。 
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Plateタブ 
 

注意：Protocol タブで選択したプロトコールがリアルタイム PCR 解析用のプレートリードステップを

含まない場合には、Plateタブが非表示になります。Plateタブを表示するには、プロトコールに少なく

とも１つのプレートリードを追加してください。 

 

Plate タブには、ロードするプレートファイルのプレビューが表示されます。リアルタイム PCR ラン

では、プレートファイルは、蛍光色素、スキャンモード、およびプレートタイプを含む各ウェルの内容

の説明を含みます。CFX Maestro ソフトウェアではこれらの説明を使用してデータ収集と解析を行い

ます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

デフォルトで、ソフトウェアは User > User Preferences ダイアログボックス内の Files タブの Run 

Setupセクションで File Selectionに定義されたプレートを表示します。User Preferencesダイアログ

ボックス内のデフォルトのプレートを変更できます。詳細については、49 ページの「デフォルトのフ

ァイル設定の変更方法」を参照してください。 

 

Plateタブでは、以下を行えます。 

 

 ロードする新しいプレートの作成 

 

 ロードまたは編集する既存のプレートの選択 

 

プレートの作成と修正に関する詳細については、「プレートの作成」を参照してください。 
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新しいプレートの作成方法 

 

1. Plateタブの Create Newをクリックします。 

 

Plate Editorが表示されます。 

 

2. Plate Editorを使用して、新しいプレートを作成します。 

 

3. OKをクリックしてプレートを保存し、Run Setupの Plateタブに戻ります。 

 

4. プレートの詳細を表示して以下のいずれかを行います。 

 

 詳細が正しい場合、Nextをクリックして Start Runタブに移る。 

 

 詳細が正しくない場合、Edit Selectedをクリックして Plate Editorに戻る。プレートファイル

を訂正して変更を保存した後、Plateタブの Nextをクリックして Start Runタブに移る。 

 

既存のプレートファイルの選択方法 

 

1. Plateタブで以下のいずれかを行います。 

 

 Select Existingをクリックして既存のプレートファイルへナビゲートする。 

 Express Loadをクリックしてドロップダウンリストからプレートファイルを選択する。 

 

アドバイス：Express Loadドロップダウンリストにプレートを追加し、またはドロップダウ

ンリストからプレートを削除することができます。詳細については、「Express Loadのプロ

トコールの追加および削除」を参照してください。 

 

2. プレートの詳細を表示して以下のいずれかを行います。 

 

 詳細が正しい場合、Nextをクリックして Start Runタブに移る。 

 

 詳細が正しくない場合、Edit Selectedをクリックして Plate Editorウィンドウを開く。プレー

トファイルを訂正して変更を保存した後、Plateタブの Nextをクリックして Start Runタブに

移る。 

 

Express Loadのプレートファイルの追加および削除 

 

Plate Editorに表示される Express Loadドロップダウンリストの内容を修正することができます。この

リストに表示されるプレートは、以下のフォルダに保存されます。 

 
c:¥Users¥Public¥Documents¥Bio-Rad¥CFX¥User¥<user_name>¥ExpressLoad¥ 
 

Express Loadリストのプレートファイルの修正方法 

 

1. ExpressLoadフォルダにナビゲートして、これを開きます。 

 

2. フォルダ内のプレートファイル（.pltd）を訂正します。 

 

3. 以下のいずれかを行います。 

 

 フォルダからプレートファイルを削除し、ドロップダウンリストからプレートファイルを削

除する。 

 

 フォルダにプレートファイルをコピーし、ドロップダウンリストにプレートファイルを追加

する。 
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Start Runタブ 
 

Start Runタブには、ランを実行する実験に関する情報が表示されます。また、実験のランを実行でき

る接続機器、ブロックが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Start Runタブでは以下を行えます。 

 

 選択しているプロトコールファイル、プレートファイル、およびスキャンモードを含む詳細なラ

ン情報の表示。 

 

 ランに関するメモの追加。 

 

 ランのステータス（実行中または待機中）、µL単位のサンプル容量、リッド温度、エミュレーシ

ョンモード、および IDまたはバーコード（可能な場合）を含む、接続されているすべての機器に

関する詳細の表示。 

 

注意：Selected Blocks表の Start Runに表示されるカラムを修正できます。詳細については、126

ページの「Selected Blocks表における詳細の修正」を参照してください。 

 

 ランを実行するブロックの選択。 

 

 選択している各機器のリッドの開閉の遠隔制御。 

 

 ランの開始。 
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Selected Blocks表における詳細の修正 

 

Selected Block(s)表の Start Runに表示されるカラムを修正することができます。また、この表のデフ

ォルトのサンプル容量やリッド温度の値も修正できます。設定の変更は、実行するランに適用されます。 
 

Selected Blocks表の Start Runにカラムを追加する方法 

 

 表を右クリックし、表示されるメニュー内のオプションを選択します。 

 

Selected Blocks表の Start Runからカラムを削除する方法 

 

 表を右クリックし、表示されるメニュー内のオプションを解除します。 

 

ブロックのサンプル容量またはリッド温度の値を編集する方法 

 

 ターゲットブロックのサンプル容量またはリッド温度セルを選択し、新しい値をセルに入力しま

す。 

 

ブロックのラン IDまたはバーコードの追加方法 

 

 ターゲットブロックの ID/Bar Codeセルを選択し、IDを入力するかバーコードリーダーでスキャ

ンします。 

 

実験のラン実行 
 

実験のラン実行方法 

 

1. Start Runタブの Run Informationセクションで、プレートとプロトコールの詳細を検証します。 

2. （オプション）Notesテキストボックスに、ランまたは実験に関するメモを追加します。 

3. ランを実行する１つ以上のブロックのチェックボックスを選択します。 

 

アドバイス：すべてのブロックの実験ランを実行するには、Selected Blocks表の下にある Select 

All Blocksを選択してください。 

 

4. （オプション）Flash Block Indicatorをクリックすると、選択している各機器ブロックのインジケ

ータ LEDが点灯します。 

 

5. ブロックに実験プレートを挿入します。 

 

a. Open Lidをクリックする。選択している各ブロックの自動リッドが開きます。 

 

b. 選択している各ブロックに実験ブロックを挿入する。 

 

c. Close Lidをクリックする。 

 

アドバイス：各ブロックの前方にあるボタンを押しても、リッドを開閉するができます。 

 

6. Open Lidおよび Close Lidをクリックして、選択している各機器ブロックの自動リッドを開閉さ

せます。 
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7. ランの詳細を表示して、以下のいずれかを行います。 

 

 詳細が正しい場合、Start Runをクリックする。 

 

 詳細が正しくない場合: 

 

 Selected Blocks タブの詳細を修正し、Start Runをクリックする。 

 

 正しいタブに戻って適正な変更を行い、変更を保存した後に Next をクリックして Start 

Runタブに戻り、ランを開始する。 

 

以前のランから新しいランを開始する方法 

 

 以下のいずれかを行います。 

 

 ソフトウェアのメインメニューバーで File > Repeat a Runを選択し、繰り返したいランのラ

ンデータファイルにナビゲートしてそれをダブルクリックする。 

 

 Startup Wizardの Repeat Runタブを選択して、繰り返したいランのランデータファイルをダ

ブルクリックする。 

 

任意に、Repeat Runタブで Browse をクリックすると、繰り返したいランデータファイルに

ナビゲートしてそれをダブルクリックすることが可能です。 
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Run Detailsダイアログボックス 
 

Start Run をクリックすると、CFX Maestroソフトウェアはデータファイル（.pcrd）の保存を促し、ラ

ンを開始し、Run Detailsダイアログボックスを開きます。Run Detailsダイアログボックスは以下の３

つのタブを含みます。 

 

 Run Status（ランのステータス） ― このタブは、プロトコールの現在のステータスの表示、リ

ッドの開閉、ランの一時停止、繰り返しの追加、ステップのスキップ、またはランの中止などを

おこないます。 

 

 Real-time Status（リアルタイムステータス） ― このタブは、収集したリアルタイム PCR蛍光

データを表示します。 

 

 Time Status（時間のステータス） ― このタブは、プロトコール用の全画面カウントダウンタ

イマーを表示します。 

 

これらのタブについては、後続の節で詳述します。 

 

Run Statusタブ 
 

Run Status タブには、現在進行中のランのステータスが表示されます。この画面では、リッドの制御

や進行中のランの変更も可能です。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

説明 

1 Run Status（ランのステータス）ペイン ― プロトコールの現在の進捗状況を表示します。 

2 Run Status（ランのステータス）コントロールボタン ― 機器の操作または現在のプロトコール

の中断が可能です。 

3 Run Information（ラン情報）ペイン ― ランの詳細を表示します。 
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Run Statusコマンド 

 

Run Status タブのコマンドを使用すると、ソフトウェアから機器を操作し、または進行中のランを変

更することができます。 

 

注意：ラン実行中に、繰り返しを追加するなど、プロトコールを変更しても、ランに関連するプロトコ

ールファイルは変更されません。この操作は、Run Logに記録されます。 

 

 ― 選択している機器の自動リッドを開きます。 

 

重要：ランの実行中にリッドを開くと、現ステップ中のランが一時停止し、データが変更される

おそれがあります。 

 

 ― 選択している機器の自動リッドを閉じます。 

 

  ― プロトコールの現在の GOTO ステップにさらに多くの繰り返しを追加します。

このオプションは、GOTOステップの実行中にのみ使用できます。 

 

 ― プロトコールの現在のステップをスキップします。 

 

注意：GOTOステップをスキップすると、ソフトウェアは GOTOループ全体をスキップするこ

との確定を促し、プロトコールの次のステップに進みます。 

 

 ― 選択している機器の LEDを点灯し、選択しているブロックを識別します。 

 

 ― プロトコールを一時中断します。 

 

注意：この操作は Run Logに記録されます。 

 

 ― 一時中断していたプロトコールを再開します。 

 

 ― プロトコールが終了する前にランを中止します。 

 

注意：プロトコールの終了前にランを中止すると、データが変更されるおそれがあります。 
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Real-time Statusタブ 
 

Real-time Statusタブには、ランでの最初の２回のデータ読み取り後に、各サイクルで収集されたリア

ルタイム PCRデータが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

説明 

1 Amplification trace（増幅トレース）ペイン ― ラン実行中のリアルタイム増幅データを表示し

ます。 

2 Well group identifier（ウェルグループ識別名称） ― ウェルグループがプレート設定で識別され

た場合、ユーザーはトレース、ウェル、および表形式の情報を表示する特定のウェルグループを

選択できます。 

Step number identifier（ステップ数識別名称） ― プロトコールが２つ以上のステップでデータ

収集する場合（例えば、増幅と融解曲線の最中）、ユーザーは特定のステップを選択してそのス

テップで収集されるトレースを見ることができます。 

3 Well selector（ウェルセレクター）ペイン ― プレート内の、アクティブウェル、非アクティブ

ウェル、および空のウェルを表示します。 

4 Plate setup table（プレート設定表）ペイン ― プレート設定を表形式で表示します。 

5 Run details（ランの詳細）ペイン ― 以下を含むランのリアルタイムの状況を表示します。 

  現在のステップ 

  現在のリピート数 

  現在の温度 

  残り時間 

  サンプル温度 

  リッド温度 

6 Plate Setup（プレート設定） ― Plate Setupダイアログボックスを開きます。ここではラン実

行中に現在のプレート設定を修正することができます。 
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Real-time Statusタブでは、以下を行えます。 

 

 ウェルセレクターペインまたはプレート設定表で選択することにより、リアルタイムトレースを

表示または非表示にする。 

 

 ウェルグループドロップダウンリストで選択することにより、単一トレースまたはトレースグル

ープを表示する。 

 

 プレートを編集、またはプレートファイルを入れ替える。 

 

 ランに PrimePCRファイルを適用する。 

 

リアルタイムトレースの表示または非表示 

 

デフォルトでは、充填されたすべてのウェルはアクティブであり、プレート設定表に表示されます。ア

クティブなウェルは、ウェルセレクターペインに青色で表示されます。非表示のウェルはウェルセレク

ターペインに薄いグレー色で表示され、使用されないウェルは濃いグレー色で表示されます。 

 

ランの実行中にアクティブウェルからのトレースを非表示にすることができます。CFX Maestro はす

べてのウェルに関するデータ収集を継続します。ウェルを非表示にすると、プレート設定表にはデータ

が表示されません。 

 

リアルタイムトレースを非表示にする方法 

 

 ウェルセレクターペインで、非表示にしたいアクティブ（青色）ウェルをクリックします。 

 

リアルタイムトレースを表示する方法 

 

 ウェルセレクターペインで、表示したい非表示（薄いグレー色）ウェルをクリックします。 

ウェルセレクターの詳細については、145ページの「ウェルセレクター」を参照してください。 

 

Plate Setupの編集 

 

プレート設定の編集方法 

 

 Plate Setupをクリックした後に、View/Edit Plateを選択します。 

 

Plate Editorウィンドウが表示されるので、ここで、ランの進行中にプレートを編集できます。プ

レートの編集に関する詳細については、「プレートの」を参照してください。 

 

注意：Plate Editor ウィンドウからトレース形式を編集することもできます。変更が Real-time 

Statusタブの増幅トレースプロットに表示されます。 
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プレートファイルの入れ替え 

 

アドバイス：プレートファイルの入れ替えは、ExpressLoadフォルダ内の Quick Plateファイルでラン

を開始する場合に特に便利です。 

 

プレートファイルの入れ替え方法 

 

 Plate Setupをクリックした後に以下のオプションのいずれかを選択します。 

 

 Replace Plate file（プレートファイルの入れ替え） ― ブラウザウィンドウ内のリストから新

しいプレートファイルを選択します。 

 

 Apply PrimePCR file（PrimePCRファイルを適用） ― Smart検索を使用してプレートレイ

アウトが得られるランファイルを検索するか、バイオ・ラッド社のウェブサイトからダウン

ロードされ PrimePCR フォルダ内に含まれていないファイルを検索するのに Browse をクリ

ックします。 

 

注意：CFX Maestroでは、プレートファイルのスキャンモードとプレートサイズを確認します。

これらは、ランを開始したラン設定と同じものとします。 

 

Time Statusタブ 
 

Time Statusタブには、現時点でのランを完了するまでの残余時間が表示されます。 
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PrimePCR実験の実施 
 

PrimePCR実験では、バイオ・ラッド社がウェットラボにて検証済みかつ最適化済みのパスウェイや疾

患特異的なアッセイを使用でき、以下のフォーマットで使用できます。 

 

 Preplated panels（プリプレートパネル） ― 生物学的パスウェイまたは疾患に特有のアッセイを

含んだプレート。これらは PrimePCRコントロールと対照遺伝子を含みます。 

 

 Custom configured plates（カスタム設定プレート） ― 対象のターゲット、コントロール、およ

びリファレンスのアッセイを選択するオプションを含むユーザー決定レイアウトで設定されるプ

レート。 

 

 Individual assays（独立アッセイ） ― リアルタイム反応で使用する独立したプライマーセットを

含むチューブ。 

 

全体的なラン時間を縮小するため、プロトコール内の融解ステップを削除することができます。バイ

オ・ラッド社は、PrimePCRランプロトコールにはこれ以外の変更を加えることをお勧めしません。デ

フォルトのプロトコールが、アッセイの検証に使用されます。これを逸脱すると、結果に影響がおよぶ

可能性があります。プロトコールの変更は、結果として生じるデータファイルの Run Informationタブ

や作成されるレポートに記録されます。 

 

PrimePCRランの開始方法 

 

 PrimePCRランを開始するには、以下のいずれかを行います。 

 

 Startup Wizardの Run Setupタブで PrimePCRを選択し、該当するケミストリー（SYBRま

たは Probe）を選択する。 

 

 Startup WizardにあるRepeat runタブのRecent RunsリストからPrimePCRランを選択する。 
 

 Homeウィンドウで File > New > PrimePCR Runを選択する。 

 

 Homeウィンドウで File > Open > PrimePCR Run Fileを選択する。 

 

 PrimePCRランファイルを Homeウィンドウにドラッグ＆ドロップする。 

 

PrimePCRランの選択後、Start Runタブに Run Setupウィンドウが開き、ここには、選択している機

器に基づきデフォルトの PrimePCRプレートレイアウトがロードされています。 

 

プロトコールにおける融解ステップの削除方法 

 

 Protocolタブで、Include Melt Stepの隣のボックスを解除します。 

 

PrimePCRプレートのターゲット情報をプレートレイアウトにインポートする方法 

 

1. 以下のいずれかを行います。 

 

 Run Detailsダイアログボックスの Real-time Statusタブで、Plate Setup > Apply PrimePCR 

Fileを選択する。 

 

 Data Analysisウィンドウで、Plate Setup > Apply PrimePCR File を選択する。 

 

2. PrimePCR run fileダイアログボックスで、Browseをクリックして該当する PrimePCRファイル

（.csv）にナビゲートします。 

 

3. ターゲットの PrimePCRファイルを選択して Openをクリックします。 

 

CFX Maestro はターゲット情報をプレートレイアウトにインポートします。 
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解析用のスタンドアローンデータの転送 
 

ランが完了すると、CFX Maestro は蛍光データを解析します。ランをスタンドアローンモードで実行

し、機器自体に保存する場合、データを解析用の CFX Maestroコンピュータに転送する必要がありま

す。 

 

C1000 Touchサーマルサイクラーでは、最大 100のリアルタイム PCRランを格納できます。ランの完

了後、スタンドアローンデータファイルをサーマルサイクラーから E メール、USB ドライブ、あるい

はソフトウェア自体を通じて CFX Maestro コンピュータに転送できます。 

 

本節では、CFX Maestro コンピュータへのスタンドアローンデータファイルの転送方法について説明

します。 

 

CFX Maestroソフトウェアを介した転送 
 

重要：CFX Maestro を通じてデータファイルを転送する場合、サーマルサイクラー部に保存されてい

るすべてのファイルが転送されます。データを安全に転送するため、ディスク容量が十分にあることを

確認してください。 

 

CFX Maestroを介してデータを転送する方法 

 

1. Home ウィンドウの Detected Instruments ペインで、ターゲット機器を右クリックして Retrieve 

Data Filesを選択します。 

 

Browse For Folderダイアログボックスが表示されます。 

 

2. Browse For Folderダイアログボックスで、データファイルを保存したい場所にブラウズして OK

をクリックします。 

 

転送プロセスにより、選択した場所に Real-Time Dataというラベルのついたフォルダが作成され

ます。ランデータが別個の.zpcrファイルとして Real-Time Dataフォルダに保存されます。 

 

Ｅメールを介した転送 
 

ランの最後にデータファイルをＥメール送信する方法 

 

1. C1000 TouchサーマルサイクラーでＥメール通知を設定します。 

 

46ページの「Ｅメール通知の設定」または C1000 Touchサーマルサイクラーおよび CFXリアル

タイム PCR検出システムの機器ガイドを参照してください。 

 

2. Ｅメール通知の設定時に、必ず Attach Data Fileを選択してください。 

 

ランデータが.pcrdファイルとしてＥメール送信されます。 

 

USBドライブを使用したデータ転送 
 

アドバイス：USBドライブを C1000 Touchサーマルサイクラーの USBポートに挿入すると、ラン完

了時に、データファイルが USBドライブのルートディレクトリに自動保存されます。 
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また、サーマルサイクラーに以前保存されたデータファイルを見つけて、取り付けられた USB ドライ

ブに保存することもできます。 

 

デーファイルの検索と USBドライブへの保存方法 

 

1. C1000 Touchの Home画面で、Saved Filesをタッチしてファイルフォルダにアクセスします。 

 

2. Locationカラムで、Real-Time Dataをタッチします。 

 

3. Fileカラムで、エクスポートするファイルを選択します。 

 

選択したファイルに関する情報が、Previewペインに表示されます。 

 

4. ファイルをエクスポートするには、File Optionsにタッチします。 

 

5. OKにタッチして、取り付けられている USBドライブにファイルを保存します。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ランデータは.zpcrファイルとして USBドライブに保存されます。 

 

データファイルの作成 
 

機器から CFX Maestro コンピュータに転送されるデータを解析するため、圧縮データファイル（.zpcr

ファイル）をデータファイル（.pcrdファイル）に変換する必要があります。CFX Maestroでは、.zpcr

ファイルから.pcrd ファイルへの変換を行った後、スキャンモードとプレートサイズが同じであるプレ

ートファイルを選択し、それを.pcrdファイルに適用します。 

 

スタンドアローンデータファイルからデータファイルを作成する方法 

 

1. CFX Maestro で、以下のいずれかを行います。 

 

 ターゲットの.zpcrファイルを見つけて CFX Maestroの Homeウィンドウにドラッグする。 

 

 File > Open > Stand-alone Runを選択し、ターゲットファイルにナビゲートしてそれを選択

する。 

 

CFX Maestro には、Save Asダイアログボックスが表示されます。 

 

2. .pcrdファイルを保存するフォルダにナビゲートして、Saveをクリックします。 

 

.pcrdファイルの保存後、Data Analysisウィンドウが開き、結果のデータがそこに表示されます。 
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第８章 データ解析について 
 

CFX Maestro ソフトウェアは、各ランの最後にリアルタイム PCR データを自動的に処理し、Data 

Analysisウィンドウを開いてデータ（.pcrdファイル）を表示します。 

 

CFX Maestro ソフトウェアでは、データファイルを開いて表示するためのいくつかの方法を提供しま

す。 

 

 データファイル（拡張子は.pcrd）を Homeウィンドウにドラッグしてそこでリリースする。 

 

 Homeウィンドウの File > Open > Data Fileを選択し、ターゲットの.pcrdファイルにブラウズす

る。 

 

 Homeウィンドウの File > Recent Data Filesを選択し、最近開いた 10個のデータファイルのリ

ストから選択する。 

 

 Startup Wizardの Analyzeタブを選択し、Recent Filesから選ぶか Browse をクリックしてデータ

ファイルを見つける。 

 

Data Analysisウィンドウ 
 

Data Analysis ウィンドウには複数のタブが表示され、各タブは特定の解析手法のための解析データま

たはラン固有の情報を表示します。タブは、ランで収集されたデータがその解析のタイプで使用できる

場合にのみ表示されます。 

 
 
 
 

アドバイス：表示するタブを選択するには、Data Analysisウィンドウの Viewメニューから選択します。

元のタブのレイアウトに戻るには、Settings > Restore Default Window Layout を選択してください。 
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Data Analysis ツールバー 
 

Data Analysisウィンドウのツールバーは、重要なデータ解析機能への迅速なアクセスを提供します。 

 
 
 
 

表８は、ツールバーにある各ボタンの機能を記載します。 

 

表８ Data Analysis ウィンドウのツールバー 

ツールバーボタン 名称 機能内容 

 
Plate Setup View/Edit plate：ウェルの内容を閲覧、編集するため

Plate Editorを開きます。 

Replace Plate file：プレートレイアウトを入れ替える

ためのプレートファイルを選択します。 

Apply PrimePCR file：PrimePCR
TM
ランのためのプレ

ートレイアウトに入れ替えるためのランファイルを選

択します。 

 

Manage Well Groups Well Groups Managerウィンドウを開きます。ここで

は、ウェルグループの作成、編集、および削除を行え

ます。 

 

Well Group ドロップダウンメニューから既存のウェルグループ名

を選択します。デフォルトの選択は、All Wellsです。

このボタンは、ウェルグループが作成されている場合

にのみ表示されます。 

 
Analysis Mode Fluorophore モードまたは Target モードのいずれかで

データを解析します。 

 Help データ解析に関する詳細について、ソフトウェアヘル

プを開きます。 

 

Data Analysis メニューバー 
 

表９は、Data Analysisウィンドウのメニューバーの項目を記載します。 

 

表９ Data Analysis ウィンドウのメニューバーの項目 

メニュー項目 コマンド機能 機能内容 

File Save ファイルを保存します。 

 Save As 現在のプロトコールを別名で保存します。 

 Repeat Run 現在のランからプロトコールとプレートファ

イルを抽出し、繰り返しランを実行します。 

 Close Data Analysisウィンドウを閉じます。 
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表９ Data Analysisウィンドウのメニューバーの項目（つづき） 

メニュー項目 コマンド機能 機能内容 

View Run Log Run Logウィンドウを開いて現在のデータファ

イルのランの記録を表示します。 

 Quantification, Melt Curve, 
Gene Expression, End Point, 
Allelic Discrimination, Custom 
Data View, QC, Run 
Information 

Data Analysis ウィンドウで選択しているタブ

の解析データを表示します。少なくとも１つ以

上のタブを選択するものとします。 

Settings Cq Determination Mode 各曲線で計算されるCq値の算出法、Regression

または Single Thresholdを選択します。 

 Baseline Setting 選 択 し た ウ ェ ル グ ル ー プ の Baseline 

Substraction法を選択します。 

 Analysis Mode データ解析のため、Fluorophore または Target

を選択します。 

 Cycles to Analyze 解析するサイクルを選択します。 

 Baseline Thresholds Baseline Thresholdsウィンドウを開き、ベース

ラインまたは閾値を調整します。 

 Trace Styles Trace Stylesウィンドウを開きます。 

 Plate Setup プレートの閲覧、編集するための Plate Editor

を開きます。現在のプレートをユーザー設定の

プレートファイルまたは PrimePCR ランファ

イルにプレートを入れ替えます。 

 Include All Excluded Wells 除外されているウェルを解析に含めます。 

 Mouse Highlighting マウスポインターでデータの同時的に強調表

示のオン・オフを行います。 

 

アドバイス：Mouse Highlightingがオフの場合、

Control キーを押すと強調表示が一時的にオン

になります。 

 Restore Default Window 
Layout 

ウィンドウの配置をデフォルトの設定に戻し

ます。 

Export Export All Data Sheets to Excel タブ毎に全てのスプレッドシート表示を別の

Excelファイルにエクスポートします。 

 Export RDM File RDML のバージョン（1.1または 1.0）を選択し

て Save Asウィンドウを開き、RDML ファイル

名とロケーションを指定します。 

 Custom Export エクスポートするフィールドとファイルフォ

ーマットを指定できるCustom Exportウィンド

ウを開きます。 

 Export to LIMS Folder 前もって決めていたフォーマットで LIMS フォ

ルダにデータを保存するためのウィンドウを

開きます。 
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表９ Data Analysisウィンドウのメニューバー項目（つづき） 

メニュー項目 コマンド 機能内容 

Tools Reports このデータファイルに関するレポートを開き

ます。 

 Well Group Reports 特定のウェルグループについてのレポートを

作成するためのWell Group Reportウィンドウ

を開きます。 

 Import Fluorophore Calibration 現在のデータファイルに適用するキャリブレ

ーションファイルを選択します。 

 qbase+ インストールされている場合には、現在の.pcrd

ファイルから直接 qbase+ v2.5 を立ち上げま

す。 

 

タブの詳細 
 

Data Analysis ウィンドウの各タブは、特定の解析手法によるグラフおよびスプレッドシートでデータ

を表示し、表示したいデータを選択するためのウェルセレクターを含んでいます。Data Analysis が開

くと、デフォルトで Quantification タブが表示されます。Quantification タブの Amplification グラフの

データを使用して、ランに適した解析設定を決定することができます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

注意：ソフトウェアは、Data Analysisの各タブのペインにあるデータをリンクします。例えば、ウェ

ルセレクター内のウェル上にマウスポインターを配置してウェルを強調表示すると、他のすべてのペイ

ンのデータが強調表示されます。 
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Step Number（ステップ番号）セレクター 
 

CFX96 Touch、CFX96 Touch Deep Well、CFX Connectおよび CFX384 Touchの各システムは、複数

のプロトコールステップで蛍光データを取得できます。ソフトウェアは各ステップで得られるデータを

個別に維持します。Step Numberセレクターは、Quantificationタブの Standard Curveグラフの下に表

示されます。プロトコールに少なくとも１つデータ収集ステップが含まれる場合、CFX Maestro ソフ

トウェアは最初の収集ステップからのデータを表示します。プロトコールが２つ以上の収集ステップを

含む場合、例えば下記のように、ドロップダウンリストから別のステップを選択できます。 

 
 
 

ステップを選択すると、その選択肢が Data Analysisウィンドウに表示されるすべてのデータに適用さ

れます。 

 

Data Analysis ウィンドウでのウェルグループの表示 
 

プレート内のウェルは、ウェルグループを使用する独立した解析用にサブセットへとグループ分けされ

ます。ウェルグループを作成すると、そのグループ名が Data Analysisウィンドウにあるツールバーの

Well Groupsドロップダウンリストに表示されます。 

 

ウェルグループを作成すると、Data Analysis ウィンドウを開いたときにデフォルトのウェルグループ

の All Wells が表示され、グラフとスプレッドシートに示される内容を含むすべてのウェルのデータが

表示されます。該当するウェルグループ内のウェルのみが、ウェルセレクターの内容を含んでロードさ

れ、そのウェルのデータのみがデータ解析計算に使用されます。 

 

アドバイス：ウェルグループの作成、編集、および削除を行うには、ツールバーの Manage Well Groups

をクリックしてください。 

 

注意：ウェルグループを作成していない場合には、Well Groupsドロップダウンリストはツールバーに

表示されません。 

 

ラン実行後のウェル内容の変更 
 

データ解析中に、Plate Editor内のウェルの内容を変更することによりデータの表示方法を変更しても、

ラン実行中に各ウェルから収取された蛍光データが変更されることはありません。モジュールによる蛍

光データの収集後、これらのデータを削除することはできませんが、画面表示と解析からデータを削除

することは可能です。 

 

ラン実行後にウェルの内容を変更する方法 

 

 Data Analysisウィンドウの Plate Setupをクリックし、以下のオプションから１つ選びます。 

 

 Edit/View Plate（プレートの編集／表示） ― 手動によるレイアウト変更を行うための Plate 

Editorを開きます。 

 

 Replace Plate file（プレートファイルの入れ替え） ― Select Plateブラウザを開き、ここで、

現在のプレートレイアウトと入れ替える以前に保存したプレートファイルにナビゲートしま

す。 
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 Apply PrimePCR file（PrimePCRファイルの適用） ― Select PrimePCR fileダイアログボ

ックスを開き、ここで PrimePCR ランファイルにナビゲートしてそれをプレートレイアウト

に適用します。 

 

アドバイス：ランの前、ラン実行中、または PCRのラン完了後に、ウェルの内容に関する情報を追加

または編集することができます。ランの前にスキャンモードとプレートサイズを割り当てる必要があり

ます。ランの実行後にこれらのパラメータを変更することはできません。 

 

データ解析設定 
 

Quantificationタブの Amplificationグラフのデータは、サイクル毎の各ウェルでの相対蛍光強度（RFU）

を示します。グラフ内の各トレースは、１つのウェルでの単一蛍光色素から得たデータを示します。こ

のようなデータを用いて、１種類の蛍光色素ベースでの各ウェルの Cq値が計算されます。ソフトウェ

アでは、Cq値の算定に以下の２つのモードの一方を使用します。 

 

 Regression（回帰法） ― 各ウェルのトレースに多変数非線形回帰モデルを適用し、このモデル

から最適な Cq値を計算します。 

 

 Single Threshold（単一閾値） ― 単一閾値を用い、各ウェルの蛍光強度トレースの交差閾値ポ

イントに基づいて Cq値を計算します。 

 

Cq値算定モードを選択するには、Settings > Cq Determination Mode を選びます。 

 

閾値の調整 
 

Single Thresholdモードでは、Amplificationグラフの閾値線をクリックし、マウスポインターを上下に

移動させることで、蛍光色素の閾値を調整できます。代替的に、選択している蛍光色素の正確な交差閾

値を指定することもできます。 

 

ベースラインの設定 
 

ソフトウェアにより、ウェル別にベースラインが自動設定されます。ベースライン設定では、すべての

蛍光強度トレースのベースライン補正方法を決定します。ソフトウェアにより以下の３つのベースライ

ン補正オプションが提供されます。 

 

 No Baseline Subtraction（ベースライン補正なし） ― 相対蛍光強度トレースとしてデータを表

示します。この解析モードでは一部の解析を行うことができません。そのため、Gene Expression

タブ、End Pointタブ、Allelic Discriminationタブは表示されません。 

 

 Baseline Subtraction（ベースライン補正あり） ― ウェルの各蛍光色素のベースライン補正さ

れたトレースとしてデータを表示します。ソフトウェアは、定量化サイクルの決定、検量線の作

成、濃度不明サンプルの濃度測定を行うために、データをベースライン補正する必要があります。

ベースライン補正トレースを作成するため、ベースラインサイクル中に記録された各ウェルの蛍

光強度を通して最良の直線が適用されます。その後、各サイクルで背景補正データから最適デー

タが差し引かれます。 

 

 Baseline Subtracted Curve Fit（ベースライン補正曲線フィット） ― ベースライン補正トレー

スとしてデータを表示するほか、中心化平均フィルター用いたベースライン補正曲線がスムーズ

化します。このプロセスにより、Cq値はそれぞれ不変値となります。 
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これらのオプションに加え、Apply Fluorescent Drift Correction（蛍光ドリフト補正適用）も選択できま

す。ランの初期の数サイクル中に RFU値が異常にドリフトしているウェルに対して、ソフトウェアは、

水平ベースラインが無事に生成されている近接するウェルから、予想されるベースラインを引き出しま

す。 

 

ベースライン補正設定の変更方法 

 

 Settings > Baseline Settingを選択します。 

 

解析モード 
 

データは、蛍光色素またはターゲット名でグループ化され解析されます。蛍光色素でグループ分けされ

ると、データトレースはそのラン用のプレート設定に示されるように、蛍光色素で表示されます。増幅

グラフの下にある該当する蛍光色素セレクターチェックボックスを選択すると、個々の蛍光色素データ

が増幅および検量線グラフ（可能な場合）に表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ターゲットごとにグループ分けされると、データトレースはそのラン用のプレート設定で入力されるタ

ーゲット名で表示されます。 
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データ解析モードの選択方法 

 

 以下のいずれかを行います。 

 

 Settings > Analysis Mode を選択する。 

 

 ツールバーの Analysis Modeドロップダウンメニューからモードを選択する。 

 

解析するサイクル数 
 

解析するサイクル数を制限することができます。また、特定のサイクルセットからのデータを解析する

ことも可能です。解析できる最大サイクル数は 50です。 

 

注意：ランの開始時からサイクルを削除すると、ベースラインに顕著な影響を与えることがあります。 
 

特定のサイクルレンジにデータ解析を制限する方法 

 

1. Settings > Cycles to Analyze を選択します。 

 

Cycles to Analyze ダイアログボックスが表示されます。 

 

2. 開始サイクル値と終了サイクル値を入力して、OKをクリックします。 

 

Cycles to Analyzeダイアログボックスの Restore Defaultsをクリックすると、解析に使用していた元

のサイクルに戻ります。 
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ウェルセレクター 
 

ウェルセレクターを使用して、Data Analysis ウィンドウに表示されるグラフまたはスプレッドシート

のウェルデータの表示または非表示することができます。サンプルがロードされているウェルのみ、ウ

ェルセレクターで選択できます。ソフトウェアは、ウェルセレクター内のウェルを色付けします。 

 

 青色 ― 選択しているウェルを示します。選択しているウェルのデータは Data Analysisウィンド

ウに表示されます。 

 

 薄いグレー色 ― 選択していないウェルを示します。選択していないウェルのデータは Data 

Analysisウィンドウに表示されません。 

 

 濃いグレー色 ― 空のウェルを示します。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ウェルデータの表示・非表示 

 

 ウェルセレクターで以下のいずれかを行います。 

 

 １つのウェルを非表示にする場合、そのウェルのみをクリックする。このウェルを表示する

には、再度クリックする。 

 

 複数のウェルを非表示にする場合、選択したいウェル群をドラッグする。このウェル群を表

示するには、再度ドラッグする。 

 

 すべてのウェルを非表示にするには、プレートの左上隅をクリックする。再度左上隅をクリ

ックすると、すべてのウェルが表示される。 

 

 ウェル列またはウェル行を非表示にする場合は、列または行の最初の部分をクリックする。

表示するには、同部位を再度クリックする。 
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ウェルセレクターの右クリックメニュー項目 
 

ウェルセレクター画面のウェルを右クリックすると、表 10に記載される項目を選択できます。 

 

表10 ウェルセレクターの右クリックメニュー項目 

項目 機能内容 

Well XX このウェルだけを表示、このウェルを表示から削除、このウェ

ルの色を設定、または解析からこのウェルを除外 

Selected Wells（右クリック＆ドラッ

グ） 

これらのウェルだけを表示、これらのウェルを表示から削除、

これらのウェルの色を設定、または解析からこれらのウェルを

除外 

Copy クリップボードに、サンプルタイプや任意の複製番号を含むウ

ェルの内容情報をコピーする。 

Copy as Image ウェルセレクター表示を画像としてコピーする。 

Print ウェルセレクター表示を印刷する。 

Print Selection 現在の選択を印刷する。 

Export to Excel Excelスプレッドシートにデータをエクスポートする。 

Export to Csv .csv文書としてデータをエクスポートする。 

Export to Xml .xml 文書としてデータをエクスポートする。 

Well labels ウェルのラベルをサンプルタイプ、ターゲット名、またはサン

プル名に変更する。 

 

解析からの一時的なウェルの除外 
 

データ解析から一時的にウェルを除外する方法 

 

1. 蛍光データのトレース上、または検量線上にプロットされたポイント上で、ウェルセレクターに

表示されるウェルを右クリックします。複数のウェルを除外する場合には、右クリック＆ドラッ

グで複数のウェル、トレース、ポイントを強調表示します。 

 

2. 右クリックメニューから、該当するオプションを選択します。 

 
 Well > Exclude Well 

 
 Selected Wells > Exclude from Analysis 

 
 Selected Traces > Exclude these wells from Analysis 
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代替法として、解析から永久にウェルを削除するには、Clear Wells ボタンをクリックして

Plate Editor内のウェルから内容を消去してください。 

 

重要：消去されたウェル内容は、再入力する必要があります。 

 

除外ウェルを含める方法 

 

 ウェルセレクターの該当するウェルを右クリックし、Well > Include Well in Analysis を選択しま

す。 

 

グラフ 
 

Data Analysis ウィンドウの各グラフには、各種グラフのデータが表示され、これにはデータ補正用の

オプションが含まれます。 

 

グラフのツール 
 

グラフのツールは、Data Analysis ウィンドウの各グラフに表示されます。すべてのグラフには、以下

のツールが表示されます。 

 

Copy to Clipboard（クリップボードにコピー）― グラフ表示の内容をクリップボードにコピーしま

す。 

 

Chart Settings（グラフ設定） ― Chart Settingsダイアログボックスが開き、ここで以下のグラフ表

示オプションを修正できます。 

 

 グラフと軸のタイトル 

 

 グラフと軸のフォントとサイズ 

 

 軸の目盛り 

 

 説明の位置 

 

Export（エクスポート） ― Export Optionsダイアログボックスが開き、ここでグラフの解像度とサイ

ズを修正して以下のファイルタイプのいずれかとして指定の場所に保存できます。 

 
 .bmp 

 
 .gif 

 
 .jpg 

 
 .png 

 
 .tif 

 

棒グラフのツール 

 

グラフのツールに加え、棒グラフでは以下のツールが表示されます。 

 

Sort（ソート） ― ターゲットとサンプルをアルファベット順または逆アルファベット順に並べ替えま

す。 

 

Color Settings（色設定） ― Color Settingsダイアログボックスが開き、ここでターゲットとサンプ

ルの色を変更できます。 

 

これらのツールの詳細については、194ページの「グラフ表示の変更および注釈」を参照してください。 
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増幅グラフのツール 

 

前記のツールに加え、増幅グラフでは以下のツールが表示されます。 

 

Trace Styles（トレーススタイル） ― Trace Stylesダイアログボックスが開き、ここで増幅グラフの

トレースの外観を修正できます。 

 

Baseline Threshold（ベースライン閾値） ― Baseline Thresholdダイアログボックスが開き、ここで

選択しているウェルのデフォルトのベースラインの修正や、増幅グラフ内の各蛍光曲線の閾値の変更が

可能です。 

 

クリップボードへのグラフデータのコピー 

 

グラフ表示の内容をコピーし、ビットマップ画像ファイルを受け入れるアプリケーションにペーストす

ることができます。 

 

クリップボードにグラフデータをコピーする方法 

 

1. グラフのツールから、Copy to Clipboardを選択します。 

 

2. ビットマップ画像を受け入れるアプリケーション（例えば Microsoft Word）を開きます。 

 

3. 右クリックして Paste を選択して、ビットマップ画像をクリップボードからアプリケーションに

ペーストします。 

 

グラフ表示設定の変更 

 

Chart Settingsダイアログボックスを使用して、表示されるグラフのタイトル、フォントとサイズ、軸

の目盛り、および説明の場所を変更します。変更は表示されるグラフにのみ適用され、グラフと共に保

存されます。 

 

グラフ表示設定の変更方法 

 

1. グラフのツールから、Chart Settingsをクリックします。 

 

Chart Settingsダイアログボックスが表示されます。 
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2. Chart And Axesタブを選択して以下を行います。 

 

 グラフのタイトルを入力する。 

 

 x軸の新しいタイトルを入力し、ラベルの角度を決める。 

 

 y軸の新しいタイトルを入力する。 

 

3. Fontsタブを選択してグラフのフォントとフォントサイズを変更します。 

 

アドバイス：デフォルトでは、フォントサイズはグラフサイズの変更と共にオートスケールでサ

イズが変わります。ラベルタイプ毎に固定のフォントサイズを設定するには、Change Font Size

を選択してください。 

 

4. Axes Scaleタブを選択して以下を行います。 

 

 x軸と y軸のオートスケールを解除し、最小目盛りと最大目盛りを指定する。 

 

 グラフにグリッドラインまたは目盛マークを表示する。 

 

5. Legendタブを選択して以下を行います。 

 

 グラフの説明を非表示にします。 

 

 グラフの説明のデフォルト位置を変更します。 

 

注意：説明がグラフの左側または右側に配置されると、グラフには最初の 10個の蛍光色素のみが

表示されます。 

 

6. いつでも Applyをクリックすれば、変更を保存せずにグラフ設定の変更を見ることができます。 

 

7. OKをクリックして変更を保存し、グラフに戻ります。 

 

グラフのエクスポート 

 

このダイアログボックスを使用して、以下のファイルフォーマットのいずれかでエクスポートするため

にグラフの幅、高さおよび解像度を修正します。 

 
 .bmp 

 
 .gif 

 
 .jpg 

 
 .png 

 
 .tif 
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エクスポートしたグラフは、結果をポスターセッション、Microsoft PowerPointのプレゼンテーション、

およびジャーナルへの掲載用に使用することができます。 

 

注意：設定を修正する際には、以下を考慮してください。 

 

 最大幅と最小幅および高さ制限 

 

 72 dpiの場合：0.1～83 in 

 

 96 dpiの場合：0.1～62 in 

 

 150 dpiの場合：0.1～40 in 

 

 300 dpiの場合：0.1～20 in 

 

 600 dpiの場合：0.1～10 in 

 

 すべての解像度：2～6,000画素 

 

 アスペクト比は幅を基準とする。 

 

グラフのエクスポート方法 

 

1. グラフのツールから、Export をクリックします。 

Export Previewダイアログボックスが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

2. 必要に応じて、ディスプレイの設定を修正します。 

 

3. Export をクリックします。 
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4. Export ダイアログボックスで、以下を行います。 

 

a. （オプション）グラフのファイルの保存先フォルダにナビゲートする。 

 

b. ファイルの名称を入力し、ドロップダウンリストからファイルのタイプを選択する。 

 

5. Save をクリックしてグラフのファイルを保存します。 

 

ベースライン閾値設定の修正 

 

Single Threshold（単一閾値）モードでは、増幅グラフの閾値線をクリックしてマウスポインターを上

下に移動させて蛍光色素の閾値を調整できます。代替的に、選択している蛍光色素の正確な交差閾値を

指定することも可能です。 

 

アドバイス：サイクルレンジを指定して、User > User Preferences 内の Data Analysisタブにあるすべ

てのデータファイルについてベースラインを決定することができます。 

 

各ウェルの開始および終了ベースラインサイクルの調整方法 

 

1. Quantificationタブで、増幅グラフ下の単一蛍光色素を選択します。 

 

2. グラフツールから、Baseline Thresholdを選択します。 

 

Baseline Thresholdダイアログボックスが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Baseline Cyclesセクションで、以下を行います。 

 

 ウェルを１つ選び、その行番号をクリックする。 

 

 複数の隣接するウェルを選び、最初のウェルの行番号をクリックしたまま最後のウェルのカ

ラムまでドラッグする。 
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 複数の隣り合っていないウェルを選択するには、Ctrlキーを押したまま各ターゲットウェルの

行番号をクリックする。 

 

 すべてのウェルを選択するには、表の左上隅をクリックする。 

 

4. 選択しているすべてのウェルに対してBaseline BeginサイクルとBaseline Endサイクルを調整す

るか、スプレッドシートの下部にある Beginと Endのサイクル数を変更します。 

 

アドバイス：設定を最後に保存した値に戻すには、Reset All User Defined Valuesをクリックし

てください。 

 

5. OKをクリックして変更を保存し、グラフに戻ります。 

 

すべてのデータファイルに関するサイクルレンジを指定する方法 

 

 Home ウィンドウまたは Plate Editor ウィンドウの User > User Preferences を選択し、Data 

Analysisタブを選びます。 

 

ターゲットとサンプルのデータの並べ替え 

 

注意：このオプションは、遺伝子発現グラフでのみ使用できます。 

 

デフォルトでは、Targets リストと Samples リストがアルファベット順に表示されます。Sort ダイア

ログボックスを使用すると、この表示を逆アルファベット順に並べ替え、または１つの項目をリスト内

の別の位置に手動で移動することができます。 

 

ターゲットとサンプルのデータの並べ替え方法 

 

1. グラフツールから Sortをクリックします。 

 

Gene Expression Chart Sorting ダイアログボックスが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. ダイアログボックスで Z-Aをクリックすると、リストが逆アルファベット順に並べ替えられます。 
 

3. １つの項目を手動で移動するには、その項目を選択してグラフ間の該当するボタンをクリックし

ます。 

 

 上矢印または下矢印をクリックすると、選択した項目が１つ分移動する。 

 

 バー付き上矢印またはバー付き下矢印をクリックすると、選択した項目がリストの最上部ま

たは最下部に移動する。 

 

4. OKをクリックして変更を保存し、Gene Expressionタブに戻ります。 
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ターゲットとサンプルの色設定の変更 

 

注意：このオプションは遺伝子発現グラフでのみ使用できます。 

 

Color Settingsダイアログボックスを使用して、ターゲットまたはサンプルの色を変更し、または項目

をグラフから削除します。 

 

色設定の変更方法 

 

1. グラフツールから、Color Settingsを選択します。 

 

Color Settingsダイアログボックスが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. ターゲットまたはサンプルの表示色を変更するには、Colorカラムの該当色をクリックします。 

 

3. 表示される Colorダイアログボックスで、新しい色を選択して OKをクリックします。 

 

4. 項目を遺伝子発現グラフから削除するには、Show Chartカラムの該当するチェックボックスを解

除します。 

 

アドバイス：すべての項目を遺伝子発現グラフから解除するには、カラムの見出しの Show Chart

チェックボックスを解除します。 

 

5. （オプション）デフォルトでは棒グラフの色がグラデーション状に表示されます。固定色で色を

表示するには、Use Solid Colorsを選択します。 

 

6. OKをクリックして変更を保存し、Gene Expressionタブに戻ります。 

 

グラフを拡大 
 

グラフを拡大する方法 

 

 グラフ全体をクリック＆ドラッグします。ソフトウェアがグラフのサイズを変更し、選択してい

る領域の中心に配置します。 

 

グラフを全画面表示にリセットする方法 

 

 グラフを右クリックし、Set Scale to Defaultを選択します。 
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Microsoftファイルへのグラフのコピー 
 

データグラフを Microsoft Word、Excel、または PowerPoint文書へコピーすることができます。画像の

解像度は、画像を得た画面の解像度に対応します。 

 

Microsoftファイルへのグラフのコピー方法 

 

1. Data Analysisウィンドウで、グラフのペインの右上隅にある Copy To Clipboardをクリックしま

す。 

2. 空の Microsoftファイルを開き、クリップボードから内容をペーストします。 

 

グラフの共通右クリックメニュー項目 
 

表 11は、グラフで使用できる右クリックメニュー項目を記載しています。使用可能な項目のうちのい

くつかは、すべてのグラフに向けたものであり、これらの項目はデータの表示方法を変更するため、ま

たはグラフからデータを容易にエクスポートするために使用できます。 

 

表11 グラフの右クリックメニュー項目 

項目 機能 

Copy グラフをクリップボードにコピーします。 

Save Image As 画像を指定のサイズ、解像度、およびファイルタイプで保存します。使

用できる画像フォーマットは、PNG（デフォルト）、GIF、JPG、TIF

および BMPです。 

Page Setup 印刷用のプレビューとページ設定を選択します。 

Print グラフを印刷します。 

Set Scale to Default グラフの拡大後、デフォルト表示に戻します。 

Chart Options Chart Optionsウィンドウを開き、タイトルの変更、x軸および y軸の限

界値の選択、グリッドラインの表示、および軸の小目盛の表示を含む、

グラフの変更を行います。 

 

注意：特定のグラフに適用するメニュー項目については、第９章の「データ解析の詳細」で説明します。 
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スプレッドシート 
 

Data Analysis に示されるスプレッドシートには、データの並べ替えと転送のためのオプションが含ま

れます。以下のいずれかの方法でカラムを並べ替えます。 

 

 カラムを、選択している表の新しい場所へクリック＆ドラッグする。 

 

 カラムの見出しをクリックし、データを昇順または降順に並べ替える。 

 

Sortウィンドウで最大３カラムのデータを並べ替える方法 

 

1. スプレッドシートを右クリックして Sortを選択します。 

 

2. Sort ダイアログボックスで、並べ替える最初のカラムのタイトルを選択します。データを昇順ま

たは降順で並べ替えます。 

 

3. 並べ替える２番目または３番目のカラムを選択し、Ascendingまたは Descendingを選びます。 

 

4. OKをクリックしてデータを並べ替えるか、Cancelをクリックして並べ替えを中止します。 

 

マウスポインターをセルの上に置いて関連するグラフとウェルセレクターのデータを強調表示します。 

セルをクリックすると、その内容をコピーして別のソフトウェアプログラムにペーストすることができ

ます。 

 

スプレッドシートの共通右クリックメニュー項目 
 

表 12は、あらゆるスプレッドシート画面で使用できる右クリックメニュー項目を記載しています。 

 

表12 スプレッドシートの右クリックメニュー項目 

項目 機能 

Copy 選択しているウェルの内容をクリップボードにコピーした後、その内容

を Excelなどのスプレッドシートにペーストします。 

Copy as Image スプレッドシート表示を画像ファイルとしてコピーし、それをテキス

ト、画像、またはスプレッドシートファイルなど、画像ファイルを受け

入れるファイルにペーストします。 

Print 現在の表示を印刷します。 

Print Selection 現在の選択部分を印刷します。 

Export to Excel データを Excelのスプレッドシートにエクスポートします。 

Export to Text データをテキストファイルとしてエクスポートします。 

Export to Xml データを.xmlファイルとしてエクスポートします。 

Export to Html データを.htmlファイルとしてエクスポートします。 

Find テキストを検索します。 

Sort 最大３カラムのデータを並べ替えます。 

Select Columns スプレッドシートに表示されるカラムを選択します。 
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エクスポート 
 

CFX Maestro ソフトウェアでは、Export ドロップダウンメニューから以下の４つのエクスポート用オ

プションを提供します。 

 

 Export All Data Sheets to Excel（すべてのデータシートを Excelにエクスポート） 

 

 Export RDML Files（RDML ファイルのエクスポート） 

 

 Custom Export（カスタムエクスポート） 

 

 Export to LIMS（LIMSにエクスポート） 

 

Export All Data Sheets to Excel（すべてのデータシートを Excelにエクス

ポート） 
 

CFX Maestroソフトウェアのすべてのタブから、すべてのスプレッドシート表示を個々の Excelファイ

ルへエクスポートすることができます。 

 

すべてのデータシートを Excelにエクスポートする方法 

 

 Export > Export All Data Sheets to Excel を選択します。 

 

Export RDML Files（RDMLファイルのエクスポート） 
 

RDML は、定量的 PCR（qPCR）データを交換するための構造的かつ一般的なデータ規格です。デー

タ規格は、拡張マークアップ言語（.xml）フォーマットのテキストファイルです。RDMLデータ交換フ

ォーマットに関する追加情報については、国際 RDML コンソーシアムのウェブサイト（www.rdml.org）

を参照してください。 

 

注意：バージョン 2.3 以降の qbase+ソフトウェアをお使いの場合には、RDML ファイルをバージョン

1.1として保存してください。 

 

RDMLファイルのエクスポート方法 

 

1. Export > Export RDML Files を選択し、表示されるリストから RFML v1.1または RDML v1.0を選

択します。 

 

Save Asダイアログボックスが表示されます。 

 

2. Save Asダイアログボックスで、RDML ファイルの保存先ファイル名とその場所を指定します。 

 

3. OKをクリックしてエクスポートファイルを保存します。 

 

http://www.rdml.org/
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カスタムエクスポート 
 

カスタムエクスポートファイルの作成方法 

 

1. Export > Custom Exportを選択すると、Custom Export ダイアログボックスが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 表示されるドロップダウンリストからエクスポートのフォーマットを選択します。 

 

3. エクスポートする項目のチェックボックスを選択します。 

 

4. （オプション）Customize Column Namesをクリックしてカラム名を変更できます。 

 

5. Export をクリックします。 

 

Save Asダイアログボックスが表示されます。 

 

6. Save Asダイアログボックスで、エクスポートするファイルの保存先ファイル名とその場所を指

定します。 

 

7. OKをクリックしてエクスポートファイルを保存します。 

 

LIMSフォルダへのエクスポート 
 

データは、LIMS 対応のファイルフォーマットへエクスポートすることが可能です。LIMS ファイルの

作成、管理、および使用に関する詳細については、付録Ｃの「LIMS統合」を参照してください。 

 

LIMSフォーマットへのデータのエクスポート方法 

 

1. Export > Export to LIMS Folder を選択します。 

 

Save Asダイアログボックスが表示されます。 

 

2. Save Asダイアログボックスで、エクスポートするファイルを保存先ファイル名とその場所を指

定します。 

 

3. OKをクリックしてエクスポートファイルを保存します。 
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第９章 データ解析の詳細 
 

Data Analysis ウィンドウには、データを表示するための複数のタブが含まれます。本章では、９つの

タブについて詳述します。 

 

アドバイス：Viewメニューを使用して、Data Analysisウィンドウでどのタブを表示するかを選択でき

ます。カスタマイズしたレイアウトはデータファイルに保存されます。 
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Quantificationタブ 
 

Quantification タブのデータを使用して、個々のウェルのベースライン設定や閾値設定を含むデータ解

析条件を設定します。Quantificationタブには、以下の４画面にデータが表示されます。 

 

 Amplification（増幅）グラフ ― サイクルごとの各ウェルの相対蛍光強度（RFU）が表示されま

す。グラフ内の各トレースは、１つのウェルにおける単一蛍光色素のデータを示します。 

 

 Standard curve（検量線） ― ランが標準（Std）サンプルタイプとして指定されたウェルを含

む場合にのみ表示されます。検量線は、初期量の対数に対してプロットした閾値サイクルを表示

します。説明部分には、Stdサンプルタイプのウェルにおける各蛍光色素の反応効率（E）が表示

されます。 

 

 Well selector（ウェルセレクター） ― 表示したい蛍光データを含むウェルを選択します。 

 

 Spreadsheet（スプレッドシート） ― 選択したウェルで収集されたデータのスプレッドシート

を表示します。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

蛍光色素のオプション 
 

Quantification タブのグラフとスプレッドシートに蛍光色素データを表示するには、Amplification グラ

フの下のターゲット蛍光色素を選択します。データ解析ウィンドウの蛍光色素データを非表示にするに

は、そのチェックボックスを解除します。 
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トレーススタイル 
 

Trace Stylesダイアログボックスを使用すると、Quantificationタブと Melt Curveタブの増幅グラフと

融解曲線グラフ内のトレースの外観を調整できます。その後、Trace Stylesダイアログボックスに表示

されるウェルセレクターで変更点のプレビューが可能です。 

 

トレーススタイルの調整方法 

 

1. Amplificationグラフ下の蛍光色素を１つだけ選択します。 

 

2. Trace Stylesダイアログボックスを開き、以下のいずれかを行います。 

 

 Amplificationグラフの Trace Stylesをクリックする。 

 

 Data Analysisメニューバーの Settings > Trace Styles を選択する。 

 

 トレースを右クリックして Trace Stylesを選択する。 

 

Trace Stylesダイアログが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Trace Styles ダイアログボックス内の下部にあるペインのウェルセレクターで、特定のウェルの

セットを選択します。代替的に、Wells カラム内のドロップダウンメニューで１つのサンプルタ

イプを含むウェルを選択します。 

 

4. 以下のいずれかを行います。 

 

 選択しているウェルの色を選ぶ場合、Colorカラム内のボックスをクリックする。 

 

 選択しているウェルに記号を割り当てる場合、Symbolドロップダウンリストから記号を選択

する。 
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 ボタンラベルでウェルに素早く色付けする場合、該当するクイック設定をクリックする。 

 

□ Random by Well（ウェルごとにランダム） 

 

□ Random by Replicate（リプリケートごとにランダム） 

 

□ Use Fluor Colors（蛍光色素ごと） 

 

□ Use Target Colors（ターゲットごと） 

 

□ Use Sample Colors（サンプルごと） 

 

 ウェルにラベルを割り当てるには、Sample Type、Target Name、Sample Name、または

Symbolのいずれかを選択する。 

 

対数スケールのオプション 
 

Amplificationグラフ下の Log Scaleを選択して、片対数スケールで蛍光トレースを表示します。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

アドバイス：グラフのいずれかの領域を拡大する場合には、対象の領域をマウスでドラッグしてくださ

い。全画面表示に戻すには、グラフを右クリックして Set Scale to Defaultを選択してください。 
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検量線グラフ 
 

ソフトウェアでは、ランで１つの蛍光色素に対して Stdサンプルタイプがデータに含まれている場合に

は、Quantificationタブに Standard Curveグラフが作成されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Standard Curveグラフは、以下の情報を表示します。 

 

 各曲線の名称（蛍光色素またはターゲット） 

 

 各蛍光色素またはターゲットの色 

 

 反応効率（E）。この統計値を使用してマルチプレックスリアクションを最適化し、さらに検量線

のデータを均等化します。 

 

注意：反応効率は、ターゲットがプロトコール内の各サイクルでどれほど生成されるかを説明す

るものです。100 %効率の場合、各サイクルでターゲットが２倍になることを示します。 

 

 相関係数、R
2
（R^2 として記載）。この統計値を使用して、検量線がどの程度データとしての信

頼性を備えているかを判定します（直線性）。 

 

 Slope（勾配） 

 

 y-intercept（y切片） 
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Amplificationグラフのメニューオプション 
 

グラフのコピー、印刷、およびエクスポートのための共通の右クリックメニューオプションに加え、表

13は Amplificationグラフでのみ使用できるメニューオプションを記載します。 

 

表13 Amplificationグラフの右および左クリックメニュー項目 

メニューオプション 機能内容 

Well XX, Fluor Target このウェルのみを表示、表示からこのウェルを削除、このトレースの

色を設定、または解析からこのウェルを排除する。 

Selected Traces これらのウェルのみを表示、表示からこれらのウェルを削除、これら

のトレースの色を設定、または解析からこれらのウェルを排除する。 

Show Threshold Values グラフ上に各増幅曲線の閾値を表示する。 

Trace Styles Trace Stylesウィンドウを開き、Quantificationタブと Melt Curve タブ

に表示されるトレーススタイルを変更する。 

Baseline Thresholds Baseline Thresholdsウィンドウを開き、各蛍光色素のベースラインま

たは閾値を変更する（変更点は Quantification タブの Amplification グ

ラフに現れる）。 

 

Quantificationタブのスプレッドシート 
 

表 14は、Quantificationタブのスプレッドシートに表示されるデータを定義します。 

 

表14 Quantificationタブのスプレッドシートの内容 

情報 説明 

Well プレート内でのウェルの位置 

Fluor 検出された蛍光色素 

Target Plate Editorウェルに割り当てられた Target Name 

Content Plate Editorで割り当てられた Sample Type（必須）および Replicate #

（オプション）の組み合わせ 

Sample Plate Editorウェルに割り当てられた Sample Name 

Cq 各トレースの定量化（Quantification）サイクル 

 

Target、Contentまたは Sample Dataの変更 

 

Target、Content、および Sampleの各カラムのデータは、実験のランの後であっても Plate Editorを使

用してプレートファイルを編集することにより変更できます。 

 

Content、Targetおよび Sampleの各カラムのデータ変更方法 

 

 Plate Setupをクリックし、View/Edit Plateを選択して Plate Editorを開きます。 
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Quantification Dataタブ 
 

Quantification Dataタブには、各ウェルで収集した定量化データが表示されます。CFX Maestroソフト

ウェアは、以下の４つの異なるスプレッドシート画面にデータを表示します。 

 

 Results（結果） ― データのスプレッドシートを表示します。これはデフォルト画面です。 

 

 Standard Curve Results（検量線結果） ― 検量線データのスプレッドシートを表示します。 

 

 Plate（プレート） ― 各ウェルのデータをプレートマップとして表示します。 

 

 RFU（相対蛍光強度） ― サイクルごとの各ウェルの RFU定量値を表示します。 

 

Quantification Dataタブの下に表示されるドロップダウンリストから、それぞれのスプレッドシートを

選択します。 

 

Resultsスプレッドシート 
 

Resultsスプレッドシートには、プレート内の各ウェルのデータが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

注意：Plate Editorウィンドウのウェルに割り当てられたリプリケートグループに、すべての Std. Dev

（標準偏差）計算が適用されます。リプリケートグループの各ウェルに対する Cq値の平均値が得られ

ます。 

 

表 15に、Resultsスプレッドシートに表示されるデータを定義します。 

 

表15 Resultsスプレッドシートの内容 

情報 説明 

Well プレート内でのウェルの位置 

Fluor 検出された蛍光色素 

Target 増幅ターゲットの名称（遺伝子） 

Content サンプルタイプおよびリプリケート番号 

Sample サンプル内容 

Biological Set Name 生物学的セットの名称 

Cq 定量化サイクル 

Cq Mean リプリケートグループでの定量化サイクルの平均値 

Cq Std. Dev リプリケートグループでの定量化サイクルの標準偏差 
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表 15 Resultsスプレッドシートの内容（つづき） 

情報 説明 

Starting Quantity（SQ） ターゲットの予想初期量 

Log Starting Quantity 初期量の対数値 

SQ Mean 初期量の平均値 

SQ Std. Dev リプリケート全体の初期量の標準偏差 

Set Point リプリケート全体におけるグラジェントステップのウェルでのサンプ

ルの温度 

 

Standard Curve Results スプレッドシート 
 

Standard Curve Resultsスプレッドシートには、算出された検量線のパラメータが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

表 16に、Standard Curve Results スプレッドシートに表示されるデータを定義します。 

 

表16 Standard Curve Resultsスプレッドシートの内容 

情報 説明 

Fluor（または Target） 検出した蛍光色素（またはターゲット） 

Efficiency % 反応効率 

Slope 検量線の傾き 

Y-intercept 検量線が y軸と交差する点 

R^2 相関係数 
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Plateスプレッドシート 
 

Plate スプレッドシートには、１種類の蛍光色素に関するデータがプレートマップで一度に表示されま

す。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

特定の蛍光色素のデータを表示する方法 

 

 スプレッドシートの下部にあるタブをクリックします。 
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RFUスプレッドシート 
 

RFU スプレッドシートには、ランの各サイクルで取得した各ウェルの相対蛍光強度（RFU）の値が表

示されます。ウェル番号は、各列の一番上に表示され、サイクル番号は各行の左に表示されます。 
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Melt Curveタブ 
 

DNA結合する蛍光標識試薬および非結合ハイブリダイゼーションプローブに関しては、DNAが二本鎖

になるアニーリング時に最も強い蛍光発色が得られます。このため、融解温度（Tm）に向けて温度が

上昇すると、蛍光強度は一定の程度で減少します（一定の勾配）。Tm では、蛍光強度が大幅に低下す

るため、勾配は大幅に変化します。この変化の程度は、マイナスの蛍光強度導関数（-d(RFU)/dT）と温

度をプロットすることにより求められます。蛍光強度の最大変化は、グラフ上でピークとして見受けら

れ、二重鎖 DNA複合体の Tmを表します。 

 

ソフトウェアにより、融解曲線から収集した RFU データが温度の関数としてプロットされます。融解

曲線のピークデータを解析するために、ソフトウェア上で閾値ラインを上下させることにより、開始温

度と終了温度が割り当てられます。ピーク領域の底面ラインは、融解閾値ラインの位置によって特定さ

れます。ピークが有効となるには、少なくとも閾値ラインと最大ピーク地点間の距離に適合する高さに

しなければなりません。 

 

Melt Curve タブには、以下の４つの画面に増幅 PCR生成物の Tmが表示されます。 

 

 Melt Curve（融解曲線） ― 各ウェルの温度ごとの RFU として各蛍光色素のリアルタイムデー

タを表示します。 

 

 Melt Peak（融解曲線ピーク） ― 各ウェルの温度ごとの RFUデータのマイナス導関数を表示し

ます。 

 

 Well selector（ウェルセレクター） ― ウェルを選択することで、そのデータの表示・非表示が

可能です。 

 

 Peak spreadsheet（ピークスプレッドシート） ― 選択しているウェルで収集されたデータを表

示します。 

 

注意：このスプレッドシートには、各トレースにつき最大２カ所のピークが表示されます。さら

に多くのピークを表示したい場合には、Melt Curve Dataタブをクリックしてください。 
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Melt Curveデータの調整方法 

 

 以下のいずれかを行います。 

 

 Melt Peakグラフの閾値ラインをクリック＆ドラッグして、データ解析にピーク値を追加また

は削除します。 

 

 Peaks ドロップダウンメニューの Positive を選択して、融解曲線閾値ラインを上回るピーク

のスプレッドシートデータを表示します。または、Negative を選択して、融解曲線閾値ライ

ンを下回るピークのスプレッドシートデータを表示します。 

 

 Trace Stylesウィンドウを開き、Melt Curveおよび Melt Peakグラフのトレースの色を変更し

ます。 

 

 Step Number セレクターの数字を選択して、プロトコール内の別のステップにおける融解曲

線データを表示します。プロトコールが２つ以上の融解曲線ステップにプレートリードを含

む場合には、2つ以上のステップがリストに表示されます。 

 

 ウェルセレクター内のウェルを選択し、データのサブセットに集中します。 

 

 ウェルグループを選択して、プレート内のウェルのサブセットを表示・解析します。ツール

バーのWell Groupドロップダウンメニューの名称ごとに、ウェルグループを選択できます。 
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Melt Curve Dataタブ 
 

Melt Curve Dataタブは、各トレースのすべての融解曲線のピークを含む複数のスプレッドシートに、

Melt Curve タブからのデータを表示します。CFX Maestro ソフトウェアは、融解曲線データを表示す

るための以下の４つのスプレッドシートのオプションを提供します。 

 

 Melt Peaks（融解曲線ピーク） ― 各トレースに関するすべての融解曲線ピークを含むすべての

データを表示します。これはデフォルトの表示です。 

 

 Plate（プレート） ― データ画面とプレートの各ウェルの内容を表示します。 

 

 RFU（相対蛍光強度） ― 各ウェルについて各温度における RFU量を表示します。 

 

 -d(RFU)/dT ― 温度（T）の変化に伴う RFUのマイナスの変化率を表示します。これは、プレー

ト内の各ウェルに関する第一導関数プロットです。 

 

Melt Curve Dataタブ下に表示されるドロップダウンリストから、それぞれのスプレッドシートを選択

します。 

 

Melt Peaksスプレッドシート 
 

Melt Peaksスプレッドシートには、すべての融解曲線データが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 

表 17は、Melt Peaksスプレッドシートに表示されるデータを定義します。 

 

表17 Melt Peaksスプレッドシートの内容 

情報 説明 

Well プレート内のウェルの位置 

Fluor 検出した蛍光色素 

Content Plate Editorウィンドウに表示される Sample Type（サンプルタイ

プ） 

Target 増幅ターゲット（遺伝子） 

Sample Plate Editorウィンドウに表示される Sample Name（サンプル名） 

Melt Temperature 各生成物の融解温度。スプレッドシートには、各行につき 1 ピー

ク（最高点）として表示される。 

Peak Height 融解曲線のピークの高さ 

Begin Temperature ピーク開始時の温度 

End Temperature ピーク終了時の温度 
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Plateスプレッドシート 
 

Plateスプレッドシートには、融解曲線データがプレートフォーマットで表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

注意：ソフトウェアが判定するピークに調整するには、Melt Curveタブから Melt Peak グラフ内の閾

値ライン位置を調整してください。 

 

表 18は、Plateスプレッド―シートに表示されるデータを定義します。 

 

表18 Plateスプレッドシートの内容 

情報 説明 

Content Sample Type（必須）と Replicate #（オプション）の組み合わせ 

Sample サンプル名 

Peak 1 第一融解曲線ピーク（最高点） 

Peak 2 第二（より低い）融解曲線ピーク 
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RFUスプレッドシート 
 

RFU スプレッドシートには、融解曲線から得られた各サイクルにおける各ウェルの蛍光データが表示

されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 

表 19は、RFUスプレッドシートに表示されるデータを定義します。 

 

表19 RFUスプレッドシートの内容 

情報 説明 

Well number 
(A1, A2, A3, A4, A5…) 

取り込まれたウェルのプレート内での位置 

Temperature 増幅ターゲットの融解温度。各列に１つのウェルとしてプロットさ

れる。同一ウェル内の複数の生成物に関しては複数のウェルとして

プロットされる。 

 

-d(RFU)/dTスプレッドシート 
 

-d(RFU)/dTスプレッドシートには、温度（T）の変化に伴う RFUのマイナスの変化率が表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

表 20は、-d(RFU)/dTスプレッドシートに表示されるデータを定義します。 

 

表20 –d(RFU)/dTスプレッドシートの内容 

情報 説明 

Well number 
(A1, A2, A3, A4, A5) 

取り込まれたウェルのプレート内での位置 

Temperature –d(RFU)/dT 温度（T）の変化に伴う RFUのマイナス変化率 

 



第９章 | データ解析の詳細 

174 | CFX Maestro™ ソフトウェア 

End Pointタブ 
 

End Pointタブを開くと、サンプルウェルの最終相対蛍光強度（RFU）を解析します。ソフトウェアで

は、不明サンプルを含むウェルの RFU レベルを陰性対照のウェルの RFU レベルが比較され、不明サ

ンプルウェルが陽性または陰性として判定されます。陽性サンプルの RFU 値は、陰性対照 RFU 平均

値＋カットオフ値よりも高くなります。 

 

エンドポイントデータを解析するには、プレートには必ず陰性対照を含めてください。陰性対照が含ま

れなければ、ソフトウェアによってデータが判定されません。以下の２種類のプロトコールのいずれか

を行います。 

 

 Run a Quantification（定量化のラン）プロトコール ― 通常のプロトコールを設定します。ラン

の完了後、Data Analysis ウィンドウを開いて、Quantification タブでデータ解析設定を調整しま

す。その後、End Pointタブをクリックしてエンドポイントサイクルを選択します。 

 

 Run an End Point Only（エンドポイントのみのラン）プロトコール ― Run Setupウィンドウの

Plate タブで End Point Onlyプロトコールを設定後、プレートを選択・作成してランを開始しま

す。 

 

End Pointタブ画面には、最終（エンド）サイクルでターゲットが増幅されたかどうかを判定する平均

RFU 値が表示されます。これらのデータを使用して、サンプルに特異的なターゲット配列が存在して

いるか（陽性であるか）どうかを判定します。陽性の場合には、定義したカットオフレベルよりも RFU

値が高くなります。 

 

アドバイス：エンドポイントプロトコールを作成するには、Protocolタブ（Run Setupウィンドウ）を

開いて Run > End Point Only Runを選択します。 

 

ランが完了すると、データファイルが End Pointタブ画面に開きます。これには以下のセクションが含

まれます。 

 

 Settings（設定） ― データ解析設定を調整します。 

 

 Results（結果） ― 設定の調整直後に結果を表示します。 

 

 Well Selector（ウェルセレクター） ― 表示したいエンドポイントデータを含むウェルを選択し

ます。 

 

 RFU spreadsheet（RFU スプレッドシート） ― 選択しているウェルで収集されたエンド RFU

を表示します。 
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Results（結果）データ 
 

Resultsセクションには、以下のデータが表示されます。 

 

 Lowest RFU value（RFU最低値） ― データ内での RFU最低値 

 

 Highest RFU value（RFU最高値） ― データ内での RFU最高値 

 

 Negative Control Average（陰性対照平均） ― 陰性対照を含むウェルの RFU平均値 

 

 Cut Off Value（カットオフ値） ― 許容値（RFUまたは Settings（設定）に示される Percentage 

of Range（範囲率））と陰性対照平均値を加えて算定される。カットオフ値よりも大きい RFUを

含むサンプルは、「陽性」と判定されます。カットオフ値を調整するには、RFUまたは範囲率を

変更してください。 

 

カットオフ値の計算式は以下のとおりです。 

 

カットオフ値＝陰性対照平均値＋許容値 

 

許容値は、以下のいずれかの方法で選択します。 

 

 RFU（初期設定） ― RFU 絶対値を許容値に使用する場合には、この方法を選択します。最小

RFU許容値は 2です。最大値は、RFU最大値の絶対値－最小 RFU値の絶対値になります。初期

設定の RFU許容値は、RFU全範囲の 10 %となります。 

 

 Percent of Range ― RFU許容値範囲率を使用する場合には、この方法を選択します。最小範囲

率は 1 %です。最大範囲率は 99 %です。初期設定の範囲率は 10 %です。 

 

エンドポイントデータ解析の調整 
 

End Pointタブにおけるデータの調整方法 

 

 以下を行います。 

 ドロップダウンリストから蛍光色素を選択します。 

 

 End Cycle to Average値を選択して、エンドポイント RFU平均値を計算するサイクル数を設

定します。 

 

 RFUを選択して、相対蛍光強度データを表示します。 

 

 Percentage of Rangeを選択して、RFU範囲率としてデータを表示します。 

 

 ウェルセレクターのウェルを選択して、データのサブセットにまとめます。 

 

 ウェルグループを選択して、プレート内のウェルのサブセットの表示・解析を行います。ツ

ールバーのWell Groupドロップダウンメニューにある名称ごとに各ウェルグループを選択し

ます。 
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エンドポイント解析用の RFUスプレッドシート 
 

表 21は、End Pointタブ画面の RFUスプレッドシートに表示されるデータを定義します。 

 

表21 End Pointスプレッドシートの内容 

情報 説明 

Well プレート内のウェルの位置 

Fluor 検出した蛍光色素 

Content Sample Typeと Replicate #の組み合わせ 

End RFU エンドポイントサイクルでの RFU 

Call Positive（陽性）または Negative（陰性）の判定。サンプルが陽性である

場合は、その RFU値が陰性対照の RFU平均値＋カットオフ値を上回る。 

Sample Plate Editorに読み込まれるサンプル名 
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Allelic Discrimination（対立遺伝子識別）タブ 
 

Allelic Discrimination タブは未知のサンプルが入ったウェルに Genotype（遺伝子型）を割り当てます。

このデータをもとにアレル１、アレル２、ヘテロ接合体、無コール（増幅無し）、不明といった様々な

遺伝子型を有するサンプルを特定します。 

 

注意：対立遺伝子識別のためのデータは２つ以上の蛍光色素を用いたマルチプレックスランから得る必

要があります。それぞれの蛍光色素により全サンプルで１つの対立遺伝子が特定されます。 

 

対立遺伝子識別解析にあたっては最低でも以下に記すウェル内容が必要となります。 

 

 各ウェルに２つの蛍光色素 

 

 最適化データ解析のための NTC（No Template Control）サンプル 

 

CFX Maestro ソフトウェアでは４通りの方法で対立遺伝子識別データ見ることができます。 

 

 Allelic Discrimination（対立遺伝子識別）グラフ ― アレル１／アレル２の RFU のグラフでデ

ータを表示します。グラフの中の各点は１ウェル内の２蛍光色素からのデータを表します。Polar 

Coordinatesチェックボックスを選択／解除することでデカルト座標（直交座標）を極座標に切り

替えることができます。デカルト座標のｘ軸はアレル１の RFU を表し、ｙ軸はアレル２の RFU

を表します。極座標のｘ軸は角度を表し、ｙ軸は原点（全 NTC の中央値）からの RFU距離を表

します。 

 

 Well spreadsheet（ウェルスプレッドシート） ― プレートの各ウェルで収集された対立遺伝子

識別データを表示します。 

 

 Well selector（ウェルセレクター） ― 表示したい対立遺伝子データがあるウェルを選択します。 

 

 Selected Fluorophores（選択蛍光色素）パネル ―対立遺伝子識別グラフのｘ軸とｙ軸のラベル

を変えたり、解析サイクルを変えたり、コールマップを表示するかどうか指定します。 
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対立遺伝子識別データの調整 
 

ソフトウェアでは、NTCの位置と NTCから不明データポイントまでの距離と角度に基づき、不明サン

プルを含むウェルに遺伝子型が自動的に割り当てられます。 

 

対立遺伝子識別データの調整方法 

 

 以下を行います。 

 

 極座標を表示するには、対立遺伝子識別グラフのチェックボックスを選択します。 

 

 別の蛍光色素を表示するには、Selected Fluorophores パネルのドロップダウンリストから選

びます。 

 

 判定を変更するには、対立遺伝子識別グラフ内のデータポイントをドラッグして Selected 

Wellsリスト内のオプションを選択します。 

 

□ Allele 1（アレル１） 

 

□ Allele 2（アレル２） 

 

□ Heterozygote（ヘテロ接合体） 

 

□ Undetermined（不明） 

 

□ No Call（無コール） 

 

□ Auto Call（自動コール） 

 

アドバイス：デフォルトのコールに戻すには、Auto Callを選択してください。 
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グラフのメニューオプション 
 

グラフのコピー、印刷、およびエクスポートのための共通右クリックメニューオプションに加え、表

22は対立遺伝子識別グラフで使用できるメニューオプションを示しています。 

 

表22 対立遺伝子識別グラフの右クリックおよび左クリックメニューオプション 

メニューオプション 機能 

Zoom 2つ以上のデータポイントを選択した場合に選択領域を拡大する。 

Well このウェルのみを表示、画面からこのウェルを削除、このトレース

の色を設定、または単一トレースをクリックした場合に解析からこ

のウェルを除外する。 

Selected Wells これらのウェルのみを表示、画面からこれらのウェルを削除、これ

らのトレースの色を設定、または複数のトレースを選択した場合に

解析からこれらのウェルを除外する。 

 

Allelic Discrimination（対立遺伝子識別）スプレッドシート 
 

表 23は、Allelic Discriminationスプレッドシートに表示されるデータを定義します。 

 

表23 Allelic Discriminationスプレッドシートの内容 

情報 説明 

Well プレート内でのウェルの位置 

Sample サンプル名の説明 

Call 自動でのアレル 1、アレル 2、ヘテロ接合体、無コール、または不

明を含む対立遺伝子の識別 

Type Auto（自動）または Manual（手動）。判定方法について説明する。

Autoとは、ソフトウェアによって選択されたコール。Manualとは、

ユーザーによって選択されたコールを意味する。 

RFU1 アレル 1の RFU 

RFU2 アレル 2の RFU 
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Custom Data View タブ 
 

Custom Data Viewタブは、カスタマイズ可能なフォーマットで複数のペインを同時に表示します。 

 

Load a Preset Viewドロップダウンリストから、表示フォーマットのテンプレートを選択できます。表

示されるデフォルト画面は、解析されるファイルよって異なります。例えば、融解曲線データがある場

合、Amp+Meltデフォルト画面が表示されます。 

 

デフォルト画面のカスタマイズ方法 

 

 以下を行います。 

 

 ドロップダウンリストから代替のプリセット画面を選択する。 

 

 個々のペインの上にあるドロップダウンリストから別のグラフ表示を選択する。 

 

 タブの行数と列数を変更する。 

 

 個々のペインの寸法を変更する。各ペインの外周のバーをドラッグする。 

 

Save as Presetをクリックして、カスタマイズした画面をプリセットのテンプレートとして保存します。

Manage Presets をクリックすると、既存のプリセット画面の削除、名称変更、または復元を行えます。 
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QCタブ 
 

QCタブを使用すると、User Preferencesウィンドウの QCタブで定義される規定に基づき、ランデー

タの品質を迅速に評価できます。 

 

CFX Maestroソフトウェアでは、QCデータを表示するための以下の４つのオプションをご提供します。 
 

 Amplification（増幅）グラフ ― サイクルごとの各ウェルの RFU を表示します。グラフ内の各

トレースは、１個のウェルの単一蛍光色素から得られたデータを示します。 

 

 QC rules（QC規定）表 ― 適用可能な QC規定および各規定を定義する設定を表示します。適

用する QC規定には、チェックマークが付いています。 

 

 Well selector（ウェルセレクター）― 表示したい蛍光データを含むウェルを選択します。 

 

 QC rule summary（QC規定サマリー）ペイン ― 選択した QC規定を表示し、規定を満たさな

いウェルを強調表示します。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

QC基準の変更 
 

QC基準の変更方法 

 

 規定を QCに含める場合には Useチェックボックスを選択し、QCから除外する場合には Useチ

ェックボックスを解除します。 

 
 

QC不合格のウェルの排除 
 

CFX Maestroソフトウェアでは、QC基準に不合格のウェルを QC規定表の Resultsカラムとサマリー

ペインに表示します。 

 

QC基準に不合格のウェルの排除方法 

 

 排除する各ウェルについて Exclude Wellsを選択します。 
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Run Information（ラン情報）タブ 
 

Run Information タブでは、各ランに関するプロトコールとその他の情報が表示されます。このタブを

使用して、以下を行えます。 

 

 プロトコールの表示。 

 

 ランに関するメモの入力または編集。 

 

 ランの IDまたはバーコードの入力または編集。 

 

 ランの実行中に発生する可能性があるイベントの表示。このメッセージの表示は、ランのトラブ

ルシューティング時に有用です。 

 

アドバイス：プロトコールを右クリックすると、コピー、エクスポート、または印刷が可能になります。

また、メモ、ID／バーコード、またはその他のペインを右クリックすると、テキストの取り消し、カッ

ト、コピー、ペースト、削除、または選択を行うことができます。 
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データ解析レポート 
 

Reportダイアログボックスには、Data Analysisウィンドウ内の現在のデータファイルに関する情報が

表示されます。レポートを開くには、Tools > Reportsを選択するか、ツールバーの Reportsをクリッ

クします。 

 

Reportダイアログは、以下のセクションで構成されます。 

 

 メニューおよびツールバー ― レポートまたはテンプレートのフォーマット、保存、および印刷

のためのオプションを提供します。 

 

 Options（オプション）リスト（ウィンドウの左上） ― レポートに表示するオプションを提供し

ます。 

 

 Options（オプション）ペイン（ウィンドウの左下） ― 選択したオプションに関する情報を入力

するためのテキストボックスを表示します。 

 

 Preview（プレビュー）ペイン（ウィンドウの右側） ― 現時点でのレポートがプレビュー表示さ

れます。 
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データ解析レポートの作成 
 

レポートのレイアウトをテンプレートとして保存できます。これは、同様のレポート用に再度使用でき

ます。 

 

データ解析レポートの作成方法 

 

1. レポート作成前に、Data Analysisウィンドウにてウェル内容、選択しているウェル、グラフ、お

よびスプレッドシートについて最終調整します。 

 

2. Data AnalysisメニューバーのTools > Reportsを選択し、Reportダイアログボックスを開きます。 

 

3. レポートに含めたいオプションを選択します。選択したデフォルトのオプションを含むレポート

が開きます。チェックボックスを選択または解除すると、カテゴリー全体または１つのカテゴリ

ー内の個々のオプションを変更できます。 

 

表 24は、表示できるオプションを示しています。 

 

注意：レポートに表示されるデータは、Data Analysisウィンドウのタブ内の現選択肢によって異

なります。例えば、定量化ランの場合には、検量線が含まれない可能性があるため、Data Analysis

ウィンドウやデータレポートにはその曲線データは表示されません。 

 

4. レポート内のカテゴリーやアイテムの順番を変更します。オプションを必要な場所にドラッグし

ます。アイテムはそれらが属するカテゴリー内でのみ並べ替えることができます。 

 

5. Update Reportをクリックし、変更箇所を含む Report Previewを更新します。 

 

6. レポートを印刷または保存します。ツールバーの Print Report ボタンをクリックすると、原レポ

ートが印刷されます。File > Save を選択すると、レポートが PDF（Adobe Acrobat Readerファ

イル）、MHT（Microsoft文書）、または MHTML（Microsoft 文書）ファイルフォーマットで保存

でき、ファイルの保存場所を選択できます。File > Save Asを選択すると、レポートに新しい名

称を付けて、または新しい場所に保存できます。 

 

7. （オプション）希望する情報を含んだレポートテンプレートを作成できます。現在のレポート設

定をテンプレートに保存するには、Template > Saveまたは Save Asを選択します。その後、新

規のレポート作成時に、保存したテンプレートが画面に読みだされます。 
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データ解析レポートのカテゴリー 
 

表 24は、Data Analysisウィンドウ内のデータタイプごとの、データ解析レポートで使用できるすべて

のオプションを表示します。 

 

表24 オプションリスト内のデータ解析レポートのカテゴリー 

カテゴリー オプション 説明 

Header  レポートのタイトル、サブタイトル、およびロゴ 

 Report Information ラン実行日、ユーザー名、データファイル名、デ

ータファイルパス、および選択しているウェルグ

ループ 

 Audit Information 署名を含む監査に必要な補足情報 

 Notes データレポートに関するメモ 

Run Setup 

 Run Information ラン実行日、ユーザー、データファイル名、デー

タファイルパス、および選択しているウェルグル

ープを含む 

 Protocol プロトコールのステップとオプションのテキスト

表示 

 Plate Display プレートの各ウェルでの情報をプレートビューで

表示 

Quantification 

 Analysis Settings データ収集時のステップ番号、解析モード、およ

びベースライン補正法を含む 

 Amplification Chart 
 

定量化データを含むランの増幅グラフのコピー 

 Standard Curve Chart 検量線グラフのコピー 

 Data 各ウェル内のデータを示すスプレッドシート 

Gene Expression – Bar Chart 

 Analysis Settings 
 

解析モード、グラフデータ、スケーリングオプシ

ョン、およびグラフエラーを含む 

 Chart 棒グラフのコピー 

 Target Names ターゲット名 

 Sample Names サンプル名 

 Data 各ウェル内のデータを示すスプレッドシート 

 Target Stability 
 

ターゲット遺伝子の安定性の値のグラフ 

 Box-And-Whisker Chart 箱髭グラフ 

 Dot Plot Chart ドットプロットグラフ 

Gene Expression – Clustergram, Scatter Plot, Volcano Plot, Heat Map 

 Analysis Settings 各グラフタイプの設定を含む 

 Chart グラフ 
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表 24 オプションリスト内のデータ解析レポートのカテゴリー（つづき） 

カテゴリー オプション 説明 

 Data 各ターゲット内のデータを表示するスプレッドシ

ート 

Gene Expression - ANOVA Data 

 ANOVA Settings 実施する ANOVAのタイプ、独立変数と従属変数、

および解析に使用するＰ値閾値 

 ANOVA Results 平方和、自由度（df）、二乗平均、Ｆ統計値、お

よび ANOVA試験のＰ値データを含む 

 Tukey’s HSD 調整された平均差、stdエラー、Ｐ値、Ｐ値ボンフ

ェローニ法、Ｐ値 BH、ANOVA検定の下限値と上

限値を含む 

 Data Descriptives 解析におけるターゲットおよび標準遺伝子の係

数、カウント、平均、および標準偏差を含む。 

 ANOVA Errors ANOVA計算中に特定されるエラー 

Melt Curve 

 Analysis Settings 融解ステップ番号および閾値線の設定を含む 

 Melt Curve Chart 融解曲線グラフ 

 Melt Peak Chart 融解曲線ピークグラフ 

 Data 各ウェル内のデータを示すスプレッドシート 

Allelic Discrimination 

 Analysis Settings 蛍光色素、サイクル、および表示コールマップを

含む 

 Allelic Discrimination 
Chart 

対立遺伝子識別グラフ 

 Data 各ウェル内のデータを示すスプレッドシート 

End Point 

 Analysis Settings 蛍光色素、最終サイクルの平均、モード、最小 RFU

値、最大 RFU値、およびカットオフ値を含む 

 Data 各ウェル内のデータを示すスプレッドシート 

QC Parameters   

 Data 各 QC規定のパラメータを示すスプレッドシート 
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ウェルグループのレポート 
 

ウェルグループのレポートの作成方法 

 

1. Data Analysisウィンドウの Tools > Well Group Reports を選択します。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Well Groups Reports ダイアログボックスで、レポートに含めるウェルグループ、増幅ステップ、

および融解ステップを選択します。 

 

3. レポートを保存する宛先フォルダへのパスを入力するか、そのフォルダにナビゲートします。 

 

4. （オプション）Choose a Report Templateを選択し、テンプレートのファイルフォルダにナビゲ

ートします。 

 

5. （オプション）Open Destination Folderを選択してフォルダを開き、生成されたレポートを表示

します。 

 

6. Create Reportsをクリックします。 
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第１０章 遺伝子発現解析 
 

厳密な条件を満たしている対照物質を使用することによって、サンプル間でのターゲット遺伝子濃度の

相対差を正規化するための遺伝子発現ランを実施することが可能です。通常、対象の遺伝子の発現レベ

ルを正規化するためには、１種類以上のリファレンス遺伝子の発現レベルを適用します。こうしたリフ

ァレンス遺伝子の適用によって、各サンプルに示される取り込み差やその他の変動が考慮され、その発

現レベルはアッセイ系の影響を受けずに定量することが可能になります。 

 

Data Analysisウィンドウの Gene Expressionタブを選択すると、２つ以上のウェルにおける PCRサ

ンプル間の相対値を評価できます。たとえば、PCR サンプルでのウイルスゲノム相対数またはトラン

スフェクト遺伝子の相対値の評価が可能です。遺伝子発現実験の最も一般的な応用例としては、定常状

態の mRNAレベルを推定するために、複数の反応で得られた cDNA濃度を比較評価することです。 

 

ソフトウェアでは、以下のシナリオのいずれかによるターゲットの相対発現レベルが計算されます。 

 

 ターゲット配列（遺伝子１）に対するあるターゲット配列（遺伝子２）の相対発現レベル。たと

えば、同一のサンプル処理条件における、ある遺伝子に対する別の遺伝子の相対量 

 

 異なるサンプル処理条件における同一ターゲットに対する１サンプル内での１ターゲット配列の

相対発現レベル。たとえば、異なる時間、場所、または発現条件下におけるある遺伝子の同一遺

伝子に対する相対量。 

 



第１０章 | 遺伝子発現解析 

190 | CFX Maestro™ ソフトウェア 

遺伝子発現解析用のプレート設定 
 

遺伝子発現解析を実施するため、ウェルに必ず以下を含むものとします。 

 

 複数のターゲット ― サンプル内で異なる増幅遺伝子または増幅配列を示す２タイプのターゲッ

ト 

 １タイプ以上のリファレンス遺伝子 ― 少なくとも１タイプのターゲットは、正規化発現解析用

のリファレンスのターゲットとします。Experiment Settingsウィンドウにすべてのリファレンス

ターゲットを割り当て、Normalized Expression（正規化発現）モード（ΔΔCq）でデータを解析

します。リファレンスターゲットを含まないランは、Relative Expression（相対発現）モード（ΔCq）

で解析するものとします。 

 共通サンプル ― Gene Expression タブ画面にプロットされたデータを表示するために、反応に

は必ず共通サンプル（少なくとも２タイプ以上）を含めるものとします。このようなサンプルは、

ターゲット配列ごとに処理または条件が異なります。Experiment Settingsウィンドウに対照サン

プル（オプション）を割り当ててください。対照サンプルが選択されていない場合、ソフトウェ

アは最小 Cqを対照サンプルとして使用します。 

 

Plate Editorの Gene Expression設定の要件は、反応の内容が、１タイプの蛍光色素を用いるシングル

プレックス PCR であるか、または２タイプ以上の蛍光色素を用いるマルチプレックス PCR であるか

によって異なります。 

 

プレート設定ガイド 
 

データファイルのプレート設定が解析に必要な情報を含んでいないで Gene Expression タブを選択す

ると、通常棒グラフが表示される空間に情報入力のための指示が表示されます。正規化遺伝子発現解析

のため、以下のステップを完了させてください。 

 

1. 以下を使用してターゲット名とサンプル名を定義します。 

 

 Plate Setup（プレート設定） ― Plate Editorウィンドウを開きます。 

 

 Replace Plate File（プレートファイルの入れ替え） ― 現在のプレートレイアアウトと入れ

替える、以前保存したプレートファイルにナビゲートするため、Select Plateブラウザを開

きます。 

 

 Replace PrimePCR File（PrimePCRファイルの入れ替え） ― Select PrimePCRファイル

ダイアログボックスを開きます。ここで PrimePCRランファイルにナビゲートし、それをプ

レートレイアウトに適用します。 

 

2. Experiment Settings ダイアログボックスを使用して１つ以上のリファレンスターゲットとコント

ロールサンプルを選択します。 

 

プレートレイアウトが既にターゲットとサンプルの情報を含んでいる場合には、２番目のステッ

プのみを行い、これがオレンジ色に強調表示されます。正規化遺伝子発現解析を行う前にこのス

テップを完了しなければなりません。 

 

注意：クラスタグラム、散布図、ヒートマップ、および Volcano プロットのデータは、遺伝子発

現解析用のプレート設定に示される正規化遺伝子発現の要件をすべて満たした場合にのみ表示さ

れます。 
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遺伝子発現グラフ 
 

CFX Maestroソフトウェアでは、遺伝子発現データを複数の画面に表示します。表 25は、ソフトウェ

アで使用できるグラフのオプションを示しています。 

 

表25 遺伝子発現グラフのオプション 

ボタン 名称 機能 

 

Graphing 以下のいずれかの画面に正規化遺伝子発現データを表

示します。 

 棒グラフ（Bar chart）（デフォルト） 

 箱髭グラフ（Box and whisker chart） 

 ドットプロットグラフ（Dot plot chart） 

 

Clustergram 異なるターゲットおよびサンプルの発現の類似度に基

づき、正規化発現データを階層構造で表示します。 

 

Scatter Plot ターゲットの正規化発現をコントロールサンプル vs.実

験サンプルで表示します。 

 

Volcano Plot コントロールサンプルと比較した実験サンプルのター

ゲットの発現（レギュレーション）における変化を表示

し、Ｐ値に基づく重要度を示します。 

 

Heat Map 相対的正規化発現とそのプレート上の位置に基づき、コ

ントロールサンプルと比較した実験サンプルのターゲ

ットのレギュレーションを視覚的に描写します。 

 

Well Results 
 

すべてのグラフからのウェルのデータをまとめます。 

 

ANOVA ANOVAを実施し、不均衡データ結果を処理するため、

応用回帰への手引（Companion to Applied Regression）

（car）および最小二乗手段（lsmeans）Rパッケージを

使用して、正規化遺伝子発現データの一元配置および二

元配置 ANOVAの結果を表示します。 

 

Reference Gene Selection 
Tool 
 

（Gene Studyウィンドウの Study Analysisタブで使用

可能）試験した標準遺伝子を識別し、それぞれの安定性

に基づき Ideal（理想的）、Acceptable（可）、または

Unstable（不安定）に分類します。 

 

PrimePCR Controls 
Anlaysis 
 

（Gene Studyウィンドウの Study Analysisタブで使用

可能）試験したサンプルの結果を表示します。 
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グラフ化 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ターゲットの相対的発現は、以下の２つの画面に示されます。 

 

 Gene Expression（遺伝子発現）グラフ ― リアルタイム PCRデータを以下のいずれかとして表

示します。 

 

 ΔΔCq ― コントロールサンプルと標準ターゲットを使用して算定される相対的正規化発現。 
 

 ΔCq ― コントロールサンプルに対するサンプル内のターゲット遺伝子の相対量。 

 

遺伝子発現グラフのデータは、３つの画面のいずれかに表示することができます。詳細について

は、194ページの「グラフ表示の変更および注釈」を参照してください。 

 

 Spreadsheet（スプレッドシート） ― 遺伝子発現データのスプレッドシートを表示します。 

 

アドバイス：グラフのどれかまたはスプレッドシートを右クリックするとオプションを表示でき

ます。Plate Setupドロップダウンメニューから View/Edit Plateを選択して Plate Editorを開き、

プレートのウェル内容を変更します。 

 

アドバイス：右クリックメニューから Sortを選択すると、グラフのターゲット名とサンプル名の

順番を並べ替えることができます。 
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正規化遺伝子発現（Normalized Gene Expression） 

 

データを正規化するには、測定される１つ以上のリファレンス遺伝子の発現レベルを正規化因子として

使用します。リファレンス遺伝子としては、評価対象となる生物系で調節されていない（変動しない）

ターゲット、たとえばアクチン、GAPDH、またはチューブリンなどが挙げられます。 

 

正規化遺伝子発現（ΔΔCq）解析の設定方法 

 

1. データファイル（拡張子は.pcrd）を開きます。 

 

2. Data Analysisウィンドウの Quantificationタブでデータを再チェックします。閾値や解析モード

の変更を行ってデータを補正します。 

 

3. Gene Expressionタブを選択します。 

 

4. Gene Expressionタブで、Experiment Settingsをクリックします。 

 

5. Experiment Settingsダイアログボックスで以下を行います。 

 

a. Samplesタブを選び対照を１つ選択します。対照が割り当てられると、CFX Maestroソフト

ウェアはすべての遺伝子の相対量を１に設定される対照発現量へと正規化します。 

 

b. Target タブを選び標準遺伝子を選択します。遺伝子発現解析には、サンプル内のターゲット

のうち１つの標準ターゲット必要です。 

 

6. まだ選択してない場合には Normalized Expression（ΔΔCq）を選択します。その後、Gene 

Expressionタブ画面で発現レベルを確認します。 

 

注意：正規化遺伝子発現解析用のプレートレイアウトを設定するために Setup Wizardを使用する

こともできます。 

 

相対量（Relative Quantity） 

 

定義によって、相対量（ΔCq）データは正規化されません。この方法は、リファレンス遺伝子（ターゲ

ット）を含まないサンプルを定量化する場合に使用されます。一般に、ランの設定時に以下の点が考慮

されます。 

 

 各サンプルは、同一のテンプレート量を示す。各ウェルでの RNA または cDNA の質量と同一に

なると考えられる。 

 

 生物サンプル量のばらつきは、ソフトウェアのデータ解析以外の方法によってラン実行後に正規

化される。たとえば、各サンプルに添加される核酸質量、または核酸が単離された細胞数などの

正規化係数によって相対量を単に除算する方法が選択される可能性がある。 

 

相対量（ΔCq）解析のラン方法 

 

 Gene Expression タブ画面の右側のペインにある Mode ドロップダウンリストから、Relative 

Quantity（相対量）（ΔCq）を選択します。 

 

アドバイス：結果を他の遺伝子発現ランによるデータと比較するには、新しい Gene Study 画面

を開くか、あるいは既存の Gene Study画面にデータファイルを追加します。 
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グラフ表示の変更および注釈 
 

グラフのツールバーメニューコマンドとデータ解析グラフツールを使用すれば、グラフ画面の変更、各

グラフの注釈、およびグラフ表示の変更が可能です。グラフのツールバーは、グラフと画面下部のデー

タ解析スプレッドシートの間に表示されます。 

 

グラフのツールバーツール 

 

アドバイス：データ解析グラフの右側に表示されるグラフツールに関する詳細については、147ページ

のグラフを参照してください。 

 

グラフの下にあるツールバーによって、注釈ツールへ迅速にアクセスできます。 

 
 
 
 

表 26は、グラフのツールバーにあるボタンの機能を示しています。 

 

表26 グラフのツールバー 

ボタン 名称 機能 

 

Bar chart 

（デフォルト） 
ターゲットの相対的発現を表示します。 

 
Box-and Whisker chart 
 

25 %と 75 %の四分位、中央値、およびデータの最も遠

いはずれ値を表示します。 

 

Dot Plot chart 
 

箱髭グラフから個々のターゲットデータポイントを表

示します。 

 

Add Arrow アクティブなグラフに矢印を描画します。 

 
Add Circle アクティブなグラフに丸を描画します。 

 

Add Text アクティブなグラフにテキストボックスを挿入します。

ここでテキストを追加してグラフ内の対象アイテムを

特定することができます。 

 
Undo アクティブなグラフへの最後の注釈を削除するか、また

は元に戻します。 

 
Redo アクティブなグラフへの最後の Undo操作を戻します。 

 Clear All アクティブなグラフのすべての注釈を消去します。 

 



グラフ化 

ユーザーガイド | 195 

ターゲットとサンプルデータの並べ替え 

 

注意：このオプションは、遺伝子発現グラフでのみ使用できます。 

 

デフォルトでは、ターゲットとサンプルの各リストはアルファベット順で表示されます。Sortツールを

使用すると、表示を逆順に並べ替えることができ、また、項目をリスト内の別の位置に手動で移動する

ことができます。 

 

ターゲットとサンプルデータの並べ替え方法 

 

1. Chartツールで Sortをクリックします。 

 

Gene Expression Chart Sorting ダイアログボックスが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. 特定のリストで、Z-Aをクリックすると逆順に並べ替わります。 

 

3. 項目を手動で移動するには、項目を選択してグラフ間の該当するボタンをクリックします。 

 

 上下矢印をクリックすると、選択した項目の位置が１つ移動します。 

 

 バー付き上下矢印をクリックすると、選択した項目がリストの最上部または最下部に移動し

ます。 

 

4. OKをクリックして変更を保存し、Gene Expressionタブに戻ります。 
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ターゲットおよびサンプルの色設定の変更 

 

Color Settingsダイアログボックスを使用して、ターゲットまたはサンプルの色を変更し、またはグラ

フからアイテムを削除できます。 

 

ターゲットの色設定の変更方法 

 

1. Gene Expressionダイアログボックスの右側のペインで、サンプルが X-Axis ドロップダウンリス

トに表示されていることを確認します。 

 

2. グラフのツールで、Color Settings（色設定）を選択します。 

 

Color Settingsダイアログボックスが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. ターゲットの表示色を変更するには、Colorカラム内でその色をクリックします。 

 

4. 表示される Colorダイアログボックスで新しい色を選択し、OKをクリックします。 

 

5. ターゲットを遺伝子発現グラフから削除するには、Show Chartカラムの該当するチェックボック

スを解除します。 

 

アドバイス：すべてのターゲットを解除するには、カラムの見出しにある Show Chart を解除し

ます。 

 

6. （任意）デフォルトでは、バーが固定色で表示されます。バーをグラデーション色で表示するに

は、Use Solid Colorsを解除します。 

 

7. OKをクリックして変更を保存し、Gene Expressionタブに戻ります。 
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サンプルの色設定の変更方法 

 

1. Gene Expressionダイアログボックスの右側のペインで、X-Axis ドロップダウンリストにターゲ

ットが表示されていることを確認します。 

 

2. 196ページの「ターゲットの色設定の変更方法」の手順を実行してください。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

グラフ画面の変更 

 

現在のグラフ画面の変更方法 

 

 ターゲット画面に関するツールバーメニューのコマンドを選択します。 

 

注意：Gene Expressionタブは常に開いており、最後に選択した画面にデータを表示します。 

 

はずれ値のデータポイントの除外 

 

ドットプロットグラフでは、はずれ値を容易に表示でき、また解析から除外することができます。 

 

はずれ値のデータポイントの除外方法 

 

 ドットプロットグラフのターゲットはずれ値を右クリックし、Exclude Well from Analysis を選択

します。 

 

データポイントがドットプロットグラフから削除され、ウェルは Quantificationタブ画面のウェルセレ

クター内でグレー表示に変わります。 

 

除外されたはずれ値データポイントを含める方法 

 

 Quantificationタブ画面のウェルセレクター内のウェルを右クリックし、Well > Include in Analysis

を選択します。 
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グラフの注釈 

 

データを明確に伝えるため、矢印、丸、およびテキストをそれぞれの棒グラフに加えることができます。

注釈は棒グラフと共に保存され、エクスポートファイルや印刷ファイルに表示されます。しかし、１つ

のグラフ画面について作成された注釈は、他のグラフ画面には追加されません。 

 

グラフに矢印または丸を描画する方法 

 

1. 棒グラフのツールバーで、特定のツールをクリックします。 

 

2. 棒グラフをクリックし、必要に応じてグラフ内にカーソルをドラッグします。 

 

グラフにテキストを追加する方法 

 

1. 棒グラフのツールバーの Add Text をクリックします。 

 

2. 棒グラフをクリックすると、その場所にテキストボックスが表示されます。 

 

3. テキストボックスにテキストを入力します。 

 

4. グラフ内のどこかをクリックしてテキストボックスを終了します。 

 

アドバイス：テキストボックスの複数の行を追加するには、Enterキーを押してください。 

 

注釈の移動方法 

 

1. 注釈の上にカーソルを重ねます。アイコンが指差し形状に変わり、注釈の縁が強調表示されます。 

 

2. 注釈をクリックしたまま別の位置までドラッグします。 

 

3. クリックを解除して注釈をその位置に固定します。 

 

注釈の取り消し方法 

 

 Undoをクリックします。 

 

最も新しく追加した注釈が削除されます。 

 

アドバイス：新しく追加した注釈は、１個ずつ、最大 10個まで取り消すことができます。 

 

注釈の再実行方法 

 

 Redoをクリックします。 

 

最も新しく削除した注釈が再び戻ります。 

 

アドバイス：新しい注釈は、１個ずつ最大 10個まで再実行することが可能です。 

 

注釈の削除方法 

 

 注釈を右クリックし、Deleteを選択します。 
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遺伝子発現データの調整 
 

解析モードの選択後、Gene Expressionタブ画面の右側のペインにある設定オプションを変更して、表

示データを調整します。 

 

Graph Data（グラフデータ） 

 

Y軸の値を線形目盛りに設定し、グラフデータのオプションを有効にします。グラフデータのオプショ

ンでは、以下のオプションのいずれかでグラフのデータを表すことができます。 

 

 Relative to control（対照との相対） ―座標軸を 0から 1へスケーリング変更したデータグラフ。

実行したランで対照（control）を割り当てた場合には、このオプションを選択してターゲット遺

伝子のアップレギュレーションとダウンレギュレーションを迅速に視覚化します。 

 

 Relative to zero（ゼロとの相対） ― ゼロを基点とするデータグラフ。 

 

アドバイス：User Preferencesダイアログボックスの Gene Expressionタブでグラフデータオプショ

ンを設定します。 

 

Analyze Using（解析に使用） 

 

CFX Maestro ソフトウェアでは、遺伝子発現計算を実施するためにプレート設定に示される各独立変

数を自動的に考慮します。しかし、解析設定を変更することにより、使用する変数を指定することが可

能です。たとえば、プレート設定に生物学的グループとサンプルが含まれる場合、サンプルデータのみ、

生物学的グループデータのみ、サンプルと生物学的グループデータ、または生物学的グループとサンプ

ルデータを選び、棒グラフに結果を表示できます。 

 

注意：Use biological groups for analysis（解析に生物学的グループを使用）チェックボックスは、デー

タが生物学的グループを含む場合にのみ有効です。データに生物学的グループが含まれる場合、チェッ

クボックスは初期設定では選択されていないため、棒グラフにはサンプルデータしか表示されません。 
 

解析の変更方法 

 

 Analyze Usingセクションで、User biological groups for analysis チェックボックスを選択・解除

します。 

 

グラフに特定データを表示する方法 

 

 Graph Viewドロップダウンリストから、以下のオプションのいずれかを選択します。 

 

 Samples Only（サンプルのみ） 

 

 Use biological groups for analysis チェックボックスを選択していない場合、ターゲッ

トごとにサンプルのみが計算に使用されます。 

 

 Use biological groups for analysisチェックボックスを選択している場合、CFX Maestro

ソフトウェアはサンプルと生物学的グループをそれぞれ独立して正規化します。グラ

フには、各生物学的グループについて平均化された正規化サンプルデータが表示され

ます。 
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 Biological Groups Only（生物学的グループのみ） 

 

 Use biological groups for analysis チェックボックスを選択していない場合、ターゲッ

トごとに生物学的グループのみが計算に使用されます。 

 

 Use biological groups for analysisチェックボックスを選択している場合、CFX Maestro

ソフトウェアはサンプルと生物学的グループをそれぞれ独立して正規化します。グラ

フには、各サンプルについて平均化された正規化生物学的グループデータが表示され

ます。 

 

 Sample Biological Group（サンプル 生物学的グループ） ― 各ターゲットについて、CFX 

Maestro ソフトウェアは対照として使用する最小 Cq 値を探します。各ターゲットの対照を

基準としてサンプルと生物学的グループの相対量を計算し、その後、正規化発現を計算しま

す。グラフには、同様のサンプルがそれぞれの生物学的グループと相互に隣り合わせて並べ

られます。 

 

 Biological Group Sample（生物学的グループ サンプル） ― 各ターゲットについて、CFX 

Maestro ソフトウェアは対照として使用する最小 Cq 値を探します。各ターゲットの対照を

基準として生物学的グループとサンプルの相対量を計算し、その後、正規化発現を計算しま

す。グラフには、同様の生物学的グループがそれぞれのサンプルと相互に隣り合わせて並べ

られます。 

 

Control（対照） 

 

注意：一度に１対照のみ選択できます。Experiment Settings ダイアログボックスで対照を選択した場

合、Controlドロップダウンリストにはデフォルトでその対照が表示されます。Experiment Settingsダ

イアログボックスで複数の対照を選択すると、Controlドロップダウンリストには何も表示されません。

別の対照を Control ドロップダウンリストから選択でき、選択すると Experiment Settings ダイアログ

ボックスの対照設定は自動的に更新されます。 

 

すべてのターゲットの相対量を正規化するための対照のタイプを選択します。 

 

 サンプルのみを使用して解析する場合、Controlドロップダウンリストには実験に使用するすべて

のサンプルが表示されます。 

 

 生物学的グループのみを使用して解析する場合、Controlドロップダウンリストには実験に使用す

るすべての生物学的グループが表示されます。 

 

 Sample Biological Group または Biological Group Sampleのいずれかを使用して解析する場合、

Controlドロップダウンリストには Not Available（使用不可）と表示されます。正規化に使用する

特定の対照を選択することはできません。 

 

アドバイス：対照を None（なし）（サンプルと生物学的グループで使用可能）または Not Available（使

用不可）に設定することにより、スケーリングオプションが有効になり、ここではデータを Average

（平均）、Lowest（最低）、Highest（最高）、または Unscaled（非基準化）としてスケーリング可能

です。 

 

Annotate P-Values（Ｐ値の注釈）およびＰ値閾値 

 

Annotate P-Values（Ｐ値の注釈）を選択すると、ソフトウェアでは、選択した閾値よりもＰ値が低い

場合にターゲットを上回る棒グラフにアスタリスク（*）を表示します。ソフトウェアは標準のｔ検定

を使用してサンプルの発現レベルを選択した対照サンプルの発現レベルと比較することにより、自動的

にＰ値を算定します。Ｐ値の閾値範囲は、0.000～1.000です。 
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X-Axis（X軸オプション） 

 

x軸オプションでは、遺伝子発現グラフの x軸データを選択できます。 

 

 Target（ターゲット） ― ターゲット名を x軸に表示します。 

 

 Sample（サンプル） ― サンプル名を x軸に表示します。 

 

Y-Axis（Y軸オプション） 

 

Y軸オプションでは、以下の３つのスケールのいずれかで遺伝子発現グラフを表します。 

 

 Linear（線形） ― このオプションは線形スケールを表します。 

 

アドバイス：y軸を Linearに設定すると、Graph Dataドロップダウンリストが有効になり、ここ

から Relative to controlのデータまたは Relative to zeroのデータをグラフにすることができます。 
 

 Log 2（対数 2） ― このオプションは広範なダイナミックレンジでサンプルを評価します。 

 

 Log 10（対数 10） ― このオプションは極めて広範なダイナミックレンジでサンプルを評価しま

す。 

 

Scaling（スケーリングオプション） 

 

Normalized Gene Expression（ΔΔCq）を選択し、Control Sampleを Noneに設定して、遺伝子発現グ

ラフのスケーリングオプションを有効にします。以下のスケーリングオプションのいずれかを選択して、

実行するラン設計に最適な方法でデータを算定・表示します。 

 

 Unscaled（非基準化） ― 非基準化の正規化遺伝子発現を示します。 

 

 Highest（最高） ― 各サンプルの発現レベルを全サンプルにおける最高発現レベルで除算する

ことにより、各ターゲットで最高レベルとなる正規化遺伝子発現をスケール化します。 

 

このスケーリングオプションでは、最高レベルにスケール化される計算式が適用されます。 

 

 Lowest（最低） ― 各サンプルの発現レベルを全サンプルにおける最低発現レベルで除算するこ

とにより、各ターゲットの正規化遺伝子発現をスケール化します。 

 

このスケーリングオプションでは、最低レベルにスケール化される計算式が適用されます。 

 

 Average（平均） ― 各サンプルの発現レベルを全サンプルの発現レベルの幾何平均で除算する

ことにより、各ターゲットの正規化遺伝子発現をスケール化します。 

 

このスケーリングオプションでは、平均にスケール化される計算式が適用されます。 

 

Error Type（誤差タイプ） 

 

遺伝子発現グラフにおいて、誤差タイプ（エラーバー）の計算のオプションを選択します。 

 

 平均標準誤差（デフォルト、SEM） 

 

 標準偏差（Std Dev） 
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Chart Error Bar Multiplier（グラフのエラーバー乗数） 

 

遺伝子発現グラフのエラーバーの乗数を選択します。±１（デフォルト）、２、または３の整数のうち

のいずれかを選択してください。以下の誤差タイプを選択すると、乗数のタイプが変更されます。 

 

 平均標準誤差として SEM 

 

 標準偏差として Std Dev 

 

Experiment Settings（実験の設定） 
 

アドバイス：このダイアログボックスは Plate Editorでも使用できます。詳細については、109ページ

の「Experiment Settings の変更」を参照してください。 

 

Experiment Settings ダイアログボックスでは、ターゲットやサンプルのリストの表示または変更が可

能であり、さらにリファレンス遺伝子や対照サンプルを選ぶことができます。 

 

Experiment Settingsダイアログボックスの開き方 

 

 Graphingタブ画面で、右側のペイン下部にある Experiment Settingsをクリックします。 

 

Experiment Settings ダイアログボックスが現れ、Targetsタブが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Targets設定の調整方法 

 

 Targetsタブで、以下を行います。 

 

 遺伝子発現データ解析用のリファレンスとしてターゲットを選択するには、Referenceカラ

ム内の名称を選択します。 

 

注意：リファレンス遺伝子として複数のターゲットを選択できます。しかし、すべてのター

ゲットをリファレンス遺伝子として選択すると、ソフトウェアでは正規化遺伝子発現を実施

できません。 

 

 ターゲットの色を変更するには、Color カラム内の該当するセルをクリックし、表示される

Colorダイアログボックスで色を変更します。 

 

色の変更が、遺伝子発現グラフに表示されます。 
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 以前得られた効率値を使用するには、Auto Efficiencyカラム内のターゲットのチェックボッ

クスを解除し、ターゲットの効率割合の数値を入力します。 

 

ソフトウェアでは、ターゲットのデータに検量線が含まれる場合には、Auto Efficiencyを使

用してターゲットの相対効率が計算されます。 

 

Sample設定の調整方法 

 

 Samplesタブで以下を行います。 

 遺伝子発現データ解析用の対照サンプルを選択するには、その名称を Control カラムから選

びます。 

 

重要：ウェルグループごとに選択できる対照は１つだけです。複数の対照を選択すると、ソ

フトウェアは棒グラフデータに対照サンプルとして「None（なし）」と表示します。棒グ

ラフのこの設定を変更するには、Control ドロップダウンメニューから対照サンプルを選択

してください。 

 

 サンプルの色を変更するには、Color カラム内の該当セルをクリックし、表示される Color

ダイアログボックスで色を変更します。 

 

色の変更は、遺伝子発現グラフに表示されます。 

 

 サンプルを遺伝子発現グラフに表示するには、Show Chartカラム内で選択します。 

 

サンプルは Colorカラムで選択した色でグラフに表示されます。 

 

 サンプルを遺伝子発現グラフから削除するには、Show Chartカラム内で解除します。 

 

アドバイス：サンプルの名称は Results（結果）表に残ります。 

 

サンプルタイプを解析計算から除外する方法 

 

 Experiment Settings ダイアログボックスの下部で該当するチェックボックスを選択します。 

 

右クリックメニューのオプション 
 

遺伝子発現グラフを右クリックすると、表 27の項目を選択できます。 

 

表27 遺伝子発現グラフの右クリックメニュー項目 

項目 機能内容 

Copy グラフをクリップボードにコピーします。 

Save Image As グラフを画像ファイルとして保存します。画像の解像度と寸法を設定

し、ファイルタイプ（PNG、GIF、JPG、TIFまたは BMP）を選択しま

す。 

Page Setup 印刷用のページ設定を選択します。 

Print グラフを印刷します。 

Set Scale to Default Show All（すべて表示）により、すべてのデータが棒グラフに表示され

ます。Scroll Bar（スクロールバー）により、グラフのフレームに表示

するサンプルが多すぎる場合にはスクロールバーを表示し、その一方で

バーの幅を最小限に維持します。 

Chart Settings Chart Settingsウィンドウを開きグラフを調整します。 
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表 27 遺伝子発現グラフの右クリックメニュー項目（つづき） 

項目 機能内容 

Sort グラフの x軸に表示されるサンプルまたはターゲットの順番を並べ替え

ます。 

Color Settings Color Settings ウィンドウを開きます。ここではグラフの表示に応じて

グラフ内のターゲットまたはサンプルの色を変更できます。 

User Corrected Std Devs 補正した標準偏差式を使用してエラーバーを算定します。 

Use Solid Bar Colors グラフを固定色のバーで表示します。 

X-Axis Labels x軸のラベルを水平に、または角度を付けて表示します。 

 

データスプレッドシート 
 

表 28はグラフ化したデータスプレッドシートに表示されるデータを定義します。 

 

注意：データスプレッドシート内の値は、グラフタイプと右側のペインで選択される設定に基づき算定

されます。 

 

表28 グラフのタブのスプレッドシート内の情報の説明 

項目 説明 

Target Experiment Settings ウィンドウで選択したターゲット名（増幅遺伝子） 

Sample Experiment Settings ウィンドウで選択したサンプル名 

Control Experiment Settings ウィンドウでサンプル名を対照として選択した場

合の対照サンプル 

Expression 選択したモードにより、正規化遺伝子発現（ΔΔCq）または相対量（ΔCq）

のいずれか。 

 

重要：データに生物学的グループが含まれ Use biological groups for 

analysisチェックボックスが選択されている場合、ソフトウェアは、全

生物学的グループの重み付き平均を得るために各生物学的グループの

発現を平均化したものとして Expression（発現）値を算定します。 

Expression SEM（または

SD） 

選択したオプションにより、平均標準誤差（SEM）または標準偏差（SD）

のいずれか。 

Corrected Expression SEM

（または SD） 
選択したオプションにより、相対発現の SEMまたは SDの補正値計算。 

Mean Cq Cq の平均 

Cq SEM（または SD） 選択したオプションにより、Cqの標準誤差（SEM）または標準偏差（SD）

のいずれか 

P-Value 選択したターゲットの発現の差が有意である確率 

注意：棒グラフで報告されるＰ値は、選択している対照に基づきます。

Ｐ値がユーザー指定の閾値未満であるグラフに注釈をつけることが可

能です。 
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Show Details（詳細情報の表示）オプション 
 

表 29は、Show Detailsが遺伝子発現グラフのスプレッドシートの右クリックメニューから選択された

場合に表示されるデータを定義します。 

 

表29 Show Detailsが選択された棒グラフのスプレッドシートの情報 

情報 説明 

Data Set データファイル内の１つの蛍光色素による蛍光データ 

Relative Quantity 算定されたサンプル相対量 

Relative Quantity SD 算定された相対量の標準偏差 

Corrected Relative Quantity 
SD 

補正された相対量について算定された標準偏差 

Relative Quantity SEM 算定された相対量の平均標準誤差 

Corrected Relative Quantity 
SEM 

補正された相対量について算定された平均標準誤差 

Unscaled Expression 算定された非基準化発現 

Unscaled Expression SD 算定された非基準化発現の標準偏差 

Corrected Unscaled 
Expression SD 

算定された非基準化発現の標準偏差（補正済） 

Unscaled Expression SEM 算定された非基準化発現の平均標準誤差 

Corrected Unscaled 
Expression SEM 

算定された非基準化発現の平均標準誤差（補正済） 

Expression 選択したモードにより、正規化遺伝子発現または相対量発現レベルのい

ずれか 

Expression SD 選択したモードの標準偏差 

Corrected Expression SD 選択したモードについて算定された標準偏差 

Expression SEM 選択したモードの平均標準誤差 

Corrected Expression SEM 選択したモードについて算定された平均標準誤差 

Wells プレート内のウェル番号 

Mean Cq Cq の平均 

Cq SD Cq の標準偏差 

Cq SEM Cq の平均標準誤差 

P-Value 選択したターゲットのサンプル発現の差が有意である確率 
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Clustergram（クラスタグラム） 
 

クラスタグラムでは、異なるターゲットやサンプルの発現の類似度に基づき、データを階層構造で表示

します。 

 

注意：棒グラフ用の相対発現以外のデータプロットを表示するため、標準ターゲットを選択する必要が

あります。 

 

クラスタグラムの画像は、以下のようにサンプルまたはターゲットの相対発現を示します。 

 

 アップレギュレーション（赤） ― 高発現 

 

 ダウンレギュレーション（緑または青） ― 低発現 

 

 レギュレーションなし（黒） 

 

 算出値なし（黒地に白の×印） 

 

色の色合いが明るいほど、相対発現の差がより大きいことを示します。正規化 Cq値が算出されていな

い場合、四角部分が黒字に白の×印になります。 

 

データプロットの外縁は、クラスタ階層を示す樹状図になります。類似の発現パターンのターゲットま

たはサンプルが隣り合った枝を持つ一方で、類似しないパターンの場合はより離れた位置になります。 
 

設定 
 

以下のオプションを設定できます。 

 

 Cluster By（クラスタ方法） ― ターゲット、サンプル、両方、もしくは無しから選びます。 

 

 Size（サイズ） ― スライダーを使用して、明瞭化するために画像サイズを調整しグラフの拡大

率を変更します。 

 

 Split Out Replicates（リプリケートの分割） ― 個々のリプリケートの値を表示します。 

 

アドバイス：クラスタグラム、散布図、ヒートマップ、および Volcano プロットのカラースキムは各

グラフの右クリックメニューにあるオプションを選択することにより、初期設定の Red/Green（赤／

緑）から Red/Blue（赤／青）に変更できます。 

 

右クリックメニューオプション 
 

クラスタグラムの右クリックメニューオプションは、棒グラフの場合と同じです。使用可能なオプショ

ンについては、203 ページの表 27 を参照してください。さらに、ダウンレギュレーションの発現をグ

ラフ上で初期設定の Red/Green（赤／緑）から Red/Blue（赤／青）に変更するには Color Schemeを

選択してください。 

 

データスプレッドシート 
 

スプレッドシートには、ターゲット、サンプル、および正規化発現の値が表示されます。 
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Scatter Plot（散布図） 
 

散布図には、対照 vs.実験サンプルでのターゲットの正規化発現が表示されます。 

 

散布図の画像は、閾値セットに基づくターゲット遺伝子発現の以下の変化を示します。 

 

 アップレギュレーション（赤丸） ― 相対的に高発現 

 

 ダウンレギュレーション（緑または青丸） ― 相対的に低発現 

 

 変化なし（黒丸） 

 

閾値線をクリック＆ドラッグして、レギュレーションの閾値を調整します。 

 

設定 
 

以下のオプションを設定できます。 

 

 Control Sample（対照サンプル） 

 

 Experimental Sample（実験サンプル） 

 

 Regulation Threshold（レギュレーション閾値） 

 

この値を増加または減少すると、プロット内の閾値線が適切に移動します。 

 

右クリックメニューオプション 
 

散布図の右クリックメニューオプションは、棒グラフの場合と同じです。使用可能なオプションについ

ては、203ページの表 27を参照してください。追加として以下があります。 

 

 Symbol（記号） ― このオプションを選択すると、プロットに使用する記号を初期設定の丸から

以下のいずれかへ変更できます。 

 

 三角 

 

 十字 

 

 四角 

 

 ひし形 

 

 Color Scheme（カラースキム） ― このオプションを選択すると、グラフのダウンレギュレーシ

ョンの発現を初期設定の Red/Green（赤／緑）から Red/Blue（赤／青）に変更できます。 

 

データスプレッドシート 
 

スプレッドシートには、ターゲットの値と、対照サンプルと実験サンプルの正規化発現が表示されます。

また、閾値設定と比較してターゲットがアップレギュレーションまたはダウンレギュレーションしてい

るかどうかを示します。 
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Volcanoプロット 
 

Volcano プロットには、対照 vs.実験サンプルでのターゲットの発現（レギュレーション）の変化とＰ

値を基にした有意差の程度が表示されます。 

 

プロットの画像は、閾値設定に基づくレギュレーションの以下の変化を表示します。 

 

 アップレギュレーション（赤丸） ― 高発現 

 

 ダウンレギュレーション（緑または青丸） ― 低発現 

 

 変化なし（黒丸） 

 

閾値線をクリック＆ドラッグしてレギュレーションの閾値を調整します。 

 

設定 
 

以下のオプションを設定できます。 

 

 Control Sample（対照サンプル） 

 

 Experimental Sample（実験サンプル） 

 

 Regulation Threshold（レギュレーション閾値） 

 

 P-Value Threshold（Ｐ値閾値） 

 

Regulation Thresholdまたは P-Value Thresholdの値を増加または減少すると、プロットの閾値線が適

切に移動します。 

 

右クリックメニューオプション 
 

Volcanoプロットの右クリックメニューオプションは、棒グラフの場合と同じです。使用可能なオプシ

ョンについては、203ページの表 27を参照してください。追加として以下があります。 

 

 Symbol（記号） ― このオプションを選択すると、プロットに使用する記号を初期設定の丸から

以下のいずれかへ変更できます。 

 

 三角 

 

 十字 

 

 四角 

 

 ひし形 

 

 Color Scheme（カラースキム） ― このオプションを選択すると、グラフのダウンレギュレーシ

ョンの発現を初期設定の Red/Green（赤／緑）から Red/Blue（赤／青）に変更できます。 

 

データスプレッドシート 
 

スプレッドシートには、ターゲット、サンプル、レギュレーション、およびＰ値の値が表示されます。

また、Ｐ値が閾値を超えるかどうか、閾値設定と比較してアップレギュレーションまたはダウンレギュ

レーションしているかどうかを示します。 
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ヒートマップ 
 

ヒートマップは、相対的正規化発現に基づき対照サンプルと比較した実験サンプルのターゲットのレギ

ュレーションとそのプレート上の位置を視覚的に描写します。 

 

ヒートマップ下の凡例は、正規化発現の範囲を表示し、これは以下に対応します。 

 

 アップレギュレーション（赤丸） ― 高発現 

 

 ダウンレギュレーション（緑または青丸） ― 低発現 

 

 変化なし（黒丸） 

 

色の色合いが明るいほど、相対的正規化発現の差が大きくなります。正規化発現値が算出されていない

場合には、四角部分が黒地に白の×印で表示されます。 

 

設定 
 

以下のオプションを設定できます。 

 

 Control Sample（対照サンプル） 

 

 Experimental Sample（実験サンプル） 

 

 Size（サイズ） ― グラフの拡大率を変更するため、スライダーを使用して画像サイズを調整で

きます。 

 

 Split Out Replicates（リプリケートの分割） ― 個々のリプリケートの値を表示します。 

 

右クリックメニューオプション 
 

ヒートマップの右クリックメニューオプションは棒グラフの場合と同じです。使用可能なオプションに

ついては 203 ページの表 27 を参照してください。さらに、Color Scheme（カラースキム）を選択す

ると、グラフのダウンレギュレーションの発現を初期設定の Red/Green（赤／緑）から Red/Blue（赤

／青）に変更できます。 

 

データスプレッドシート 
 

スプレッドシートには、ターゲット、サンプル、およびレギュレーションの値が表示されます。 
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Well Results（ウェル結果）スプレッドシート 
 

Well Resultsスプレッドシートは、すべてのグラフのウェルデータをまとめています。表 30は、Well 

Resultsスプレッドシートに表示されるデータを定義します。 

 

注意：Well Results表のデータは個々のウェルを基に計算されます。 

 

表30 Resultsタブの情報 

情報 説明 

Target ターゲット名（増幅遺伝子） 

Sample サンプル名 

Mean Cq Cq の平均 

Mean Efficiency Corrected 
Cq 

反応効率の調整後の Cqの平均 

Normalized Expression リファレンスターゲットに正規化したターゲット発現（ΔΔCq） 

Relative Normalized 
Expression 

対照サンプルと比較した正規化発現。Fold Change（倍率変化）とも呼

称。 

Regulation 対照サンプルと比較した発現における変化。 

Compared to Regulation 
Threshold 

閾値設定に基づく実験サンプルのアップレギュレーションまたはダウ

ンレギュレーション 

P-Value 発現の差が有意である確率 

 

注意：Ｐ値は、対照サンプル vs.試験サンプルについてウェルごとの正

規化発現（NE）値の分布を比較する独立 t検定の結果です。 

Exceeds P-Value Threshold 閾値を超えたターゲットのＰ値であるかどうかを表示 

 

注意：リプリケートのデータは、Split Out Replicatesが選択されているデータ解析タブ（すなわち、ク

ラスタグラムとヒートマップ）のスプレッドシートにのみあります。棒グラフで対照サンプルとして

none（無し）を選択すると、遺伝子発現解析スプレッドシートの発現データ間に矛盾が生じる可能性

があります。 
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ANOVA計算 
 

ANOVAタブ画面には、分散（ANOVA）の一元配置または二元配置解析の結果が表示されます。ANOVA

は、２つ以上の因子（独立変数）の平均が等しいという仮定について試験します。帰無仮説では、すべ

ての因子の平均が等しいとし、その一方で代替的な仮説では少なくとも１つの因子レベルの平均は異な

るとしています。 

 

一元配置 ANOVAは、１つの因子に基づき複数の個体群平均を比較します。二元配置 ANOVAは、２つ

の因子（２つの独立変数）に基づき複数の個体群平均を比較します。 

ANOVAデータは、均衡がとられるか（同数の観測結果がある）、または不均衡（観測数が等しくない）

になります。 

 

不均衡な場合を対処するため、平方和を計算する以下の３つのアプローチを採用します（Fox, 2008）。 

 

 タイプ I（階層的アプローチ） 

 

タイプ I では、因子 A の主な効果を試験した後に、A の主な効果が生じた後の因子 Bの主な効果

を試験し、さらに主な効果を生じた後の相互作用の効果 ABを試験します。 

 

 因子 Aの SS(A) 

 

 因子 Bの SS(B | A) 

 

 相互作用 ABの SS(AB | B, A) 

 

 タイプ II（従来の実験アプローチ） 

 

タイプ II では、他の主な効果が生じた後のそれぞれの主な効果について試験します。相互作用が

ない場合には、タイプ IIはタイプ IIIよりも統計的に強力です。 

 

 因子 Aの SS(A | B) 

 

 因子 Bの SS(B | A) 

 

 タイプ III（完全回帰アプローチ） 

 

このタイプでは、他の主な効果と相互作用が生じた後の主な効果の存在について試験します。こ

のアプローチは、有意な相互作用が存在する場合に有効です。 

 

 因子 Aの SS(A | B, AB) 

 

 因子 Bの SS(B | A, AB) 

 

注意：データの均衡がとられると、すべてのタイプで同じ結果を生じます。 

 

CFX Maestro ソフトウェアを使用すると、実験データセットに対して一元配置および二元配置の

ANOVAを実施できます。CFX Maestroソフトウェアは、平均が相互に著しく異なる場合の ANOVA試

験の Tukey HSD 事後結果を自動的に得て、Bonferroni 法と Benjamini-Hochberg 法の調整を使用して

family-wise error rate（FWER）を得ます。 
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不均衡な二元配置 ANOVAの結果について、CFX Maestroソフトウェアはまず、タイプ IIIのアプロー

チを使用して ANOVAを計算します。相互作用が有意でない場合には、タイプ IIのアプローチを使用し

て ANOVAを計算します。 

 

注意：不均衡な一元配置 ANOVA データセットは、平方和の結果に影響を及ぼしません。したがって、

平方和に対処するためのアプローチはしません。 

 

CFX Maestroソフトウェアは以下の Rパッケージを使用して ANOVAを実施し、不均衡なデータ結果

を処理します。 

 

 car（companion to applied regression） 

 

 lsmeans（least-squre means） 

 

設定 
 

以下のオプションを設定できます。 

 
 ANOVA 

 

 一元配置 ANOVA 

 

 二元配置 ANOVA 

 

 独立変数（一元配置 ANOVAを選択した場合にのみ使用可能） 

 

 サンプル 

 

 生物学的グループ 

 

 従属変数 

 
 Cq 

 

 発現レベル 

 

 Ｐ値閾値 

 

ドロップダウンリストから値を選択します。 

 

ANOVAの計算 

 

ANOVA タブを初めて選択すると、CFX Maestro ソフトウェアは以下の初期設定を使用して一元配置

ANOVAを自動的に計算し、結果表にデータを表示します（213ページの表 31を参照）。 

 

 独立変数：Sample（サンプル） 

 

 従属変数：Cq 

 

 Ｐ値閾値：0.05 
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成功すると、データは下部のペインの Results表にある ANOVAタブ画面に表示されます。 

 

注意：ANOVA を実施できない場合、ソフトウェアは Errors タブを自動的に表示します。ここには、

ANOVA解析で報告されるエラーとして考えられる理由が示されます。 

 

設定を変更するか、または二元配置 ANOVA を選択して、結果を再計算できます。.pcrd ファイルを終

了すると、CFX Maestro ソフトウェアは変更と結果を保存します。 

 

ANOVAの再計算方法 

 

 ANOVAタブの上部ペインで新しいオプションを選択し、Not currentをクリックします。再計算

をクリックします。 

 

このファイルを次回開いて ANOVA タブを選択すると、CFX Maestro ソフトウェアは保存済みの設定

を使用して ANOVAを再計算します。 

 

Rスクリプトのエクスポート 

 

ANOVAの計算後、結果と Rスクリプトをエクスポートし、スタンドアローン Rアプリケーションで.r

ファイルを開くことができます。.rスクリプトには、carパッケージと lsmeansパッケージが必要です。

エクスポートする.rスクリプトには、必要なパッケージのコードが含まれ、スタンドアローン Rアプリ

ケーションにインストールされていない場合にはインストールします。 

 

Rスクリプトのエクスポート方法 

 

 ダイアログボックスの右上隅にある Export R Scriptをクリックし、表示される Save Asダイアロ

グボックスに.rファイルの名称と位置を入力します。 

 

結果の表 
 

ANOVAのデータは結果表のタブに表示されます。表 31は、表の各タブのカラムを定義します。 

 

表31 ANOVA結果表のカラムの説明 

タブ 見出し 説明 

ANOVA   

 Target PCRで増幅される対象の遺伝子／領域 

 Source 変化が派生する場所を説明します。以下の３つのソー

スが使用されます。 

 Within groups（グループ内） ― グループ（たと

えば、サンプルまたは生物学的グループ）内の変

動性を参照 

 Between groups（グループ間） ― （二元配置

ANOA のみで使用）対象（たとえば、サンプル生

物学的グループ）の因子による変動性を参照 

 Residuals（残差） ― 解析における独立変数の結

果として変動性を考慮した後の従属変数における

変動性の差の数値を参照。残差値が小さいほど、

独立変数と従属変数の関連性が強い。 
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表 31 ANOVA結果表のカラムの説明（つづき） 

タブ 見出し 説明 

 Sum of squares 
 

ソースによる平方和（グループ間または因子、グルー

プ内または誤差、合計または全変動）： 

 within mean squares（平均平方の範囲内）を計算

するために within sum of squares（平方和の範囲

内）（グループ内）を使用する。within sum of 

squaresをその自由度（df）で除算すると、within 

mean square（平均平方の範囲内）に等しくなる。 

 between mean squares（平均平方の間）を計算す

るために between sum of squares（平方和の間）

（グループ間）を使用する。 between mean 

squaresは、between sum of squares をその dfで

除算した値に等しい。 

 df 最終的な計算で変動しても差し支えない値の個数 

 Mean square 
 

ソースによる平均平方和: 

 within mean square（平均平方の範囲内）（グルー

プ内）は、複数のサンプル内のすべての平方和の

平均に基づく母集団分散の推定値。 

 between mean square（平均平方の間）（グルー

プ間）は、サンプル平均の平方和にサンプルサイ

ズを乗じた値に基づく母集団分散の推定値。 

 F statistic グループ平均が著しく異なるかどうかを評価する。平

均平方の回帰和の平均平方和の誤差に対する比率。 

 P-Value 帰無仮説が真であると仮定し、帰無仮説が拒絶される

最小限の有意度（観測される有意度）。 

 

注意：この表のＰ値は、Ｆ統計値に基づき、全体とし

て平均値間に差異があるかどうかを示します。

ANOVA のＰ値が有意である場合、事後 Tukey HSD

（Honest Significant Difference）検定を使用してどの

ペアがＰ値で示される有意差を示すかを判定します。 

Tukey HSD（テューキーHSD） 

 Target PCRにより増幅される対象の遺伝子／領域 

 Variable 

（二元配置 ANOVA

の場合のみ） 

平均値の差（サンプルまたは生物学的グループ）の比

較に使用する独立変数。結果が Contrastカラムに表示

される。 

 Contrast 
 

比較される独立変数の個々のセット 

 Mean difference 2つの独立変数間の平均値の差 
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表 31 ANOVA結果表のカラムの説明（つづき） 

タブ 見出し 説明 

 Std. Error 平均の標準誤差は、サンプル平均の標準偏差 

 P-Value 帰無仮説が真であると仮定し、帰無仮説が拒絶される

最小限の有意度（観測される有意度）。 

 P-Value Bonferroni 複数の比較における問題を抑制するためにＰ値に適

用されるタイプの補正法。 

 P-Value BH Ｐ値 Benjamini-Hochberg 法。複数の比較における問

題を抑制するためにＰ値に適用される別のタイプの

補正法。 

 Lower Bound（X %） 所定の確率で確信間隔が真の母平均を含むことにな

る、確信間隔に関連する下限値。 

 Upper Bound（Y %） 所定の確率で確信間隔が真の母平均を含むことにな

る、確信間隔に関連する上限値。 

Descriptives 

 Target PCRにより増幅される対象の遺伝子／領域 

 Factor 

（一元配置 ANOVA

の場合のみ） 

平均値の差を比較するために ANOVAの計算で使用さ

れる独立変数 

 Sample（二元配置

ANOVAの場合のみ） 

実験サンプル、またはサンプルの識別用特性 

 Biological Group 

（二元配置 ANOVA

の場合のみ） 

同じ処理または条件を備えた同様のサンプルのグル

ープ 

 Count 実験サンプルの個数 

 

アドバイス：このカラムを使用すると均衡 vs.不均衡

データセットを見ることができます。 

 Mean 各ターゲット-因子の組み合わせについて実施される

N個の比較の、従属変数の平均値 

 Std. Deviation 各ターゲット-因子の組み合わせについて実施される

N個の比較の、従属変数の標準偏差 

Errors 

 Message ANOVA解析で報告されるエラーの理由 

 

右クリックメニューオプション 
 

ANOVAの結果のグラフに関する右クリックメニューオプションは、棒グラフの場合と同じです。使用

可能なオプションについては、203ページの表 27を参照してください。 
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Gene Study（Gene Study） 
 

インターランキャリブレーターを用いて複数のリアルタイム PCR実験による遺伝子発現データを比較

する Gene Studyを作成することにより、各実験間で正規化を行います。複数のデータファイル（拡張

子は.pcrd）からのデータを Gene Studyに加えて Gene Studyを作成します。ソフトウェアはこれらの

データをまとめて１つのファイル（拡張子は.mgxd）とします。 

 

注意：Gene Study で解析できる最大サンプル数は、コンピュータの RAM や仮想メモリのサイズによ

って制限されます。 

 

インターランキャリブレーション 
 

インターランキャリブレーションは、個別のリアルタイム PCRラン（すなわち、異なるプレートより

生成された、異なる.pcrd ファイル）でアッセイされたターゲット間のラン間変動を補正するための各

ターゲットでのすべての Gene Studyで自動的に適用されます。 

 

サンプルをインターランキャリブレーターとしてソフトウェアが認識するためには、ターゲット名、サ

ンプル名、およびもし使用していれば生物学的セット名が比較するすべてのプレートにまたがって合致

している必要があります。 

 

注意：少なくとも１つのインターランキャリブレーターサンプルは、インターランキャリブレーション

のための Gene Studyでは必要です。適切なインターランキャリブレーターサンプルのないターゲット

は、Gene Studyでの補正なしで処理されることになります（非推奨）。 

 

インターランキャリブレーターは、以下の２つの方法で適用されます。 

 

 ターゲッごと ― 異なる PCRプライマーは異なる効率を備えています。デフォルトでは、インタ

ーランキャリブレーターは、同じターゲット名を持つ同じプレートのすべてのウェルに適用され

ます（たとえば、同じアッセイで生成される Cq）。 

 

 研究全体 ― １つのインターランキャリブレーターがユーザーによって選択され、Gene Study全

体に適用されます。 

 

詳細については、バイオ・ラッド社の技術サポートまでご連絡ください。 
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Gene Studyダイアログボックス 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gene Studyダイアログボックスには以下の２つのタブが含まれます。 

 

 Study Setup タブ ― Gene Studyのランを管理します。 

 

重要：Gene Study内のデータファイルの追加または削除によって、元のファイルのデータは変更

されません。 

 

 Study Analysis タブ ― 組み合わせランの遺伝子発現データを表示します。 

 

Study Setupタブ 
 

表 32は Study Setupタブに表示されるデータを定義します。 

 

表32 Gene Studyダイアログボックスの Study Setupタブ 

カラムのタイトル 説明 

File Name ランのデータファイルの名称（拡張子は.pcrd） 

File Folder 
 

Gene Studyの各ランのデータファイルを格納するディレクトリ 

Date Created ランデータが収集された日付 

Well Group Name ファイルを Gene Studyに追加したときに選択したウェルグループの名

称 

 

アドバイス：Gene Study内の１つのウェルを解析するには、データフ

ァイルを Gene Studyにインポートする前に Data Analysisウィンドウ

で該当するウェルグループを選択する必要があります。 

Step リアルタイム PCR データを収集するためプレートリードを含むプロト

コールステップ 

Run Type ユーザー定義または PrimePCRランのいずれか 

Protocol Edited これを選択すると、PrimePCRランに使用されるプロトコールが編集さ

れたことを示します。 

View Plate Gene Study に含まれる各ランのデータと共にプレートのプレートマッ

プを開きます。 
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Gene Studyの作成 
 

Gene Studyの作成方法 

 

1. Gene Studyにデータをインポートする前に、Data Analysisウィンドウで以下を行います。 

 

 同じ内容を含むサンプルが同じ名称であることを確認します。Gene Study では、ソフトウ

ェアは同じターゲット名またはサンプル名のウェルは同じサンプルを含むと仮定します。 

 

 Quantificationタブでベースラインと閾値（Cq）を調整し、各ランのデータを最適化します。 

 

 Gene Studyに含めたいウェルグループを選択します。 

 

Gene Study 内の１つのウェルグループからのデータを表示するには、データファイルをイ

ンポートする前にそのグループを選択しておく必要があります。 

 

Study Setupタブ画面は、Gene Study内のすべてのランのリストを表示します。 

 

2. Gene Studyダイアログボックスで、Study Setupタブを選択します。 

 

3. Add Data Filesをクリックして、ブラウザウィンドウからファイルを選択します。データファイ

ル（拡張子は.pcrd）を Study Setupダイアログボックスにドラッグすると、ランを Gene Study

に迅速に追加することができます。 

 

4. CFX Maestro ソフトウェアでは、データファイルが追加されると自動的に Gene Study解析が実

行されます。結果を表示するには、Study Analysisタブを選択します。 

 

Gene Studyからランを削除する方法 

 

 リスト内の１つ以上のファイルを選択して Removeをクリックします。 

 

Gene Studyに関するメモの追加方法 

 

 ファイルや解析に関するメモを Notesテキストボックスに入力します。 

 

Study Analysis タブ 
 

Study Analysisタブは、Gene Study 内のすべてのランによるデータを表示します。遺伝子発現データ

解析のオプションは、単一データファイル用のオプションと同じですが、以下の例外があります。 

 

 棒グラフの場合、（もし計算される場合）インターランキャリブレーションの値は、Inter-run 

Calibrationをクリックすると表示されます。 

 

注意：以下のサンプルタイプのみがインターランキャリブレーターとして使用されます。 

 

 Unknown（不明） 

 

 Standard（標準） 

 

 Positive Control（陽性対照） 

 

Negative Control（陰性対照）、No Template Control（NTC）、および No Reverse Transcriptase 

Control（NRT）のサンプルタイプはインターランキャリブレーターとして使用できません。 
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 ヒートマップについて、サンプルターゲットが複数のプレート上の同じ位置にあって異なるサン

プルを含む場合、ドロップダウンメニューから解析用の特定のプレートを選択します。 

 

 Reference Gene Selection（リファレンス遺伝子選択）ツールは、試験するリファレンス遺伝子

を特定し、それぞれの安定性に基づき、Ideal（理想的）、Acceptable（可）、または Unstable（不

安定）に分類します。 

 

 Ideal（理想的）リファレンス遺伝子は安定しており、試験サンプル全体での変動が最小限で

す。 

 

 Acceptable（可）リファレンス遺伝子の安定性は理想的ではなく、試験サンプル全体での変

動は中程度です。Ideal リファレンス遺伝子がない場合は、このリファレンス遺伝子を使用

してください。 

 

 Unstable（不安定）リファレンス遺伝子は、試験サンプル全体にわたり過剰な変動が見られ

ます。このような遺伝子は解析から除外することをお勧めします。 

 

 PrimePCR Controlsツールは、試験サンプルの結果を表に示します。 

 

 Summary タブは、すべての試験サンプルの概要を表示します。すべてのコントロールアッ

セイに合格したサンプルは緑色で表示されます。１つ以上のコントロールアッセイで不合格

だったサンプルは黄色で表示されます。 

 

 PCRタブは、陽性 PCRコントロールアッセイの結果を表示します。このアッセイは遺伝子

発現に影響を及ぼす抑制問題または実験上の問題を検出します。 

 

 RTタブは、逆転写コントロールアッセイの結果を表示します。このアッセイは、RT性能を

定性的に評価し、RT性能が遺伝子発現を損なう可能性のあるサンプルを特定します。 

 

 gDNA タブは、DNA汚染コントロールアッセイの結果を表示します。このアッセイは、ゲノ

ム DNA（gDNA）が qPCR結果に影響を及ぼす可能性のあるレベルでサンプル内に存在する

かどうかを判定します。 

 

 RQタブは、RNA品質アッセイ（RQ1および RQ2）の結果を表示します。このアッセイは、

RNAの完全性が遺伝子発現に悪影響を及ぼす可能性があるかどうかを定性的に評価します。 
 

Gene Studyレポート 
 

Gene Study Reportダイアログボックスを使用して、Gene Studyデータをレポートに配置します。 

 

Gene Studyレポートの作成方法 

 

1. レポートを作成する前に、必要に応じて Gene Studyレポートのデータとグラフを調整します。 

 

2. Gene Studyメニューの Tools > Reportsを選択して Reportダイアログボックスを開きます。 

 

3. レポートに含めたいオプションを選択します。レポートは選択している初期設定のオプションで

開きます。カテゴリー全体または１カテゴリー内の個々のオプションを変更するには、チェック

ボックスの選択・解除を行ってください。 

 

220ページの表 33は、表示に使用できるオプションを示しています。 

 

4. レポート内のカテゴリーや項目の順序を変更します。オプションを必要な位置にドラッグします。

項目は、その属するカテゴリー内でのみ記録されます。 
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5. Update Reportをクリックして、変更を行った Report Previewを更新します。 

 

6. レポートを印刷・保存します。ツールバーの Print Report ボタンをクリックすると、現在のレポ

ートが印刷されます。File > Save を選択すると、レポートを PDF（Adobe Acrobat Readerファ

イル）、MHT（Microsoft文書）、または MHTML（Microsoft 文書）のファイルフォーマットで保

存し、ファイルを保存する場所を選択できます。File > Save As を選択すると、レポートを新し

い名称で、または新しい場所に保存できます。 

 

7. （オプション）必要な情報を含むレポートのテンプレートを作成します。現在のレポートの設定

をテンプレートに保存するには、Template > Saveまたは Save Asを選択します。その後、次回

新しいレポートを作成したい場合に、レポートテンプレートをロードします。 

 

Gene Studyレポートのカテゴリー 
 

表 33は Gene Studyレポートで使用できるすべてのオプションを示します。 

 

表33 Gene Studyレポートのカテゴリー 

カテゴリー オプション 説明 

Header  タイトル、サブタイトル、およびレポートの
ロゴ 

 Report Information 日付、ユーザー名、データファイル名、デー
タファイルパス、および選択しているウェル
グループ 

 Gene Study File List Gene Study内の全データファイルのリスト 

 Notes データレポートに関するメモ 

Study Analysis:  Bar Chart   

 Analysis Settings 
 

選択している解析パラメータのリスト 

 Chart データを表示する遺伝子発現グラフ 

 Target Names Gene Study内のターゲットのリスト 

 Sample Names Gene Study内のサンプルのリスト 

 Data データを表示するスプレッドシート 

 Target Stability ターゲットの安定性データ 

 Inter-run Calibration インターランキャリブレーションのデータ 

 Box-And-Whisker 

Chart 

遺伝子発現の箱髭グラフ 

 Dot Plot Chart 遺伝子発現のドットプロットグラフ 

Study Analysis:  Clustergram, 

Scatter Plot, Volcano Plot, 
Heat Map 

  

 Analysis Settings 各グラフタイプの設定を含む 

 Chart データを表示する遺伝子発現グラフ 

 Data 各ターゲットのデータを示すスプレッドシ
ート 

Study Analysis:  ANOVA Data   
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表 33 Gene Studyレポートのカテゴリー（つづき） 

 
 

オプション 説明 

 ANOVA Settings 実施する ANOVAのタイプ、独立変数と従属

変数、および解析に使用するＰ値閾値を含む 

 ANOVA Results 平方和、df、平均平方、Ｆ統計値、および

ANOVA試験のＰ値データを含む 

 Tukey’s HSD 調整した平均値の差、std.誤差、Ｐ値、Ｐ値

Bonferroni法、Ｐ値 BH、ANOVA検定の下限

データと上限データを含む 

 Data Descriptives 因子、カウント、平均値、および解析におけ

るターゲットとリファレンス遺伝子の標準

偏差を含む 

 ANOVA Errors ANOVA計算中に特定されるエラー 
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付録A データ解析の計算 
 

CFX Maestroソフトウェアでは、自動的に計算式が算定され、結果が Data Analysisタブ画面に表示さ

れます。本付録では、CFX Maestroソフトウェアにおける計算式の算定方法を詳述します。 

 

Ｐ値（P-value） 
 

Ｐ値は、対照と比較した場合の実験サンプルデータポイントの統計的優位性の尺度です。 

 

注意：Ｐ値を求めるために対照サンプルと実験サンプルの両方につき少なくとも２つのリプリケートが

必要です。リプリケートの数が多いほど、精度は高くなります。 

 

Ｐ値の式は、 

Ｐ値= 1 – A 

となり、ここで 

 
 
 
 
 
 
 
 
 

ここで 

 

 v = Count（NEsample（Experimental））＋Count（NEsample（Control））－2 

 

 Γ＝ガンマ関数 

 

 t = t統計値 
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ここで、 

 

 Mean＝算術平均 

 

 NE＝正規化発現（Normalized expression） 

 

 Count（x）＝リストｘのサイズ 

 

 SD＝サンプルの標準偏差 

 

Ｐ値の結果の差異 
 

Ｐ値の結果は、表示するグラフに応じて異なる場合があります。 

 

Charts（グラフ）タブ 

 

Chart表で報告されるＰ値は、選択している対照に基づいています。ユーザー指定の閾値未満のＰ値を

含むグラフに注釈をつけることができます。 

 

Results（結果）タブ 

 

Results（結果）表で報告されるＰ値は、ウェルごとの正規化発現（NE）値の分布を対照サンプル vs.

試験サンプルについて比較する、独立ｔ検定の結果です。 

 

ANOVAタブ 

 

ANOVA表で報告されるＰ値は、Ｆ統計値に基づき、平均値間に差があるかどうかを全体的に示します。

ANOVAのＰ値が有意な場合、事後 Tukey HSD（Honest Significant Difference）検定により、どのペア

がＰ値で示されるような有意差を示すかを判定します。 
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反応効率（Reaction Efficiency） 
 

プライマーとプローブセットのそれぞれで正確な効率の程度を使用することにより、遺伝子発現データ

の解析時に精度の高い結果が得られることがわかっています。遺伝子発現計算に使用する効率の初期設

定値は 100 %です。反応効率を評価するには、関連するダイナミックレンジにわたる代表的なサンプル

の系列希釈液を使用して検量線を生成したうえで、その後の遺伝子発現解析の効率を記録します。ラン

に検量線を用いる場合、Experiment Settingsウィンドウの Targetsタブ画面にある Auto Efficiencyを

選択していれば、ソフトウェアによって効率が自動的に算出され、Quantificationタブ画面の Standard 

Curveに表示されます。 

 

効率の計算式にある効率（Ｅ）は、Pfaffl（2001）および Vandesompele et al.（2002）の論文に記載さ

れる”efficiencies”から引用しています。この文献では、効率２（各サイクルの正味倍）が本ソフトウェ

アの 100 %の効率と同等です。以下の数式を適用すれば、ユーザーが利用する効率を本ソフトウェアで

適用する計算式に転換することが可能です。 

 

 Ｅ = (%効率×0.01) + 1 

 

 %効率＝ (E – 1)×100 

 

相対量（Relative Quantity） 
 

サンプル（GOI）の相対量（ΔCq）は次式により計算します。 

 

相対量 sample（GOI）＝EGOI
(Cq(MIN)-Cq(sample)) 

 

ここで、 

 

 E =プライマーおよびプローブセットの効率。この効率は、（%効率×0.01）＋１の式で計算され

ます。この場合、100 %効率＝２。 

 

 Cq (MIN)＝GOIの平均 Cq最低値にあるサンプル平均 Cq 

 

 Cq (sample)＝サンプルの平均 Cq 

 

 GOI＝対象の遺伝子（１ターゲット） 
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対照を選択した場合の相対量（Relative Quantity When a Control Is Selected） 
 

対照サンプル（対照）を指定している場合は、次式によって対照の遺伝子を含むサンプル（GOI）の相

対量（RQ）が計算されます。 

 

相対量 sample（GOI）＝EGOI
(Cq(control)-Cq(sample)) 

 

ここで、 

 

 E =プライマーおよびプローブセットの効率。この効率は、（%効率×0.01）＋１の式で計算され

ます。この場合、100 %効率＝２。 

 

 Cq (control)＝対照サンプルの平均 Cq 

 

 Cq (sample)＝GOI を含むサンプルの平均 Cq 

 

 GOI＝対象の遺伝子（１ターゲット） 

 

相対量の標準偏差（Standard Deviation of Relative Quantity） 
 

相対量の標準偏差は次式により計算されます。 

 

SD相対量＝SD CqGOI×相対量 sample X×Ln(EGOI) 

 

ここで、 

 

 SD相対量＝相対量の標準偏差 

 

 SD Cqsample＝サンプル（GOI）の Cqの標準偏差 

 

 相対量＝サンプルの相対量 

 

 E =プライマーおよびプローブセットの効率。この効率は、（%効率×0.01）＋１の式で計算され

ます。この場合、100 %効率＝2。 

 

 GOI =対象の遺伝子（１ターゲット） 

 

効率補正 Cq（CqE）（Efficiency Corrected） 
 

効率補正 Cqは次式により計算されます。 

 
CqE = Cq×(log(E)/log(2)) 

 

ここで、 

 

 E =効率 
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平均効率補正 Cq (MCqE)（Mean Efficiency Corrected） 
 

平均効率補正 Cqは次式により計算されます。 

 
 
 
 
 

ここで、 

 

 CqE =効率校正 Cq 

 

 n =リプリケート数 

 

正規化係数（Normalization Factor） 
 

正規化発現の等式の分母は、正規化係数として引用されます。次式に記載されるとおり、この正規化係

数は、一定サンプルの標準ターゲット（遺伝子）前例の相対量の相乗平均となります。 

 

正規化係数 sample（GOI）＝ (RQ sample（Ref1）×RQ sample（Ref2）×....×RQ sample（Ref n）)1/n 

 

ここで、 

 

 RQ＝相対量 

 

 n＝標準ターゲット数 

 

 GOI＝対象遺伝子（１ターゲット） 

 

正規化発現（Normalized Expression） 
 

正規化発現（ΔΔCq）とは、生物系におけるリファレンスターゲット（遺伝子または配列）の量を正規

化したターゲット（遺伝子）の相対量です。リファレンスターゲットを選択するためには、Experiment 

Settingsウィンドウを開き、リファレンス遺伝子として使用する各ターゲットの Referenceカラムをク

リックします。 

 

正規化発現の計算式は、算定相対量（RQ）の計算式を適用した次の式で表すことができます。 

 

 
 

ここで、 

 

 RQ＝サンプルの相対量 

 

 Ref＝各サンプルに１つ以上の標準ターゲットを含むランの標準ターゲット 

 

 GOI＝対象遺伝子（１ターゲット） 
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リファレンスターゲットが生物系の発現レベルを変化させないものと仮定すると、正規化発現の計算に

より、各サンプルに示されるセル数の取り込み差やそのばらつきが明らかとなります。 

 

平均発現（Averaged Expression） 
 

重要：平均発現値は、データに生物学的グループが含まれており、Charts タブ画面で Use biological 

groups for analysis チェックボックスが選択されている場合に計算されます。 

 

各生物学的グループの発現は共に平均化され、全生物学的グループの重み付け平均が得られます。 

 

平均正規化発現は次式により計算されます。 

 
 
 
 
 

ここで、 

 

 Exp1＝生物学的グループの正規化発現 

 

 n1＝生物学的グループ内のウェル数 
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対照選択時の正規化発現（Normalized Expression When a Control Is Selected） 
 

Experiment Settings ウィンドウで対照サンプルを選択している場合、ソフトウェアは対照サンプルの

発現レベルを１に設定します。この条件において、ソフトウェアは全ターゲット（遺伝子）発現の相対

量を対称発現量（１の値）に正規化します。この正規化発現は、対照が選択されている場合の非基準化

正規化発現解析値と同等となります。 

 

注意：これは相対正規化発現（RNE）と倍率変化（Fold Change）として知られています。 

 

正規化発現の標準偏差（Standard Deviation for the Normalized Expression） 
 

正規化発現値の再基準化は、選択した基準化オプションに応じて、正規化発現の標準偏差を最大レベル

または最低レベルの個々の正規化発現レベルで除算して得られます。正規化係数の標準偏差（SD）は

次式によって計算されます。 

 
 
 

ここで、 

 

 RQ＝サンプルの相対量 

 

 SD＝標準偏差 

 

 NF＝正規化係数 

 

 Ref＝標準ターゲット 

 

 n＝標準ターゲット数 

 

対照サンプルを指定している場合、次式に示す標準偏差の再基準化機能を適用する必要はありません。 
 

 
 
 

ここで、 

 

 NE＝正規化発現 

 

 RQ＝サンプルの相対量 

 

 SD＝標準偏差 

 

 GOI＝対象遺伝子（1ターゲット） 
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平均発現の標準偏差（Standard Deviation for the Averaged Expression） 
 

平均発現の標準偏差（SD）は次式によって計算されます。 

 
 
 
 
 
 
 

ここで、 

 

 NEavg＝平均正規化発現 

 

 SD＝生物学的グループの発現の標準偏差 

 

 n＝生物学的グループ内のウェル数 

 

平均発現の平均標準誤差（Standard Error of the Mean for the Averaged Expression） 
 

平均発現の平均標準誤差（SEM）は次式によって計算されます。 

 
 
 
 
 
 

ここで、 

 

 n1＝生物学的グループ 
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最高発現レベルに基準化した正規化発現（Normalized Expression Scaled to 

Highest Expression Level） 
 

ランに対照が含まれない場合、全サンプルでの最高発現レベルによって各サンプルの発現レベルを除算

することにより、各ターゲット（遺伝子）の正規化発現（NE）を基準化します。ソフトウェアでは、

最高発現レベルが１に設定され、全サンプル発現レベルが再基準化されます。最高発現レベルでの基準

化は、次式から計算します。 

 

 
 
 

ここで、 

 

 GOI＝対象遺伝子（ターゲット） 

 

最低発現レベルで基準化した正規化発現（Normalized Expression Scaled to 

Lowest Expression Level） 
 

ランに対照が含まれない場合、全サンプルでの最低発現レベルによって各サンプルの発現レベルを除算

することにより、各ターゲット（遺伝子）の正規化発現（NE）を基準化します。ソフトウェアでは、

最低発現レベルが１に設定され、全サンプル発現レベルが再基準化されます。最高発現レベルでの基準

化は、次式から計算します。 

 
 

ここで、 

 

 GOI＝対象遺伝子（ターゲット） 

 

平均発現レベルで基準化した正規化発現（Normalized Expression Scaled to 

Average Expression Level） 
 

ランに対照が含まれない場合、全サンプルでの相乗平均発現レベルによって各サンプルの発現レベルを

除算することにより、各ターゲット（遺伝子）の正規化発現（NE）を基準化します。ソフトウェアで

は、相乗平均発現レベルが１に設定され、全サンプル発現レベルが再基準化されます。最高発現レベル

での基準化は、次式から計算します。 

 

 
 
 
 

ここで、 

 

 GOI＝対象遺伝子（ターゲット） 

 

 GM＝全サンプルの正規化発現の相乗平均 

 

正規化発現 sample (GOI) 

基準化した正規化発現 sample (GOI) 

正規化発現 Lowest sample (GOI) 

基準化した正規化発現 sample (GOI) 

正規化発現 Highest sample (GOI) 

正規化発現 sample (GOI) 

基準化した正規化発現 sample (GOI) 

正規化発現 GM (GOI) 

正規化発現 sample (GOI) 
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基準化した正規化発現の標準偏差（Standard Deviation for the Scaled 

Normalized Expression） 
 

基準化した正規化発現（NE）値の再基準化は、選択した基準化オプションに応じて、正規化発現の標

準偏差（SD）を最高（MAX）または最低（MIN）の発現レベルにある正規化発現地で除算して得られ

ます。 

 

注意：対照サンプルを指定している場合には、標準偏差に対してこの再基準化機能を適用する必要があ

りません。 

 

この計算式は次のとおりです。 

 
 

ここで、 

 

 NE＝正規化発現 

 

 SD＝標準偏差 

 

 GOI＝対象遺伝子（ターゲット） 

 

 MAX＝最高発現レベル 

 

 MIN＝最低発現レベル 

 

レギュレーション（Regulation） 
 

レギュレーションは実験サンプル vs.対照サンプルのターゲットの発現における増加または減少の尺度

で、以下のように決定します。 

 

RNE≥1 の場合、レギュレーション＝RNE 

 

RNE＜1の場合、レギュレーション＝(-1)/RNE 

 

ここで、 

 

 RNE＝相対正規化発現。これは、対照が選択されている場合の正規化発現と同じです。 

 

SD基準化 NEsample (GOI) 

NE MAX or MIN (GOI) 

SD NEsample (GOI) 
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補正値の計算式（Corrected Values Formulas） 
 

補正値と非補正値の間の差は、リアルタイム PCRランの一部として検量線を作成した場合にのみ見ら

れます。ソフトウェアでは、誤差拡散を測定するうえで以下に関する式が適用されます。 

 

 標準誤差（Standard Error） 

 

 正規化発現の標準誤差（Standard Error for Normalized Expression） 

 

 対象の正規化遺伝値（ターゲット）の標準誤差（Standard Error for the Normalized Gene of 

Interest） 

 

標準誤差の計算式は次のとおりです。 

 
 
 
 

ここで、 

 

 n＝リファレンスターゲット（遺伝子）数 

 

 SD＝標準偏差 

 

正規化発現計算式における正規化係数の標準誤差は、次式で示されます。 

 
 
 
 
 
 

ここで、 

 

 n＝リファレンスターゲット数 

 

 SE＝標準誤差 

 

 NE＝正規化発現 

 

 RQ＝相対量 

 

対象の正規化遺伝子（GOI）の標準誤差の計算式は、次式で示されます。 

 
 
 
 
 

ここで、 

 

 SE＝標準誤差 

 

 GOI＝対象遺伝子（１ターゲット） 

 

 NF＝正規化係数 

 

 n＝標準ターゲット数 

 

 

   

   



付録 A | データ解析の計算 

234 | CFX Maestro™ ソフトウェア 
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付録B CFX Maestro のユーザーおよび役割

の管理 
 

CFX Maestroソフトウェアでは、ユーザーを作成して各ユーザーに役割を割り当てることができます。

役割によって、CFX Maestro の機能へのアクセスが制限されます。ユーザーには、一回に１つの役割

が割り当てられます。しかし、CFX Maestro ソフトウェアの管理者はいつでもユーザーの役割を変更

できます。 

 

アドバイス：CFX Maestro の使用にはユーザーの作成は必ずしも必要ではありません。ユーザーを作

成しなくても、初期設定のユーザーアカウント adminを使用してすべての作業を行えます。 

 

重要：ユーザーadmin は、初期設定の管理者（Administrator）アカウントで、最初に CFX Maestro に

ログインする際に使用します。特定のユーザーを CFX Maestroの管理者として作成することをお勧め

します。このユーザーに管理者権限を割り当て、このユーザーがすべての管理タスクを実施します。 
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ユーザーの管理 
 

標準版の CFX Maestroソフトウェアでは、ユーザーアカウントには名称またはパスワードが含まれま

す。 

 

各ユーザーに役割を割り当てるには、User Administrationウィンドウにあるリストから役割を選択しま

す。本例では、Guestユーザーにファイルを保存する権限が追加されています。 

 

ユーザーの追加および削除 
 

注意：CFX Maestro管理者のみがユーザーの追加および削除を行えます。 

 

CFX Maestroへのユーザーアカウントの追加方法 

 

1. Homeウィンドウの User > User Administrationを選択します。 

 

User Administrationダイアログボックスが表示されます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Manage Users ペインに、ユーザーの User Name（ユーザー名）を入力します。 

 

3. ユーザーの Role（役割）を選択します。 

 

役割によりユーザーの権限が制限されます。初期設定では Principal（代表ユーザー）になってい

ます。 

 

アドバイス：各役割の権限を変更することができます。役割に対する権限の変更は、その役割を

割り当てられている全ユーザーが対象となります。詳細については、237 ページの「役割の権限

の管理」を参照してください。 
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4. （オプション）ユーザーの名前とパスワードを入力します。 

 

5. OKをクリックしてダイアログボックスを開き、ウィンドウを閉じることを確定します。 

 

6. Yes をクリックしてダイアログボックスとウィンドウを閉じます。 

 

ユーザーの削除方法 

 

1. Manage Users ペインで、削除したい各ユーザーについて Remove（削除）を選択します。 

 

2. OKをクリックしてダイアログボックスを開き、ウィンドウを閉じることを確定します。 

 

3. Yes をクリックしてダイアログボックスとウィンドウを閉じます。 

 

注意：ソフトウェアユーザーのリストには、必ず１人の管理者が含まれているものとします。 

 

役割の権限の管理 
 

CFX Maestro には、以下の４つの役割が含まれます。 

 

 Administrator（管理者）（必須） ― 管理者には、すべての権限が与えられており、その内容を

変更することができません。管理者は、ユーザーの追加や削除、各役割の権限の変更を行うこと

も可能です。 

 

注意：管理者のみが役割の権限を変更できます。 

 

 Principal（代表ユーザー） ― 初期設定では、すべての権限が与えられます。 

 

 Operator（オペレーター） ― 初期設定では、サイクルのスキップを除いたすべての権限が与え

られます。 

 

 Guest（ゲスト） ― 初期設定では、ファイルの閲覧のみが可能です。 

 

重要：役割の権限の変更は、その役割を割り当てられているすべてのユーザーが対象になっています。

特定のユーザーの役割をカスタマイズすることはできません。役割の権限を修正する際には注意してく

ださい。 

 

各役割の権限を指定する方法 

 

1. Homeウィンドウの User> User Administrationを選択します。 

 

2. Manage Rights（権限の管理）ペインで、以下のいずれかを行います。 

 

 役割から権限を削除するには、そのチェックボックスを解除します。 

 

 役割に権限を追加するには、そのチェックボックスを選択します。 

 

3. OKをクリックしてダイアログボックスを開き、ウィンドウを閉じることを確定します。 

 

4. Yes をクリックしてダイアログボックスとウィンドウを閉じます。 

 

全役割の全権限をリセットする方法 

 

 User Administrationダイアログボックスで Restore Default Rights（初期設定の権限を復元）をク

リックしてください。 
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CFX Maestroソフトウェアへのログイン 
 

CFX Maestroソフトウェアは、Loginダイアログボックスからソフトウェアにログインする者を管理し

ます。ソフトウェアの起動時、User Administrationウィンドウに２人以上のユーザーが記載されている

場合には Loginダイアログボックスが自動的に表示されます。 

 

CFX Maestroの Homeウィンドウ上部に、ログインユーザーの名前が表示されます。 

 

CFX Maestroへのログイン方法 

 

1. Loginダイアログボックスで、User Nameドロップダウンリストから名前を選択します。 

 

2. パスワードを入力します。 

 

3. OKをクリックして Loginダイアログボックスを閉じ、ソフトウェアを開きます。 

 
 
 
 
 
 
 
 
 
 
 
 
 

ユーザーの変更 
 

ソフトウェアの実行中にユーザーを変更することができます。 

 

ユーザーの切り替え方法 

 

1. Homeウィンドウの User > Select Userを選択して、Loginダイアログボックスを開きます。 

 

2. User Nameドロップダウンリストから名前を選択します。 

 

3. 新しいユーザーのパスワードを入力します。 

 

4. OKをクリックして Loginダイアログボックスを閉じ、ソフトウェアを開きます。 
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ユーザーパスワードの変更 
 

CFX Maestro ユーザーはいつでも自身のパスワードを変更できます。 

 

ユーザーパスワードの変更方法 

 

1. Homeウィンドウの User > Change Passwordを選択してChange Passwordダイアログボックス

を開きます。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Old Password に現在のパスワードを入力します。 

 

3. New Password に新しいパスワードを入力し、そのパスワードを Confirm New Passwordに再入

力します。 

 

4. OKをクリックして変更を確定します。 

 

役割と権限を表示 
 

アドバイス：Principal（代表ユーザー）、Operator（オペレーター）、または Guest（ゲスト）のユー

ザー役割を割り当てられたユーザーは、それぞれのユーザー設定、権限、および役割のみを閲覧できま

す。 

 

現在のユーザーの役割と権限の表示方法 

 

 Homeウィンドウの User > User Administrationを選択します。 

 

User Administrationウィンドウに記載されているユーザー設定、権限、および役割を変更する場合には、

担当の CFX Maestro管理者にご連絡ください。 
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付録C LIMS統合 
 

CFX Maestro ソフトウェアは実験室情報管理システム（LIMS）での使用のために構成することができ

ます。LIMS 統合のために、CFX Maestro は、LIMS プラットフォーム（LIMS ファイル、*.plrn）によ

って生成されるプレート設定情報、CFX Maestro ソフトウェアを使用して作成されるプロトコールフ

ァイル（*.prcl）、定義されたデータエクスポート場所、および定義されたエクスポートフォーマット

を必要とします。 

 

ランの終了後、CFX Maestro はデータ（.pcrd）ファイルを生成し、それを定義されたデータエクスポ

ートフォルダの場所に保存します。CFX Maestroはさらに.csvフォーマットの LIMS互換データファイ

ルを作成し同じ場所に保存します。 

 

LIMS互換データファイルの作成 
 

本付録では、LIMS 互換データファイルの作成、保存、およびエクスポートのための CFX Maestro ソフ

トウェアの設定方法について説明します。 

 

LIMSフォルダおよびデータエクスポートオプションの設定 
 

初期設定で、CFX Maestroは LIMSプロトコール、ファイル、およびデータエクスポートファイルを以

下のフォルダに保存します。 

 

C:\Users\Public\Documents\Bio-Rad\CFX\LIMS 

 

ファイルを別のフォルダに保存するために CFX Maestroを構成し、LIMSデータのエクスポートオプシ

ョンを変更することができます。 

 

LIMSフォルダおよびデータエクスポートオプションの設定方法 

 

1. Homeウィンドウで Tools > Optionsを選択します。 

 

2. Optionsダイアログボックスで Data Export Settingsを選択します。 
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3. （オプション）ランの最後に Automatically export LIMS data（LIMSデータを自動的にエクスポ

ート）を選択します。 

 

ソフトウェアは各ランの終了後に LIMS データを自動的にエクスポートし、それを特定の場所に

保存します。 

 

4. LIMSデータのデフォルトのエクスポートオプションを変更するには、LIMS Data Export Settings

をクリックします。 

 

重要：LIMSデータは.csvファイルでないとエクスポートできません。エクスポートフォーマット

を変更しないでください。 

 

5. LIMS Data Export Format Settings ダイアログボックスで、必要なエクスポートオプションを選択

して OKをクリックします。 

 

6. OptionsダイアログボックスでLIMSデータファイルを保存したいデフォルトのフォルダにナビゲ

ートしてそれを選択します。次のようなファイルタイプごとに別の場所を選択することが可能で

す。 

 

 プロトコール 

 

 LIMSファイル 

 

 データエクスポート 

 

7. OKをクリックして変更を保存し、Optionsダイアログボックスを閉じます。 

 

LIMSプロトコールの作成 
 

LIMSランを開始するには、CFX Maestroプロトコールファイル（*.prcl）を作成してそれを指定の LIMS

プロトコールフォルダの場所に保存します。 

 

詳細については、第５章の「プロトコールの作成」を参照してください。 
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LIMSファイルの作成 
 

LIMSファイル（*.plrn）は、プレート設定詳細とプロトコールファイル名を含んでいます。このファイ

ルはインターナル LIMSによって生成されます。CFX Maestroは LIMSファイルを使用して、プロトコ

ールファイルに使用するプレートファイルを作成します。 

 

CFX Maestroは、カスタム LIMSプレートファイルを作成するために編集できる２つのプレートインポ

ートテンプレートファイルを用意しています。 

 

アドバイス：このタスクは、LIMS専門家が実施するものとします。 

 

LIMSファイルの作成方法 

 

1. Homeウィンドウで View > Show > LIMS File Folderを選択します。 

 

2. LIMS Template フォルダを開き、.csvファイルを選択してインターナル LIMS にインポートしま

す。 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. LIMSを使用して、表 34に記載された必要なフィールドを埋めてテンプレートファイルを編集し

ます。 

 

4. 拡張子.plrnの付いたファイル名でテンプレートを LIMS Fileフォルダに保存します。 

 

重要：CFX Maestroは.plrnファイルのみを開くことができます。LIMSランを開始するには、.csv

ファイルを.plrnとして保存する必要があります。 

 

表 34 LIMS .csvファイル内容の定義 

 
 
 

行 説明 内容 目的 

A 1 Plate Header 編集不可 定義済 

A,B,C 2 Field/Data/Instruction 編集不可 定義済 

B 3 Version 編集不可 定義済 

B 4 Plate Size 編集不可 定義済 

B 5 Plate Type “BR White”、”BR Clear”、また

は他のキャリブレーション済プ

レートタイプを入力 

必須 

B 6 Scan Mode “SYBR/FAM Only”、”All 

Channels”、または”FRET”を入

力 

必須 
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表 34 LIMS .csvファイル内容の定義（つづき） 

列 行 説明 内容 目的 

B 7 Units 以下のいずれかを入力。“copy 

number”、”fold dilution”、

“micromoles”、“nanomoles”、

“picomoles”、“femtomoles”、

“attomoles”、“milligrams”、

“micrograms”、“nanograms”、

“picograms”、“femtograms”、

“attograms”、または“percent” 

必須 

B 8 Run ID 今回のランを特定する短い説明

もしくはバーコードを入力 

任意 

B 9 Run Note ランの説明を入力 任意 

B 10 Run Protocol プロトコールファイル名を記載

のとおり正確に入力 

必須 

A 11-15 TBD/Empty 編集不可 定義済 

A 16 Plate Data 編集不可 定義済 

A 14-110 Well Position 編集不可 定義済 

B-G  Ch1 Dye, Ch2 Dye, 
Ch3 Dye, Ch4 Dye, 
Ch5 Dye, FRET 

使用する各チャンネルでのキャ

リ ブ レ ー トさ れ た色 素名

（例、”FAM”）を入力 

必須 

H  Sample Type “Unknown” 、 “Standard” 、

“Positive Control” 、 “Negative 

Control”、“NTC”、または”NRT

のサンプルタイプのいずれかを

入力 

必須 

I  Sample Name サンプル名を入力 任意 

J-O  CH1 Target, CH2 
Target, CH3 Target, 
CH4 Target, CH5 
Target, FRET Target 

使用する各チャンネルのターゲ

ット名を入力 

任意 

P  Biological Set Name 生物学的セット名を入力 任意 

Q  Replicate リプリケートの各セットの正整

数を入力。ゼロにすることはで

きない。 

任意 

R-W  CH1 Quantity, CH2 
Quantity, CH3 
Quantity, CH4 
Quantity, CH5 
Quantity, FRET 
Quantity 

標準の量の値を入力。10進法で

濃度を入力。 

すべての標準で必

須 

X  Well Note ウェルのメモを入力 任意 
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表 34 LIMS .csvファイル内容の定義（つづき） 

列 行 説明 内容 目的 

Y-AD 14-110 Ch1 Well Color, Ch2 
Well Color, Ch3 Well 
Color, Ch4 Well 
Color, Ch5 Well 
Color, FRET Well 
Color 

32ビット整数（argb）10進法

フォーマットでユーザー定義の

トレーススタイルの色を入力 

任意 

 

LIMSランの開始 
 

LIMSランの開始 

 

1. 以下のいずれかを行い LIMS .plrnファイルを開きます。 

 

 Homeウィンドウで View > Show > LIMS File Folderを選択してターゲットの.plrnファイル

を開く。 

 Homeウィンドウで File > Open > LIMS Fileを選択してターゲットの.plrnファイルを開く。 
 

ファイルは、Run Setupウィザードの Start Runタブ画面に開きます。Start Runタブ画面には、

ランを行う実験に関する情報が表示されます。また、実験のランを行う接続機器のブロックも表

示されます。 

 

2. Start Runタブ画面で、機器を選択して Start Runをクリックします。 
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LIMSへのデータのエクスポート 
 

ランが完了すると、CFX Maestro はデータ（.pcrd）ファイルを生成してそれを定義されたデータエク

スポートフォルダの場所に保存します。 

 

LIMSへのデータファイルのエクスポート方法 

 

 .pcrdファイルを開いて Export > Export to LIMS Folderを選択します。 

 

アドバイス：LIMS のオプションで Automatically Export Data after Run（ラン後にデータを自動的にエ

クスポート）を選択している場合、CFX Maestroは LIMS互換データファイルを.csvフォーマットで作

成して同じフォルダに保存します。 
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付録D CFX Maestro ソフトウェアの接続問

題に関するトラブルシューティング 
 

アプリケーションログ 
 

新しいランを開始する前に、CFX96 Touch、CFX96 Touch Deep Well、CFX Connect、および CFX384 

Touchの各機器は自己診断テストを開始し、仕様範囲内で動作していることを確認します。ソフトウェ

アは、この試験の結果をランおよびアプリケーションの記録ファイルに記録します。１つ以上の実験で

問題が生じた場合には、ランとアプリケーションの記録を開いて問題の発生時期を確認してください。 
 

CFX Maestroソフトウェアでは、Application Logにラン実行中の機器の状態に関する情報が記録され

ます。こうした記録を用いて、機器やソフトウェアに生じた事象をトラブルシューティング時に追跡す

ることができます。 

 

アプリケーションログを開く方法 

 

 Homeウィンドウの View > Application Logを選択します。 
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トラブルシューティング 
 

一般に、ソフトウェアと機器の通信問題は、コンピュータとシステムを再起動すると解決できます。再

起動する前に進行中の作業を必ず保存してください。 

 

注意：使用するコンピュータの RAMに余裕があり、ハードディスクドライブに十分な空きがあること

を確認してください。RAMは 2GB以上、ハードディスク空き容量は 10GB以上が推奨されます。 

 

電源トラブル 
 

電源不良が生じた場合、機器とコンピュータはシャットダウンします。電源不良状態が短時間で回復す

れば、機器はプロトコールのランを再開しますが、アプリケーションログには電源不良が記録されます。

コンピュータの設定および電源の遮断時間に応じて、機器とソフトウェアはプロトコールステップごと

のランの継続を試行します。 

 

 プロトコールがプレートリードを含まないステップにある場合、プロトコールは機器に電源が回

復した時点でランを再開します。 

 

 プロトコールがプレートリードを含むステップにある場合、機器はソフトウェアが再起動しデー

タ収集の通信を再開するまで待機します。この状況において、ソフトウェアがコンピュータによ

りシャットダウンされていなければ、プロトコールが継続されます。コンピュータとソフトウェ

アが再起動すると、プロトコールによるランが続けられます。 

 

停電中におけるリアクションモジュールからのサンプルの取り出し 

 

電源不良中にロックされているリアクションモジュールの電動リッドを開いてサンプルを取り出すこ

とができます。 

 

ロックされたプレートの取り出し方法 

 

1. ロッキングバーを押し下げて、C1000 Touchまたは CFX Connectからリアクションモジュール

を取り出します。 

 

2. リアクションモジュールを机または実験台に慎重に置きます。 

 

3. モジュールの前面が机や台の縁部から２インチ飛び出すようにように、モジュールを配置します。 
 

4. アレンレンチで、リアクションモジュールの前縁部の下（リッドを開けるためのボタンの下）か

ら 2本の大型ネジを取り外します。 

 

ネジが外れると、モジュール内部から固定具が外れる音が聞こえます。 

 

重要：モジュールの前縁部にある２本の小型ネジは外さないでください。 

 

5. リアクションモジュールのリッドを押し開きます。固定具（濃い色のプラスチック部品）が付着

していないことを確認します。ブロックからサンプルを取り出します。 

 

6. 固定具を元の位置に戻し、大型ネジ２本を締めてリッドが開いた状態でリアクションモジュール

を組み立てます。 
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USBフラッシュドライブへのデータファイルのリカバリー 
 

注意：最新の５個のランファイルのみ復元できます。 

 

スタンドアローンランからのデータファイルのリカバリー方法 

 

1. USBフラッシュドライブをサーマルサイクラーベースにある USBポートに差し込みます。 

 

2. Toolsをタップして Toolsダイアログボックスを開きます。 

 

3. Run Reportsをタップします。 

 

4. リストから復元するファイルを選択します。 

 

5. Recover Dataをタップします。システムは新しいデータファイル（.zpcr）を作成し、それを USB

フラッシュドライブにエクスポートします。 

 

CFX Maestroコンピュータへのファイルの回収 
 

サーマルサイクラーベースにあるデータとログファイルを、接続しているコンピュータのハードドライ

ブに回収することができます。 

 

注意：サーマルサイクラーベースのリアルタイムデータフォルダ内にあるすべてのファイルは、コンピ

ュータに回収されます。 

 

サーマルサイクラーベースからのファイルの回収方法 

 

1. Home ウィンドウの Detected Instrumentsペインで、対象の機器を右クリックして以下のいずれ

かを選択します。 

 

 Retrieve Log Files（ログファイルの回収） 

 

 Retrieve Data Files（データファイルの回収） 

 

2. 回収したファイルを保存するフォルダの場所を選択します。 

 

3. Okayをクリックします。 

 

CFX Maestroソフトウェアの手動インストール 
 

CFX Maestroソフトウェアの手動インストール方法 

 

1. 必要に応じて、コンピュータに接続されている機器の接続を断ちます。 
 

CFX Maestro コンピュータの機器の USB ケーブルを見つけて接続を断ちます。機器に挿入され

ている端部はそのままにしておくことができます。 
 

2. 管理者権限で CFX Maestroコンピュータにログインします。 
 

3. CFX Maestro ソフトウェアの USBドライブをコンピュータの USBポートに挿入します。 
 

4. Windows Explorerで、CFX Maestroソフトウェアの USBドライブにナビゲートしてそれを開き

ます。 
 

5. CFXフォルダを開いて Setup.exe をダブルクリックし、CFX Maestroソフトウェアをインストー

ルします。 
 

6. 画面上の指示に従ってソフトウェアをインストールします。 
 

完了したら、バイオ・ラッド社 CFX Maestroソフトウェアのスプラッシュ画面がコンピュータの

画面に表示され、Bio-Rad CFX Maestro アイコンがデスクトップに現れます。 
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7. CFX_Documentation.exe をダブルクリックして CFX Maestro ソフトウェアの文書をインストー

ルします。 

 

8. インストールの完了後、ソフトウェアの USBドライブを安全に取り外して CFX Maestroソフト

ウェアを起動します。 

 

ドライバの再インストール 
 

機器のドライバを再インストールする方法 

 

 Homeウィンドウの Tools > Reinstall Instrument Drivers を選択します。 

 

注意：ドライバの再インストールし USB接続を確認した後にリアルタイムシステムとのソフトウェア

通信に問題がある場合には、バイオ・ラッド社のテクニカルサポートにご連絡ください。 
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